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Introduction

This document covers INSIGHT software and the Evolution 200 series UV-Visible 
spectrophotometers and accessories.

About the Software and Hardware

Overview

The Evolution™ 200 series UV-visible spectrophotometers integrate advanced hardware 
features with the power and flexibility of a wide range of Smart Accessories™. The 200 series 
spectrophotometers include:

• Evolution 201

• Evolution 220

• Evolution 260 Bio

For a list of sampling and other accessories available for these instruments, see Accessories.

All instruments include our INSIGHT™ software for data collection and analysis. The 
INSIGHT software provides four modes of operation:

Contents

• About the Software and Hardware

• Contacting Us

• Product Warranty

• Trademarks

• Site Preparation and Safety

Contents

• Overview

• Setting Up the Instrument

• Before Using the Spectrophotometer
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• Fixed, to measure the light passing through the sample at one or more wavelengths.

• Scan, to measure the light that passes through the sample over a range of wavelengths.

• Quant, to set up and perform quantitative analyses of sample data.

• Rate, to make time-based kinetics measurements.

The Evolution 260 Bio systems also have operating modes for the common life science 
applications, including Nucleic Acid and Protein A280. See Life Science Applications for 
more information.

Setting Up the Instrument

The spectrophotometer can be run from the optional touchscreen (Local Control) or from a 
Windows®-compatible computer connected to the instrument (Computer Control). Local 
Control instruments include an embedded computer preloaded with software. Computer 
Control instruments must be connected to an external computer with the proper software 
installed. All instruments include a keypad.

For instructions to set up a Computer Control or Local Control spectrophotometer and 
perform basic operations using the keypad, see Using the Spectrophotometer.

Before Using the Spectrophotometer

The spectrophotometer contains precise optical components. Handle it carefully. Before using 
the system, review the Site Preparation and Safety information and Operating Precautions.

About This Document

Organization

This document has the following main sections:

Contents

• Organization

• Conventions

Section Description

Introduction Overview of the instrument and this document plus 
information about registering your instrument, contacting us, 
and the system warranty.

Evolution 200 Series 
Spectrophotometers

Complete instructions for using and maintaining the 
instrument.
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Conventions

This document uses the following conventions:

Contacting Us
For Technical Support, please contact:

Thermo Fisher Scientific
5225 Verona Road
Madison, WI  53711-4495 U.S.A.
Telephone:  1 800 532 4752

E-mail:  us.techsupport.analyze@thermofisher.com
World Wide Web:  http://www.thermo.com/spectroscopy

INSIGHT Software Complete instructions for using software features other than life 
science applications and Performance Verification (see below).

Life Science Applications Instructions for using life science applications to analyze 
samples.

Accessories Complete instructions for using accessories with the instrument.

Performance Verification Instructions for setting up and running tests to check the 
performance of the instrument.

Section Description

Note  Notes contain helpful supplementary information.

NOTICE    Follow instructions labeled “NOTICE” to avoid damaging the system hardware 
or losing data.

CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

WARNING  Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.
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For International Support, please contact:

Thermo Fisher Scientific
Telephone:  +1 608 273 5017

E-mail:  support.madison@thermofisher.com
World Wide Web:  http://www.thermo.com/spectroscopy

E-mailing Data Files
If you have questions about your data, you can send it to us as an archived workbook file 
(*.iwbk). Please send us the appropriate file as an e-mail attachment. See the description of 
E-mail Current Workbook in Menus and the description of E-mail in Data Store Tab for 
more information.

Product Warranty
Warranties herein are for products manufactured by Thermo Fisher Scientific or its authorized 
dealers.

Thermo Fisher Scientific warrants that this product is free from defects in labor and materials 
and shall conform to its product specifications as defined in the product user documentation.

This warranty covers parts (except those specified below) and labor, and applies only to 
equipment which has been installed and operated in accordance with the documentation 
supplied by Thermo Fisher Scientific, and which has been serviced only by authorized 
Thermo Fisher Scientific dealers or service personnel. This warranty does not apply to 
equipment and accessories that have been modified or tampered with in any way, misused, or 
damaged by accident, neglect, or conditions beyond Thermo Fisher Scientific’s control.

Related Topics

Warranty Period

Items Not Covered by Warranty

Warranty Repair

Shipping Cost for Items Covered by Warranty

Update Policy

Note  Please have the instrument serial number available when you contact us.

Note  Please do not send exported report files or user-defined workbooks—these do not 
contain the information we need.
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Warranty Period

With the exception of SPECTRONIC™ 20+, SPECTRONIC 20D+, GENESYS™ 20 and the 
Helios™ Epsilon spectrophotometers, all UV Visible spectrophotometers come with a 
standard warranty that is fourteen months from the date of shipment or twelve months from 
the date of installation (whichever occurs first). The replacement parts and spare components 
are warranted for 90 days from the date of shipment. If such parts are intended for long term 
storage, it is recommended that their functionality is tested immediately upon receipt and any 
problems reported to Thermo Fisher Scientific within the above specified warranty period.

The following warranties apply to instrument light sources:

1. Xenon lamps are warranted against failure for a period of three (3) years.

2. Tungsten and deuterium lamps will be replaced under warranty if they fail on the initial 
power-up or within the first month of operation.

Thermo Fisher Scientific reserves the right to request the return of failed components that are 
being replaced under warranty.

User should complete and return the Product Registration card, and retain proof of delivery 
date.

Items Not Covered by Warranty

This warranty does not apply to glassware, expendable components, peripheral devices or 
accessories not manufactured by Thermo Fisher Scientific. The manufacturer of these 
products may offer specific warranties for such parts and components.

Cleaning and calibration service is not covered by this warranty.

Warranty Repair

In the event of failure within the warranty period, Thermo Fisher Scientific will at Thermo 
Fisher Scientific’s option, repair or replace the product not conforming to this warranty. There 
may be additional charges, including freight, for warranty service performed in some 
countries. For service, call Thermo Fisher Scientific (or its authorized dealer outside the 
United States and Canada). Thermo Fisher Scientific reserves the right to ask for proof of 
delivery date.

Warranty repairs for UV Visible instruments may vary per product line and region. UV 
Visible products manufactured by Thermo Fisher Scientific are covered by a 
“return-to-factory” parts and labor warranty. In some regions, on-site warranties, extended 
warranties and service contracts may be purchased for all products.

In the event that on-site warranty service is required, and no on-site service contract is active 
on this product, the customer is responsible for any travel expenses, labor costs, and additional 
expenses which may be incurred in the performance of on-site warranty service.
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Please contact your dealer or Thermo Fisher Scientific Technical Service department for 
further information. A Return Authorization Number must be obtained from Thermo Fisher 
Scientific Technical Service before returning any product for in-warranty repair or 
replacement.

Shipping Cost for Items Covered by Warranty

It is customer’s responsibility to pay for the shipment of the product under warranty to 
Thermo Fisher Scientific.

This warranty covers return shipment (standard ground) charges for returning the repaired or 
replaced product to the customer.

Update Policy

Thermo Fisher Scientific may, from time to time, revise the performance of its products, and 
in doing so incur no obligation to furnish any such revisions to any Thermo Fisher Scientific 
customer.

THIS WARRANTY IS IN LIEU OF ALL WARRANTIES EXPRESSED, IMPLIED, OR 
STATUTORY, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF FITNESS 
FOR A PARTICULAR PURPOSE OR MERCHANTABILITY OR OTHERWISE, and 
states Thermo Fisher Scientific’s entire and exclusive liability and the Customer’s exclusive 
remedy for any claim in connection with the sale or furnishing of services, goods, or parts, 
their design, suitability for use, installation, or operations. Thermo Fisher Scientific will in no 
event be liable for any direct, indirect, special, or consequential damages, whatsoever, 
including loss of goodwill, whether grounded in tort (including negligence), strict liability or 
contract, and Thermo Fisher Scientific’s liability under no circumstances will exceed the 
contract price for the goods and/or services for which liability is claimed. 

REPRESENTATION AND WARRANTIES MADE BY ANY PERSON, INCLUDING 
ITS AUTHORIZED DEALERS, REPRESENTATIVES AND EMPLOYEES OF 
THERMO FISHER SCIENTIFIC WHICH ALTER OR ARE IN ADDITION TO THE 
TERMS OF THIS WARRANTY SHALL NOT BE BINDING UPON THERMO 
FISHER SCIENTIFIC UNLESS IN WRITING AND SIGNED BY ONE OF ITS 
OFFICERS.

Trademarks
Microsoft, Windows, Excel and Vista are either trademarks or registered trademarks of 
Microsoft Corporation in the United States and/or other countries.

DYMO is either a trademark or registered trademark of Sanford L.P. in the United States 
and/or other countries.
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Teflon and Viton are either trademarks or registered trademarks of E. I. du Pont de Nemours 
and Company or its affiliates in the United States and/or other countries.

Starna is either a trademark or registered trademark of Starna Scientific Limited in the United 
States and/or other countries.

Hellma is either a trademark or registered trademark of Hellma GmbH in the United States 
and/or other countries.

AccuVac and Hach are either trademarks or registered trademarks of Hach Company in the 
United States and/or other countries.

Spectralon is either a trademark or registered trademark of Labsphere, Inc. in the United 
States and/or other countries.

All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries.

Site Preparation and Safety
Before using the system, read the site preparation and safety manual on the provided 
documentation CD. Always follow the safety precautions in that manual and in this 
document when using the system.
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INSIGHT Software

Applications

Fixed

Contents

• Applications

• The INSIGHT Window

• Thermo Software IQ

• Operation

• Options

• System Settings

• Keyboard Shortcuts

Contents

• Fixed

• Scan

• Quant

• Rate

Life Science Applications may also be available.

The Fixed application measures the light passing through 
the sample at one or more wavelengths. To work with this 
application, click Fixed in the right pane in Home.
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Related Topics

The INSIGHT Window

Setting Application Parameters

Measuring Samples

Scan

Related Topics

The INSIGHT Window

Setting Application Parameters

Measuring Samples

Math and Analysis Operations

Quant

Related Topics

Quant

Performing a Quantitative Analysis

Rate

Related Topics

The INSIGHT Window

The Scan application measures the light that passes 
through the sample over a range of wavelengths. To work 
with this application, click Scan in the right pane in 
Home.

Use the Quant application to set up and perform 
quantitative analyses of sample data. To work with this 
application, click Quant in the right pane in Home.

Use the Rate application to make time-based kinetics 
measurements. To work with this application, click Rate 
in the right pane in Home.
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Setting Application Parameters

Performing a Kinetics Measurement

Measuring Samples

The INSIGHT Window
The INSIGHT window is divided into panes. At the left is the navigation pane, which 
contains task buttons and action buttons for displaying software features and performing 
operations. The right pane provides access to applications, stored data, software settings and 
data acquisition features.

Above the panes is a menu bar that can include features for working with workbooks, 
performing math, analysis and other operations, and getting help. The available features 
depend on the selected application, whether spectral data is displayed, etc.

To “right-click” a software feature on a Local Control system

1. Click the feature.

2. Display the keyboard by clicking  or .

Click Home in the navigation pane at any time to see 
applications available in the right pane.

To display a keyboard for entering information or for “right-clicking” software 
features (for example, to display a shortcut menu) on a Local Control system, click 
this icon in the lower-left corner of the INSIGHT window. See the procedure below 
for more information.

Alternatively, click this icon on the Windows taskbar. If the taskbar is not visible, click 
the bottom (or other) edge of the Windows desktop to display it. 
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3. Click the key indicated below.

Related Topics

Navigation Pane

Right Pane

Menus

Instrument Status Monitors

Navigation Pane

The navigation pane at the left side of the window contains features for the current 
application:

Task Buttons
Action Buttons
Other Navigation Pane Features

Related Topics

Right Pane

Menus

Task Buttons

The main task buttons (present when the software starts) provide access to basic operations:

Click this key

Button Description

Home Gives access to user groups and their applications. (The default is Classic.)

My Data Provides tools for storing and retrieving data and other information.
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Other task buttons may be available for specific applications:

Related Topics

Action Buttons

Other Navigation Pane Features

Action Buttons

These action buttons appear at the top of the navigation pane when appropriate for the 
opened application:

Options Includes features for controlling how users interact with the software.

System Settings Provides features for aligning accessories, calibrating lamps, updating 
firmware and performing other tasks.

If a Local Control instrument is connected to an external computer 
running INSIGHT software, use the Instrument Control options on the 
System tab to select the desired location of instrument control.

Button Description

Measure (current 
application)

Displays data acquisition features for the current application.

Reports Configures reports containing sample data and specifies how to 
print reports.

Oligo Calculator Calculates molecular weight, extinction coefficients, concentration 
factors and melting points for nucleic acid sequences.

Dye/Chrom. Editor For entering and editing new dyes rather than using one of the 
precoded default dyes.

Button Description

Button Description

Starts sample data acquisition, displaying prompts for confirming samples 
information, loading samples, saving data or performing other actions. Available 
only after a blank measurement for some applications. May measure single or 
multiple samples, depending on the application settings.

Measures the baseline for the application.
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Other action buttons may appear for some tasks.

Related Topics

Task Buttons

Other Navigation Pane Features

Other Navigation Pane Features

Related Topics

Task Buttons

Action Buttons

Right Pane

Measures the blank for the application.

Stops data acquisition.

Prints a copy of the spectrum and associated sample data to the default printer.

Note  To start data acquisition automatically after a specified delay instead of responding 
to a prompt, use Enable auto input trigger on the Preferences tab in Options.

Button Description

Feature Description

Overlay spectra Displays multiple spectra as they are acquired (instead of displaying only 
the spectrum being acquired or just acquired). The overlaid sample IDs 
appear in the upper-left corner of the data display. To display the 
spectrum of interest in red, click its sample ID. The last sample measured 
appears in red at the top of the legend.

The right pane in Home includes:
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When the Home screen is not displayed, the right pane is used for application settings, sample 
measurement results, available workbooks, and other features.

Related Topics

Data Display

Working With Labels

Measurement Results

Navigation Pane

Setting Application Parameters

Measuring Samples

Menus

Data Display

Feature Description

Group Select a user group to access its applications (see 
“Application buttons” below). See Applications Tab for 
information on associating applications with user groups.

Application buttons Click a button (for example, Fixed or Quant) to open an 
application. The available applications depend on the 
selected user group (see “Group” above).

Click this button to access instrument performance tests. 
See Performance Verification.

Template list If the list is present, double-click a template to open it 
and the associated application.

For some applications, clicking the Measure task 
button provides a data display in the right pane for 
viewing sample data immediately after acquisition or 
previously acquired data.
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To view data listed below the data display, select them in the list. To select multiple spectra (or 
sample points), hold down Shift or Ctrl. To display data from multiple samples as they are 
measured, select Overlay spectra in the navigation pane.

The sample IDs appear at the top of the data display, with the selected spectrum (or sample 
points) and sample ID in red. To turn off the sample legend, right-click the data display, point 
to Sample Legend and choose OFF.

The X and Y values of the pointer location appear below the data display.

To enlarge a region, draw a box around it and click inside the box. Alternatively, click  (if 
available) to reveal the view finder.

To expand the data display vertically, click  .

To change the appearance of the axes or data, right-click an axis and choose Display 
Attributes (if available for the current application). View the effects on the display while 
adjusting the attributes. To change the color of the axes or their labels, click the appropriate 
color box.

The Sample ID readout to the right of the display shows the name of the sample being 
measured (or to be measured). The table below shows the results of analysis operations and 
whether sample points fall within specified control limits.

Right-click the display to access these features (if available for the current data type):

Sample ID

X and Y values of pointer location Click to expand vertically

Click to use 
view finder
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Feature Description

Autoscale Adjusts the vertical scale of each spectrum for optimal viewing. 
Double-clicking the display has the same effect.

Auto Arrange Labels Positions labels for easier reading.

Set Scale For setting minimum and maximum values for the axes. To set 
them automatically, select Autoscale.

Sample Labels Specifies whether to display spectra with annotations (see 
“Annotate” below) and labels, such as those showing absorbance 
values for specific wavelengths.

Sample Legend Specifies whether to display sample IDs near the upper-left corner 
of the pane.

Line Type Specifies whether to display scan spectra using solid lines or 
individual data points.
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Annotate Provides features for adding annotation to displayed data. (Added 
annotation is displayed only for the selected data.) See Working 
With Labels for information about manipulating added labels. 
Right-click an edge of an added ellipse, rectangle or image to access 
ways to manipulate or delete the object. The availability of features 
depends on the current application.

More:

Attach to Curve displays the X value of the pointer location as a 
label attached to a scan spectrum by a line.

Free Standing Text adds an editable label at the pointer location. 
Its position is not affected by zooming in and out.

Ellipse draws an ellipse. To move it, drag its top edge. To resize it, 
drag a side or bottom edge. Its position, size and shape are affected 
by zooming in and out.

Rectangle draws a rectangle. To move it, drag its top edge. To 
resize it, drag a side or bottom edge or a corner. Its position, size 
and shape are affected by zooming in and out.

Image displays a dialog box for locating and selecting an image to 
add to the display. To move the image, drag its top edge. To resize 
it, drag the bottom edge or a corner. Its position and size are 
affected by zooming in and out.

Floating Image works the same as Image (see above), except the 
image position and size are not affected by zooming.

Tool Value displays the measurement made by the Peak/valley 
measurement tool or peak area tool as a label attached to the 
spectrum by a line.

Feature Description
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Related Topics

Working With Labels

Measuring Samples

Right Pane

Measurement Results

The INSIGHT Window

Working With Labels

Some operations place labels on the displayed data. Here is an example:

More Display Options 
(Fixed only)

Specifies how to display fixed sample data and control limits:

Connect points (in Spectrum) draws connecting lines between 
sample points.

Show annotations displays X and Y values of sample points.

Show X grid draws light vertical lines through sample points, 
making it easier to see their X values.

Show Y grid draws light horizontal lines through sample points, 
making it easier to see their Y values.

If control limits were specified by Use control limits on the 
Instrument tab, Show limit lines displays for each sample point 
the triangular control limit markers.

If control limits were specified, Connect points (in Limit Lines) 
draws connecting lines between the triangular control limit 
markers.

Feature Description
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To show or hide labels

Right-click the pane, point to Sample Labels and choose ON or OFF.

To move a label

Drag it to the new position.

To edit a label

Double-click it and use the dialog box that appears to change the text, its font or its color, or 
right-click the label and choose Edit, Color or Font.

To rotate a label

Right-click it, point to Rotate and choose an orientation.

To move a label in front of or behind annotation

Right-click it and choose Send to Front or Send to Back. Click here for information about 
adding annotation.

To delete a label

Right-click it and choose Delete.

Related Topics

Using the Palette Tools and View Finder

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data
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Data Display

Measurement Results

Below the data display in some applications is a table of measurement results. To display a 
spectrum, click its row in the table.

To view, copy or print information about a spectrum, including its history, right-click it in the 
table and choose Properties.

To delete a spectrum from the workbook, right-click it in the table and choose Remove (if 
available). To delete all the spectra from the workbook, right-click the table and choose 
Remove All (if available).

Any Peak Pick or Value Level results appear to the right of the data display.

Menus

The File menu includes:

To print a report containing results information for a sample, select it in the table 
and click Print or choose File (menu) > Print Report. To preview the report, 
choose File > Print Preview. To specify the information to include, use the Print 
tab and Configuration tab in Reports.

Command Description

New Workbook Opens a new workbook and closes and saves the current workbook.

Save Workbook If available, saves the current workbook using its current file name 
and location.

Save As Workbook If available, saves the current workbook with the specified file name 
and location.

Close Workbook and 
Go Home

Closes and saves the current workbook and returns to Home.

Close All Workbooks 
and Go Home

Closes all open workbooks (all applications) and returns to Home.

Import If available, imports an externally collected spectrum (.csv file or .tsv 
file) into the current Scan workbook.

Print Preview Shows the current report before printing, with the header and footer 
specified on the Report Master Page tab in Options.

Print Report Prints the current report to the default printer.

Use Current Settings 
as Default

Makes the current workbook settings and report configuration 
selections the default choices for a newly opened workbook for the 
application.
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The Math menu, when available, includes:

The Analyze menu, when available, includes:

The Operations menu, when available, includes:

The Help menu includes:

Save Workbook 
Settings as Template

If available, saves the current software settings as a template that can 
be used later by the specified user group.

E-mail Current 
Workbook

Automatically attaches the current workbook to a new e-mail 
message.

Command Description

Smooth Reduces noise in wavelength scan data. The smoothing algorithm uses 
the Savitzky-Golay method.

Derivative Converts scan data to a derivative.

Convert Spectra Converts wavelength scan data to another Y-axis format.

Add Adds two scan spectra.

Normalize Adjusts the Y scale of scan data so that a selected data point has the 
desired Y value.

Subtract Subtracts one scan spectrum from another.

Ratio Divides one scan spectrum by another.

Average Averages two or more scan spectra.

Factor Adds a constant to scan data, subtracts a constant, multiplies by a 
constant or divides by a constant.

Command Description

Peak Pick Finds peaks, valleys, or maximum and minimum values in a spectrum or 
region.

Value Level Finds the wavelengths where a spectrum crosses a specified ordinate value.

Command Description

Export Saves Measure Rate results in a file with the extension .xml. If opened in Excel®, 
the data is displayed with one column per spectrum, and one sample per sheet.

Command Description
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Related Topics

Navigation Pane

Right Pane

Instrument Status Monitors

Related Topics

Accessories

Accessories Tab for Fixed

Accessories Tab for Scan

Accessories Tab for Quant

Accessories Tab for Rate

Command Description

Help Displays the INSIGHT Help system, which can also be accessed from many 
software screens by pressing F1.

About Provides information about the software version and instrument type.

Various instrument status monitors may appear above the data display. 
They show information such as the current wavelength or readouts from 
installed accessories. One can double-click some status monitors to set 
operation parameters such as channel assignment. See Accessories for 
more information.

To specify the items to monitor, click this icon.

If the system is operating normally, a green check mark appears on the Instrument 
Status icon at the bottom of the INSIGHT window.

A yellow exclamation mark appears briefly on the icon when the system is busy 
performing an operation.

If a system problem occurs, a red X may appear on the icon. Click it to see 
information about the problem.
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Thermo Software IQ
Thermo Software IQ performs Installation Qualification (IQ) for the software. IQ verifies 
that the correct software files were installed and can also be used to verify that these files have 
not been changed, deleted, or overwritten since they were installed. (For more information, 
see the Thermo Software IQ user guide available through the Help menu of the software.)

To start Thermo Software IQ

1. Click Start on the Windows taskbar.

2. Choose All Programs (or Programs) > Thermo > Thermo Software IQ.

Contact Information

For help with questions or problems with the software, see Contacting Us.

Operation

Measuring Samples

If the current application provides a Measure button in the navigation pane, use it to access 
data acquisition features for the application. The name of the application appears on the 
button; for example:

Clicking the button displays action buttons for starting sample measurement or other data 
acquisition. The provided buttons and their availability depend on the current application 
and whether necessary operations have been performed. See Action Buttons.

Contents

• Measuring Samples

• Performing a Quantitative Analysis

• Performing a Kinetics Measurement

• Using the Palette Tools and View Finder

• Setting Application Parameters

• Sharing Custom Templates

• Managing Data

• Math and Analysis Operations
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Measurement results appear in the right pane.

See Setting Application Parameters for information about setting parameters that affect data 
acquisition, including those for controlling sampling accessories. See Accessories for 
information about using accessories.

Related Topics

Quantifying Sample Data

Performing Kinetics Measurements

Making Nucleic Acid Measurements

Making Nucleic Acid Labels Measurements

Making Protein A280 Measurements

Making Proteins and Labels Measurements

Making Pierce BCA Measurements

Making Protein Bradford Assay Measurements

Making Pierce Modified Lowry Assay Measurements

Making Pierce 660 nm Protein Assay Measurements

Making Protein Biuret Assay Measurements

Performing a Quantitative Analysis

Click Quant in the right pane in Home to set up and 
perform quantitative analyses of sample data. The tasks 
buttons below become available.

To set Quant parameters, click Settings.

To access features for quantifying sample data, click 
Measure Quant.

To specify the predefined formulas, units and advanced 
equations to be available, click Options and use the 
Formulas & Units tab.
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Related Topics

Quant

Quantifying Sample Data

Formulas and Units Tab

Quantifying Sample Data

Related Topics

Performing a Quantitative Analysis

Data Display

Quantifying Samples Without Using Standards

To quantify samples without using standards

1. Click Measure Quant in Quant.

2. Click Measure.

3. Follow the instructions that appear.

4. When samples information appears, modify it if desired.

More:

Contents

• Quantifying Samples Without Using Standards

• Quantifying Samples Using Standards

Note  Select Manually entered factor or Advanced without standards on the Type tab 
before using this procedure.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, install it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation.) See Data Display for more information.

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Quantifying Samples Using Standards

Performing a Quantitative Analysis

Data Display
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Quant

Formulas and Units Tab

Quantifying Samples Using Standards

To quantify samples using standards

1. Click Measure Quant in Quant.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

4. When standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

Note  Select Measure single standard, Standard curve, Standard curve with two 
wavelengths or Advanced standard curve on the Type tab before using this procedure.

Note  To start an analysis immediately after viewing or changing the template settings, 
start with the next step.
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The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. (If there are two analysis wavelengths, the concentration value is the average of 
the values for those wavelengths.) If Use concentration limits was selected on the Samples 
tab, horizontal limit lines show whether the concentrations are within the specified limits:

Note  If there are two analysis wavelengths, the lines appear for each of the two 
standard curves.
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Quantifying Samples Without Using Standards

Performing a Quantitative Analysis

Data Display

Quant

Formulas and Units Tab

Performing a Kinetics Measurement

Click Rate in the right pane in Home to set up and 
perform a kinetics measurement. The tasks buttons below 
become available.

To set Rate parameters, click Settings.

To access features for performing the measurement, 
click Measure Rate.
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Performing Kinetics Measurements

Related Topics

Performing a Scan Kinetics Measurement

Data Display

Performing a Fixed Kinetics Measurement

Kinetics measurements can be made at one wavelength or at more than one wavelength 
simultaneously. This includes multicell kinetics, which allows running a fixed-wavelength 
measurement on several samples simultaneously using a sample changer.

To perform a fixed kinetics measurement

1. Make sure Single wavelength or Multiple wavelength is selected on the Type tab in 
Settings in Rate.

2. Click Measure Rate.

3. Click Zero.

4. In cell position 1 load the sample to use to measure the zero and choose OK.

5. Click Measure.

If necessary, the Zero action button can be used to remeasure the zero sample.

6. When samples information appears, modify it if desired.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

Contents

• Performing a Fixed Kinetics Measurement

• Performing a Scan Kinetics Measurement
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Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the rate data report.

7. Click Continue.

8. Follow the instructions that appear.

Each row on the Data tab shows the measurement results for a single sample, and each 
column is for one wavelength. Each plot on the tab shows a sample’s spectral intensity 
measured at a particular wavelength over time.

Scroll bars are provided if plots are out of view.

Right-click the Data tab to access features for changing the scale or adding annotation. 
See Data Display for more information.

The results table contains the columns of information specified on the Configuration tab 
in Reports.

9. To perform rate calculations or modify existing rate calculations on the data in a plot, 
double-click it.

More:

A dialog box displays the plot and a table containing the default rate calculation values 
based on the Rate Calculations tab in Settings.

a. If desired, add or change sets of rate calculation values for the displayed data. Each set 
represents a curve that describes the rate behavior over the specified time period.

To delete a row from the table, right-click it and choose Delete Selected Row. To 
delete all the information from the table, right-click it and choose Clear Table.

b. Click Update to generate kinetic rate models, each of which appears as a line across 
the data.
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c. Specify how to apply the lines and then click Accept.

The dialog box closes, the lines appear across the specified plots, and the results table 
is updated with information about the model lines.

Related Topics

Rate

Data Display

Performing a Scan Kinetics Measurement

Performing a Scan Kinetics Measurement

Kinetics measurements can be made on several samples simultaneously using a sample 
changer or run in a sequential, manual mode.

To perform a scan kinetics measurement

1. Make sure Scan data acquisition is selected on the Type tab in Settings in Rate.

2. Click Measure Rate.

3. Click Zero.

This option... Applies the lines to...

This plot only The displayed data only.

All plots with this wavelength only All plots for the current wavelength.

All plots All plots.
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4. In cell position 1 load the sample to use to measure the zero and choose OK.

5. Click Measure.

If necessary, the Zero action button can be used to remeasure the zero sample.

6. When samples information appears, modify it if desired.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the rate data report.

7. Click Continue.

8. Follow the instructions that appear.

Each grid on the Data tab displays all the spectra acquired for a particular sample.

A scroll bar is provided if spectra are out of view.

Right-click the Data tab to access features for changing the scale or adding annotation. 
See Data Display for more information.

A result table appears below the spectra.
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Related Topics

Rate

Data Display

Performing a Fixed Kinetics Measurement

Using the Palette Tools and View Finder

Using the Selection Tool

Use the selection tool (if present) to zoom in or move the spectrum.

To zoom in, draw a box and click inside it. To move the spectrum, drag it up or down.

Related Topics

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Spectral Cursor Tool

Use the spectral cursor tool (if present) to view the X and Y values of a point in a spectrum.

Contents

• Using the Selection Tool

• Using the Spectral Cursor Tool

• Using the Peak/Valley Measurement Tool

• Using the Peak Area Tool

• Using the Region-Threshold Tool

• Using the View Finder

Note  To display the palette, click .
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To view the X and Y values of a point

1. Select the spectral cursor tool.

2. Click the data display.

Cross hairs appear. The X and Y coordinates of their intersection with the spectrum 
appear below the palette.

To move the cross hairs, drag across the pane or use the left and right arrow keys on the 
keyboard.

To remove the cross hairs from the display, select another tool such as the selection tool.

Related Topics

Using the Selection Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Peak/Valley Measurement Tool

Use the peak/valley measurement tool (if present) to measure the height of a peak or depth of 
a valley from a specified baseline.

To measure a peak or valley

1. Select the peak/valley measurement tool.

2. Click the data display.

A vertical line appears. The X and Y coordinates of its intersection with the spectrum 
appear below the palette.

3. Drag the line by its diamond-shaped handle to the peak or valley to measure.

4. Drag the triangular baseline handles to the desired baseline endpoints.

The height or depth of the peak or valley appears below the palette.

Note  To display the palette, click .

Note  To display the palette, click .
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To annotate the spectrum with the measured value, right-click the spectrum, point to 
Annotate and choose Tool Value. See Working With Labels.

To remove the vertical line and baseline from the display, select another tool such as the 
selection tool.

Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Peak Area Tool

Use the peak area tool (if present) to measure the corrected area of a peak. This area is 
bordered by the spectrum, two vertical lines and a baseline.

To measure a peak

1. Select the peak area tool.

2. Click the data display.

Two vertical lines appear (see the illustration below). Their X values define the limits of 
the region to measure and appear in the Region readout.

3. Drag the lines by their triangular handles to the desired locations.

4. Drag the triangular baseline handles (see the illustration below) to the desired baseline 
endpoints.

The X values of the endpoints appear in the Baseline readout. The defined area is shaded, 
and its measurement appears in the Corrected area readout. Here is an example showing 
the region limits and baseline endpoints adjusted to measure the corrected area of a peak:

Note  To display the palette, click .
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To annotate the spectrum with the measured area, right-click the spectrum, point to 
Annotate and choose Tool Value. See Working With Labels.

To remove the vertical lines and baseline from the display, select another tool such as the 
selection tool.

Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Region-Threshold Tool

For data analysis operations such as locating peaks, use the region-threshold tool (if present) 
to limit the wavelength region.

Drag the vertical lines in the data display or drag horizontally between them to move both at 
once.

Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Note  To display the palette, click .
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Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the View Finder

Using the View Finder

For data analysis operations such as locating peaks, use the view finder (if present) to adjust 
the data display.

The currently displayed region is indicated by the region markers, the bold vertical lines.

To expand horizontally

To expand vertically

To expand or contract vertically while keeping the top or bottom of spectra in place

To display a different region of the same size

There are three ways to do this: 

• To move the spectrum to the right, click the top half of the Roll button.

Note  To display the view finder, click .

Click the top half of the Horizontal Expand/Contract button. To contract 
horizontally, click the bottom half.

Click the left half of the Vertical Expand/Contract button. To contract vertically, 
click the right half.

To expand vertically while keeping the bottom of the spectra in place, click the 
symbol at the top of this button.

To expand vertically while keeping the top of the spectra in place, click the symbol 
at the right.

To contract vertically while keeping the bottom of the spectra in place, click the 
symbol at the bottom.

To contract vertically while keeping the top of the spectra in place, click the symbol 
at the left.



 2 INSIGHT Software
Operation

Thermo Scientific Evolution 200 Series User Guide 41

To roll to the left, click the bottom half.

• Drag between the region markers.

• Click to the left of the left region marker or to the right of the right region marker.

To change the display limits by moving the region markers

Drag a region marker left or right.

To display the entire spectrum 

Double-click between the region markers.

Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Setting Application Parameters

The tabs in the right pane (and their features) depend on the application.

If  appears on a tab, point to it and read the information to correct the problem.

Action buttons for the current application may include:

To set parameters that determine how data will be 
acquired or quantified with the current application, click 
Settings.

Button Description

Displays data acquisition features for the application and starts an acquisition.
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Fixed

Instrument Tab for Fixed
Accessories Tab for Fixed
Samples Tab for Fixed

Change Fixed workbook settings as desired before making sample measurements. All Fixed 
measurements are saved in a workbook that includes the data acquisition settings.

Instrument Tab for Fixed

Resets the parameters on all the tabs to their default values. For Quant and Rate, 
also steps through each tab in sequence.

Makes the parameters on all the tabs available, closes the current workbook, and 
creates a new workbook.

Button Description

To set data acquisition parameters for a Fixed workbook, 
click Settings to access:

Click Settings in Fixed to display the Instrument tab in 
the right pane.

Feature Description

Data mode Y-axis format for acquired data.

Integration time How long the system acquires and averages data at each measured 
wavelength. Increasing the integration time improves the 
signal-to-noise ratio.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve 
the signal-to-noise ratio; however, a larger spectral bandwidth 
decreases the ability to resolve closely spaced spectral features.
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Result mode Determines how results are calculated and displayed:

Normal displays the results in the units specified in the Data mode 
setting (see above).

Peak Height calculates the peak height with respect to a sloping 
baseline defined by two wavelengths adjacent to the center peak:

The lowest of the three measured wavelengths defines the start of 
the sloping baseline, the middle wavelength defines the peak 
location, and the highest wavelength defines the end point of the 
sloping baseline.

Wavelength 1 + Wavelength 2 adds the Y values at the two 
measured wavelengths.

Wavelength 1 - Wavelength 2 subtracts the Y value at the second 
measured wavelength from the Y value at the first.

Wavelength 1 / Wavelength 2 divides the Y value at the first 
measured wavelength by the Y value at the second.

Reference wavelength 
correction

If available and selected, subtracts the background intensity at the 
specified reference wavelength from the sample intensity at all 
measured wavelengths. The reference wavelength value appears in 
red in the table of wavelengths.

Use control limits If available and selected, specifies the control limits for each 
wavelength in the table. The limits, shown as triangular markers in 
the data display (and listed in the table to the right of the display), 
indicate whether each measured data point is within specification. 
Enter the desired upper and lower limits for each wavelength in the 
table, using the appropriate units for the selected data mode.

Feature Description
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Related Topics

Setting Application Parameters

Fixed

Accessories Tab for Fixed

Samples Tab for Fixed

Accessories Tab for Fixed

The status of accessories can be monitored during measurements.

Related Topics

Accessories

Setting Application Parameters

Fixed

Instrument Status Monitors

Instrument Tab for Fixed

Samples Tab for Fixed

Table of wavelengths Wavelengths at which measurements will be made, plus the 
corresponding control limits if specified (see above). The number 
of required wavelengths depends on the setting of Result mode (see 
above). To enter or change the value in a table cell, click it and 
type. To order the list by wavelength, lower control limit or upper 
control limit, click the appropriate column heading.

Autoscale Autoscale automatically adjusts the Y-axis scale for optimal viewing 
of data during a measurement.

Ordinate Y scale To specify the Y-axis display limits, deselect Autoscale and set Max 
and Min to the desired maximum and minimum Y values, 
respectively, in the range 400 to -400.

Description (optional) Description of the template.

Click Settings in Fixed to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. See Accessories for details.

Feature Description
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Samples Tab for Fixed

Related Topics

Setting Application Parameters

Fixed

Instrument Tab for Fixed

Accessories Tab for Fixed

Click Settings in Fixed to display the Samples tab in the 
right pane.

Feature Description

Number of samples Number of samples in the samples table.

Increment sample name 
from selected row

For creating sequentially numbered sample names in the samples 
table if Number of samples (see above) is set to 2 or greater:

1. Select Increment sample name from selected row.

2. Click the cell in the Sample Name column for starting the 
sequence.

3. Type a new sample name.

4. Press Enter.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated 
values) file, .csv (comma separated values) file, or .xml 
(extensible markup language) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum 
of 1000. To change a sample name, click its cell and edit the text. 
To enter or change text in a table cell, click it and type. To order 
the list by sample name or description, click the appropriate 
column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Scan

Instrument Tab for Scan
Measurement Tab for Scan
Correction Tab for Scan
Accessories Tab for Scan
Samples Tab for Scan

Instrument Tab for Scan

To set data acquisition parameters for a Scan workbook, 
click Settings to access:

Click Settings in Scan to display the Instrument tab in 
the right pane.

Feature Description

Data mode Y-axis format for acquired data.

For Abs*Factor, set Factor to a value by which to multiply measured 
absorbance values.

Smooth Select the desired degree of smoothing (if available for the selected 
data mode and Derivative setting). Smoothing reduces noise in the 
data but can also remove some spectral features such as small peaks, 
valleys and shoulders. For more information, see About Smoothing.

Derivative Select the desired derivative order for acquired data (if available for 
the selected data mode).

Start wavelength 
and End wavelength

Starting and ending values of the wavelength range for acquiring data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve the 
signal-to-noise ratio; however, a larger spectral bandwidth decreases 
the ability to resolve closely spaced spectral features, especially in 
scanning measurements.

Integration time How long the system acquires and averages data at each data interval. 
Increasing the integration time improves the signal-to-noise ratio but 
reduces the scan speed.

Data interval Difference in wavelength between two consecutive data points.

Scan speed Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.
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Related Topics

Setting Application Parameters

Scan

Measurement Tab for Scan

Correction Tab for Scan

Samples Tab for Scan

Accessories Tab for Scan

Measurement Tab for Scan

Related Topics

Setting Application Parameters

Scan

Estimated time Estimated duration of data acquisition. Increases as integration time 
increases and as the data interval decreases. Varies inversely with scan 
speed.

Autoscale Auto scale automatically adjusts the Y-axis scale for optimal viewing 
of data during a measurement.

Ordinate Y scale To specify the Y-axis display limits, deselect Autoscale and set Max 
and Min to the desired maximum and minimum Y values, 
respectively, in the range 400 to -400.

Description 
(optional)

Description of the template.

When setting up a Scan workbook, click Settings to 
display the Measurement tab in the right pane.

Feature Description

Result Data analysis operation to perform automatically after sample measurement.

Select Off to not perform any operation.

The parameters for a selected operation appear to the right. See Finding Peaks in 
Scan Data or Finding Value Level Crossings in Scan Data for information on 
setting them and how results are displayed.

Feature Description
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Instrument Tab for Scan

Correction Tab for Scan

Samples Tab for Scan

Accessories Tab for Scan

Correction Tab for Scan

Click Settings in Scan to display the Correction tab in 
the right pane. Three baseline correction types are 
available:

Type Description

100%T baseline Standard baseline correction. The data may be acquired 
using an empty holder or using solvent.

0%T or 0%R baseline Corrects for any inherent variations in the electronic zero 
line of the instrument.

More:

This can be more of a factor at lower light energy levels 
present in a DRA (Diffuse Reflectance Accessory) and when 
working at high absorbance levels.

For more information, see ASTM method E903. The 
calculation in transmission performed in the instrument is:

 or 

Requires a previously acquired 100%T baseline.

S - 0%T
100%T - 0%T
---------------------------------- S - 0%R

100%R - 0%R
-----------------------------------
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Select Standard reference correction with 0%R or 0%T baseline to display additional 
features:

Related Topics

Setting Application Parameters

Scan

Instrument Tab for Scan

Measurement Tab for Scan

Samples Tab for Scan

Standard reference correction 
with 0%R or 0%T baseline

Applies a 100%T baseline correction and a zero line 
correction (0%R baseline) to a sample measured with a 
reflectance accessory that is not absolute (for example, a 
Diffuse Reflectance Accessory).

More:

The software multiplies the scan result at each data point by 
the corresponding value in the table (explained below).

The calculation in reflectance performed in the instrument 
is:

Requires a previously acquired 100%T baseline.

Correct single beam 
substitution error

Allows the ratioed spectrum acquired with the single-beam 
sphere to be corrected as if it were acquired with a 
double-beam instrument (where the baseline is collected in 
the integrating sphere). Requires that Data mode on the 
Instrument tab be set to Absorbance, % Transmittance, 
% Reflectance or Log(1/R).

Feature Description

Clear Table Clears information from the table.

Load Table Fills the table with wavelength and intensity values from a .tsv (tab separated 
values) file or .csv (comma separated values) file containing X delimiter Y 
pairs.

Save Table Saves in a .tsv file, .csv file, or .xml (extensible markup language) file the 
wavelength and intensity values in the table.

Type Description

S - 0%R
100%T - 0%R
---------------------------------- Std. Ref.×



2 INSIGHT Software
Operation

50 Evolution 200 Series User Guide Thermo Scientific

Accessories Tab for Scan

Accessories Tab for Scan

The status of accessories can be monitored during measurements.

Related Topics

Accessories

Setting Application Parameters

Scan

Instrument Status Monitors

Instrument Tab for Scan

Measurement Tab for Scan

Correction Tab for Scan

Samples Tab for Scan

Samples Tab for Scan

Click Settings in Scan to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. See Accessories for details.

Click Settings in Scan to display the Samples tab in the 
right pane.

Feature Description

Number of samples Number of samples in the samples table.

Increment sample name 
from selected row

For creating sequentially numbered sample names in the samples 
table if Number of samples (see above) is set to 2 or greater:

1. Select Increment sample name from selected row.

2. Click the cell in the Sample Name column for starting the 
sequence.

3. Type a new sample name.

4. Press Enter.
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Related Topics

Setting Application Parameters

Scan

Instrument Tab for Scan

Measurement Tab for Scan

Correction Tab for Scan

Accessories Tab for Scan

Quant

Type Tab for Quant
Measurement Tab for Quant
Standards Tab for Quant
Instrument Tab for Quant
Accessories Tab for Quant
Samples Tab for Quant

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated 
values) file, .csv (comma separated values) file, or .xml 
(extensible markup language) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum 
of 1000. To change a sample name, click its cell and edit the text. 
To enter or change text in a table cell, click it and type. To order 
the list by sample name or description, click the appropriate 
column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

To set parameters that define a Quant template, click 
Settings to access: 
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Related Topics

Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Type Tab for Quant

If only the Type tab appears, set its parameters. Click Next at the bottom 
of the tab to set parameters on the next tab, and so on. To return to the 
previous tab, click Previous. Click Finish when ready to complete the 
process. To cancel the operation, click Cancel.

Note  Change Quant settings only before sample measurements. All Quant measurements 
saved in a workbook must be made with the same settings. See Setting Application 
Parameters for information about unlocking settings.

Click Settings in Quant to display the Type tab in the 
right pane.

Feature Description

Name (if present) User group name followed by the name of the template of settings 
(entered when the template was saved using Save Workbook Settings as 
Template in the File menu).

Description 
(optional)

Optional description of the template.

Quant Type Type of quantitative analysis (see the table below). An image 
representing the selected type appears to the right. The required tabs also 
appear (click the Reset action button to step through them).
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Related Topics

Quant

Measurement Tab for Quant

Standards Tab for Quant

Instrument Tab for Quant

Samples Tab for Quant

Accessories Tab for Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Measurement Tab for Quant

Type How the Type Calculates Sample Concentration

Manually entered 
factor

Uses the equation C = K * A, where C is the concentration of the 
analyte in the selected units, K is the entered factor, and A is the 
absorbance.

Measure single 
standard

Divides the sample absorbance value by the average absorbance value 
of a single standard. This is in effect a “Standard curve” quantification 
(see below) with just one standard.

Standard curve Uses a simple standard curve based on the absorbance of a set of 
standards at a specified wavelength.

Standard curve with 
two wavelengths

Takes the average of values determined by each of two standard curves 
associated with the specified wavelengths.

Advanced standard 
curve

Uses a standard curve generated from a specified equation.

Advanced without 
standards

Uses a “single result equation” specified on the Measurement tab. 
(Calculates the concentration or answer directly from this equation.)

Click Settings in Quant to display the Measurement tab 
in the right pane. The available features depend on the 
Quant Type setting on the Type tab. The features for 
each type are described in tables below.
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Manually entered factor

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction To use uncorrected data, select None.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the 
entered wavelengths, finds its Y value at the analytical 
wavelength, and subtracts it from the measured absorbance.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Use user-defined factor Calculates component concentration using the entered factor (K 
in the equation C = K *A), with the selected unit.

Use extinction coefficient Calculates component concentration with absorbance (A) equal 
to

where ε is the entered extinction coefficient (a constant 
dependent on the component and wavelength), c is 
concentration in the selected unit, and  is 1 cm (the 
pathlength).

lcε
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Measure single standard

Molecular weight Molecular weight of the component. Available only if the units 
specified on this tab are different and require this value for a 
conversion.

Calculate additional 
results

For selecting or defining formulas for additional data 
processing, with the results appearing in the analysis report. The 
formulas are written in a form similar to that used in a 
command script language, with constants, mathematical 
functions, etc. (See “Operations and Functions” for definitions 
of operations and functions.) All functions are case-sensitive. 
Spaces are not allowed between a function name and “(”. After 
adding formulas, edit their information in the formula table as 
desired. To delete a table row, right-click it and choose Delete 
Row.

Instructions:

To use one or more predefined formulas

1. Click Select.

2. Select the desired formulas.

Hold down the Ctrl or Shift keys on the keyboard while 
making multiple selections. The available formulas depend 
on the Formulas & Units tab settings in Options.

3. Choose OK.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, 
select it and enter values for the variables.

The available formulas depend on the Formulas & Units 
tab settings.

3. Click OK.

4. For selected provided formulas, enter a name and 
concentration unit in the table.

The available units depend on the Formulas & Units tab 
settings.

Feature Description
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Standard curve

Standard curve with two wavelengths

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Standard concentration Concentration of the single standard.

Calculate additional 
results

See Calculate additional results above.

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.

Feature Description

Analysis wavelengths Wavelengths to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings.

Calculate additional 
results

See Calculate additional results above.
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Advanced standard curve

Feature Description

Standard Curve Equation Equation used to quantify samples, written in a form similar to 
that used in a command script language, with constants, 
mathematical functions, etc. (See Operations and Functions for 
definitions of operations and functions.) All functions are not 
case-sensitive. Spaces are not allowed between a function name 
and “(”.

For this Quant type the equation defines the value for the Y-axis 
of the calibration curve.

Instructions:

To use a predefined equation

1. Click Select.

2. Select the desired equation and click OK.

The available equations depend on the Formulas & Units 
tab settings in Options.

To define an equation

1. Click Build.

2. To enter an equation in its entirety, set Equation type to 
User defined and type the equation. To use a provided 
equation, select it and enter values for the variables.

The available equations depend on the Formulas & Units 
tab settings.

3. Click OK.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.
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Advanced without standards

Related Topics

Operations and Functions

Quant

Type Tab for Quant

Standards Tab for Quant

Instrument Tab for Quant

Samples Tab for Quant

Accessories Tab for Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Operations and Functions

The tables below describe the operations and functions usable in Quant equations specified 
on the Measurement tab. Arithmetic operations (including functions) are performed first, 
followed by comparison operations, and finally logical operations.

Feature Description

Single Result Equation See Standard Curve Equation above for instructions.

For this Quant type the equation is used to obtain a single 
concentration result (without using standards).

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.

Note  The operators, arguments and functions are not case-sensitive.
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Arithmetic Operations

Comparison Operations

Logical Operations

The following equation functions produce a value based on one or more arguments you 
supply.

Operator Description Example Returned by Example Operation

+ Addition 2 + 6 + 4 12

- Subtraction 25 - 4 21

* Multiplication 25 * 4 100

/ Division 25 / 4 6.25

- Negation -4 + 25 21

mod Modulo division 
(returns remainder)

16 mod 5 1

& Text addition “abc” & “def” “abcdef”

Operator Description Example Result

>= Greater than or equal (3 + 2) >= 4 true

<= Less than or equal (3 + 2) <= 5 true

=, == Equals (2 + 2) = 4 true

!=, <> Does not equal (2 + 2) != 5 true

< Less than 5 < 4 false

> Greater than 5 > 4 true

true The value “true” (5 > 4) = true true

false The value “false” (5 > 4) = false false

Operator Description Example Result

AND If both sides of the AND are true, result is true 5 > 4 AND 2 = 3 false

OR If either side of the OR is true, result is true 5 > 4 OR 2 = 3 true
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Example Function Arguments

Arithmetic Functions

Logarithmic Functions

Argument Description

<number>, <angle>, <length>, 
<value>, <power>, <start>, <len>

An expression that yields a number.

<list> Any expression that yields a list of numbers.

<text>, <sub> An expression that yields a text.

Function Returned or Performed by Function

abs(<number>) Absolute value of a number.

ceiling(<number>) Smallest integer greater than or equal to <number>. Example:

Ceiling(2.2) is 3.0

floor(<number>) Largest integer less than or equal to <number>. Example:

Floor(2.7) is 2.0

random() Random fractional number between 0 and 1.

round(<number>) Rounds a double value to the nearest integer value.

sqrt(<number>) Square root of a number.

truncate(<number>) Truncated number. Everything to the right of the decimal point is 
removed, leaving only the integer portion of the number. The 
returned value is not rounded.

Function Returned by Function

exp(<number>) Result of the constant e (2.7182818) raised to the power of the 
specified number (e^<number>).

ln(<number>) Natural logarithm (base e logarithm) of a number.

log10(<number>)

log(<number>)

Base 10 logarithm of a specified number.

pow(<value>, <power>) Value raised to the power. Example:

pow(2,3) is 8.0
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Trigonometric Functions

Statistical Functions

Text Functions

Note  For functions acos and asin, <number> is an expression that yields a number in the 
range -1 to 1.

Note  The formula for converting degrees to radians is radians = degrees * (pi/180).

Function Returned by Function

acos(<number>) Arccosine of a number in radians.

asin(<number>) Arcsine of a number in radians.

atan(<number>) Arctangent of a number in radians.

atan2(<number1>,<number2>) Arctangent of <number1> divided by <number2> in 
radians. The signs of both arguments are used to 
determine the quadrant of the returned value.

cos(<angle>) Cosine of an angle measured in radians.

cosh(<angle>) Hyperbolic cosine of an angle measured in radians.

pi() Ratio of the circumference of a circle to its diameter.

sin(<angle>) Sine of an angle measured in radians.

sinh(<angle>) Hyperbolic sine of an angle measured in radians.

tan(<angle>) Tangent of an angle measured in radians.

tanh(<angle>) Hyperbolic tangent of an angle measured in radians.

Function Returned by Function

average(<list>) Average of a list of numbers (sum divided by the number of items).

max(<list>) Highest value from two or more numbers.

min(<list>) Lowest value from two or more numbers.

sum(<list>) Sum of a list of numbers.

Function Returned by Function

FindTextIndex(<search>, 
<text>)

Index of the first occurrence of the <search> text in the 
specified text. If the text is not found, a -1 is returned.

Lowercase(<text>) Copy of the text converted to lower case using the casing rules 
of the current culture.



2 INSIGHT Software
Operation

62 Evolution 200 Series User Guide Thermo Scientific

Measurement Functions

PassFail(<expression>) “Pass” in the language of the current culture if the expression 
evaluates to true; otherwise, “Fail”.

Quote Text containing the quote (“) character.

Return Text containing a carriage return.

TextLength(<text>) Number of characters, including spaces, in the specified text. 
A CRLF is counted as two characters.

ExtractText(<text>, <start>, 
<len>)

Portion of the specified text. The extracted text starts at the 
specified <start> index and has a specified length.

Tab Text containing the tab character.

ToNumber(<text>) Numeric representation of the text.

ToText(<number>) Text representation of the number.

Function Returned or Performed by Function

Y(location) Y-axis value at the given location.

Y(location, baseline) Y-axis value at the given location with a one-point baseline.

Y(location, baseline1, 
baseline2)

Y-axis value at the given location with a two-point baseline.

Area(start, end) Area between two spectral limits.

Area(start, end, 
baseline)

Area between two spectral limits using a one-point baseline.

Area(start, end, 
baseline1, baseline2)

Area between two spectral limits using a two-point baseline.

PMin(start, end) Minimum Y-axis value between two spectral limits.

PMax(start, end) Maximum Y-axis value between two spectral limits.

PMax(start, end, 
baseline)

Corrects the spectrum with a one-point baseline and then report the 
maximum Y-axis value between two spectral limits.

PMax(start, end, 
baseline1, baseline2)

Corrects the spectrum with a two-point baseline and then report the 
maximum Y-axis value between two spectral limits.

PLoc(start, end) Location (X-axis value) at which the maximum Y-axis value occurs 
between two spectral limits.

PLoc(start, end, 
baseline)

Corrects the spectrum with a one-point baseline and then report the 
location (X-axis value) at which the maximum Y-axis value occurs 
between two spectral limits.

Function Returned by Function
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Related Topics

Measurement Tab for Quant

Formulas and Units Tab

Performing a Quantitative Analysis

Standards Tab for Quant

PLoc(start, end, 
baseline1, baseline2)

Corrects the spectrum with a two-point baseline and then report the 
location (X-axis value) at which the maximum Y-axis value occurs 
between two spectral limits.

PWidth(start, end, 
percent)

Determines the peak width between two spectral limits. Report the 
width at which the peak reaches a specified percentage of the peak 
maximum.

Pavg(start, end) Determines the average value of the spectrum between two spectral 
limits.

Pcut(start, end, 
percent)

Determines the location (X-axis value) of the cut-on or cut-off point 
in the specified spectral region. For example, for a region with 
increasing Y value, a cut-on point occurs where the increase reaches 
the specified percentage of total increase across the region. Here is an 
example showing a cut-on point with “percent” set to 60:

To display the Standards tab in the right pane, click 
Settings in Quant and then set Quant Type to Standard 
curve, Standard curve with two wavelengths, or 
Advanced standard curve.

Function Returned or Performed by Function
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Related Topics

Quant

Type Tab for Quant

Measurement Tab for Quant

Instrument Tab for Quant

Samples Tab for Quant

Accessories Tab for Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Standard Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Instrument Tab for Quant

Related Topics

Quant

Click Settings in Quant to display the Instrument tab in 
the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

For Abs*Factor (Scan only), set Factor to a value by which to 
multiply measured absorbance values.

Smooth (Scan only) Select the desired degree of smoothing (if available for the 
selected data mode and Derivative setting). Smoothing reduces 
noise in the data but can also remove some spectral features 
such as small peaks, valleys and shoulders. See About 
Smoothing.

Derivative (Scan only) Select the desired derivative order for acquired data (if available 
for the selected data mode).

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for 
acquiring data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for Scan) or at each measured wavelength (for Fixed). 
Increasing the integration time improves the signal-to-noise 
ratio but reduces the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Type Tab for Quant

Measurement Tab for Quant

Standards Tab for Quant

Samples Tab for Quant

Accessories Tab for Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Accessories Tab for Quant

The status of accessories can be monitored during measurements.

Related Topics

Quant

Accessories

Instrument Status Monitors

Type Tab for Quant

Measurement Tab for Quant

Standards Tab for Quant

Instrument Tab for Quant

Samples Tab for Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Click Settings in Quant to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. See Accessories for details.
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Samples Tab for Quant

Related Topics

Quant

Type Tab for Quant

Measurement Tab for Quant

Standards Tab for Quant

Instrument Tab for Quant

Accessories Tab for Quant

Formulas and Units Tab

Quantifying Sample Data

Performing a Quantitative Analysis

Click Settings in Quant to display the Samples tab in 
the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)
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Rate

Type Tab for Rate
Measurement Tab for Rate
Instrument Tab for Rate
Accessories Tab for Rate
Samples Tab for Rate
Rate Calculations Tab for Rate

Related Topics

Rate

Performing a Kinetics Measurement

Type Tab for Rate

Related Topics

Measurement Tab for Rate

Instrument Tab for Rate

Accessories Tab for Rate

Samples Tab for Rate

Rate Calculations Tab for Rate

Performing a Kinetics Measurement

To set parameters for the current Rate workbook, click 
Settings to access: 

Click Settings in Rate to display the Type tab in the 
right pane.

Feature Description

Name User group name followed by the name of the template of settings (entered 
when the template was saved using Save Workbook Settings as Template in 
the File menu).

Description Description of the template.

Rate Type Type of kinetics measurement to perform.
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Measurement Tab for Rate

Click Settings in Rate to display the Measurement tab in 
the right pane.

Feature Description

Integration time How long the system acquires and averages data to obtain each data 
point at each measured wavelength for single and multicell 
experiments or at each data interval for scan experiments.

Dwell time How long the sample remains in the light beam.

Use this setting to vary the number of data points collected per cell 
per cycle. Dwell time is always a multiple of integration time (see 
above). Dwell time can be very useful when performing multicell 
rate measurements. This is because the cell changer accessory will 
position a cell in the light beam for a specified period of time (dwell 
time), rather than moving back and forth between cells and 
increasing the time between measurements (when no sample is in 
the light beam).

For example, if the integration time is 0.1 second and dwell time is 
0.5 second, five data points will be recorded for each cell before the 
cell changer moves to the next cell. For fairly fast reactions, multiple 
samples can be measured, with over ten times as many data points 
acquired within a short time. This can improve the accuracy of rate 
calculations for faster multicell rate measurements.

Time unit Determines the time unit used in the stages table (see below).

Allow multiple stages Allows the use of the specified number of measurement stages, over 
which the frequency of data acquisition can be determined. For 
example, if a reaction has two components, the first component 
could be fast and require a high data density. The second component 
could be much slower and longer lived, therefore requiring a lower 
data density. Defining multiple stages enables the use of the proper 
data density over a given period of time.

For single and multiple wavelength experiments only.

Stages table Defines for each stage the start time, end time and interval (how 
frequently a measurement is made). For example, using an interval 
of 10 seconds would measure the sample every 10 seconds from the 
start time to the end time. In a multicell experiment the interval 
setting is the measurement interval for each sample.

For single and multiple wavelength experiments only.

Cycle time Time between each measurement cycle. For scan experiments only.
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Related Topics

Type Tab for Rate

Instrument Tab for Rate

Accessories Tab for Rate

Samples Tab for Rate

Rate Calculations Tab for Rate

Performing a Kinetics Measurement

Instrument Tab for Rate

Number of cycles Number of measurement cycles. For scan experiments only.

Duration Length of the experiment, calculated by multiplying the cycle time 
by the number of cycles (see above). For scan experiments only.

Click Settings in Rate to display the Instrument tab in 
the right pane.

Feature Description

Data mode Y-axis format for acquired data.

For Abs*Factor, set Factor to a value by which to multiply measured 
absorbance values. For scan experiments only.

Smooth Select the desired degree of smoothing. Smoothing reduces noise in 
the data but can also remove some spectral features such as small 
peaks, valleys and shoulders. For more information, see About 
Smoothing. For scan experiments only.

Derivative Select the desired derivative order for acquired data. For scan 
experiments only.

Start wavelength 
and End wavelength

Starting and ending values of the wavelength range for acquiring 
data. For scan experiments only.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve the 
signal-to-noise ratio; however, a larger spectral bandwidth decreases 
the ability to resolve closely spaced spectral features, especially in 
scanning measurements.

Feature Description
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Related Topics

Type Tab for Rate

Measurement Tab for Rate

Accessories Tab for Rate

Samples Tab for Rate

Rate Calculations Tab for Rate

Performing a Kinetics Measurement

Accessories Tab for Rate

The status of accessories can be monitored during measurements.

Related Topics

Accessories

Instrument Status Monitors

Type Tab for Rate

Measurement Tab for Rate

Integration time How long the system acquires and averages data at each data interval. 
Increasing the integration time improves the signal-to-noise ratio but 
reduces the scan speed. For scan experiments only.

Data interval Difference in wavelength between two consecutive data points. For 
scan experiments only.

Scan speed Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases. For scan 
experiments only.

Estimated time Estimated duration of data acquisition. Increases as integration time 
increases and as the data interval decreases. Varies inversely with scan 
speed. For scan experiments only.

Wavelength table Wavelengths to monitor during the reaction. For single and multiple 
wavelength experiments only.

Click Settings in Rate to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. See Accessories for details.

Feature Description
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Instrument Tab for Rate

Samples Tab for Rate

Rate Calculations Tab for Rate

Performing a Kinetics Measurement

Samples Tab for Rate

Related Topics

Type Tab for Rate

Measurement Tab for Rate

Instrument Tab for Rate

Accessories Tab for Rate

Rate Calculations Tab for Rate

Performing a Kinetics Measurement

Rate Calculations Tab for Rate

Click Settings in Rate to display the Samples tab in the 
right pane. To

Feature Description

Number of samples Number of samples in the experiment.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended.

Set up sample table 
columns

Specifies the columns of sample information to be entered during the 
experiment. To add a column, type the desired name in an empty cell 
and press the Tab key. To delete a column (except the Sample Title 
column), right-click it and choose Delete Column. To delete all the 
columns (except the Sample Title column), right-click the table and 
choose Delete All Columns.

Click Settings in Rate to display the Rate Calculations 
tab in the right pane (for single and multiple wavelength 
experiments only).
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Related Topics

Type Tab for Rate

Measurement Tab for Rate

Instrument Tab for Rate

Accessories Tab for Rate

Samples Tab for Rate

Performing a Kinetics Measurement

Sharing Custom Templates

To share a custom template, paste a copy of it into the desired folder, such as:

C:\Users\Public\Documents\Thermo\Insight\Custom Methods

C:\Documents and Settings\All Users\Documents\Thermo\Insight\Custom 
Methods

Feature Description

Calculate rate constants 
automatically at end of 
data acquisition

Calculates rate constants automatically at the end of the 
experiment.

Calculate Rate For each measurement stage, enter the starting and ending times 
of the rate vector, the rate scaling factor, and the order of the 
reaction. The factor is a constant that is multiplied by a calculated 
kinetics parameter to give physical significance to the 
measurement.

To enter different settings for individual wavelengths, select 
Specify settings for individual wavelengths (available only if 
Rate Type on the Type tab is set to Multiple wavelength). In the 
Wavelength column, select or type the desired wavelength for each 
row of settings. The available wavelengths are those entered on the 
Instrument tab.

To delete a row of information from the table, right-click the row 
and choose Delete Selected Row. To delete all the information 
from the table, right-click it and choose Clear Table.

Note  “Shared Documents” may appear in a path instead of “Documents”.
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Managing Data

My Data 

Use these tabs to select items to open or delete:

Use the links below the buttons to display archived workbooks. Click Active workbook 
library to view the directory where a workbook was last saved. To change the path to the 
default workbook, right-click My favorite workbook library and choose Edit Link.

Related Topics

Managing Data

Contents

• My Data

• Reports

Use My Data to access saved workbooks, templates and 
Performance Verification (PV) result reports. Drag the 
borders of the panes to change their size and shape.

Tab Description

Workbooks Select a folder in the tree to list its workbooks. Select a listed workbook to see 
its spectra. To zoom in on the displayed spectra, draw a box and click inside it 
or use the view finder. To view the full data range, double-click the spectral 
display.

Templates Select a group folder in the tree to list its templates.

PV Reports Select the listed result reports of interest. To select multiple reports, hold 
down Shift or Ctrl. (One window will display all the opened results.)

Click Open to open the selected workbook or 
template (and associated application) or the 
selected PV reports. Alternatively, double-click the 
item to open it. Additional measurements can be 
appended to an opened workbook. Opened PV 
results can be printed and copied from the report 
window.

Click Delete to delete the selected workbook or 
template.
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Reports

A report contains a table of sample data and other specified information.

These action buttons appear in Reports:

The export formats include:

These tabs appear in the Reports right pane:

To configure or view the report after opening a 
workbook or measuring a sample, click Reports.

Button Description

Shows the current report before printing, with the header and footer specified 
on the Report Master Page tab in Options.

Prints the current report on the specified printer.

Saves the current report in the specified format (see the table below).

Format Description

Report, Excel XML 
Spreadsheet (*.xml)

Can be opened in Excel®. Only the columns displayed in the 
report are saved. Configure the report to display the desired 
information before exporting.

Report, Tab Separated 
Values (*.tsv)

Can be opened in Notepad or Excel. Only the columns 
displayed in the report are saved. Configure the report to display 
the desired information before exporting.

Wavelength Curve, Excel 
XML Spreadsheet (*.xml)

Saves the absorbance values along with the corresponding 
wavelengths for a highlighted sample. If multiple samples are 
highlighted, the corresponding absorbance values for each 
wavelength are saved onto separate worksheets within one Excel 
file.

Wavelength Curve, Tab 
Separated Values (*.tsv)

Saves absorbance values along with the corresponding 
wavelengths for highlighted samples in a format that can be 
opened in Notepad or Excel. Multiple samples are saved 
sequentially in one column.
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The Print tab includes:

Tab Description

Report Displays the sample data archived in the opened workbook. To sort the 
information in the table, click the desired column heading.

To view particular data, select it in the table. For most applications this 
displays a sample spectrum. For fixed Rate data, this displays spectral data 
points for the indicated wavelength and the line resulting from the rate 
calculations, if specified. For scan Rate data, all of the sample’s spectra 
appear.

See Data Display for information on using features made available by 
right-clicking the displayed data.

To view, print or copy data acquisition and other information about data, 
right-click it in the list and choose Properties.

To change a sample ID, click its cell and type a new ID.

Configuration Specifies the report columns to include and their order. The available 
columns depend on the current application and workbook settings.

To include a column, select it in the Available Columns list and click 
.

To remove an included column, select it in the Reported Columns list and 
click .

To move an included column up, select it and click .

To move an included column down, select it and click .

To restore the most recent configuration, click .

Only the information associated with selected columns will be included in 
exported files. See the information on exporting reports above.

Print Specifies the items to include in printed reports (see the table below).

Feature Description

Header/Footer Includes a header and footer in the printout.

Header Items Title and subtitle to appear in the header. Use the Font buttons to specify 
their fonts.

Table Includes a table of sample information. Use the Font button to specify the 
font for the information.
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If the computer is not mapped to recognize that .xml files should be opened with Excel, open 
the exported file from within Excel.

Math and Analysis Operations

Smoothing Scan Data

Use Smooth in the Math menu to reduce noise in wavelength scan data. The smoothing 
algorithm uses the Savitzky-Golay method. For more information, see About Smoothing.

Settings info Includes a table of workbook settings. Use the Font button to specify the 
font for the information.

Graphs Includes spectra and other data plots in printed reports. See “Print report 
graphs” below for more information.

Page Setup Specifies the paper size, orientation and other printing attributes.

Print report 
graphs

Select Overlay to print data plots overlaid. Select Separate to print data 
plots separately, with the specified number of plots on a page. These are 
available only if Graphs is selected (see above).

Note  We recommend first defining a master page on the Report Master Page tab in 
Options.

Feature Description

Contents

• Smoothing Scan Data

• Converting Scan Data to a Derivative

• Converting Scan Data to Other Units

• Adding Two Scan Spectra

• Normalizing Scan Data

• Subtracting a Scan Spectrum

• Ratioing Two Scan Spectra

• Averaging Scan Spectra

• Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

• Finding Peaks in Scan Data

• Finding Value Level Crossings in Scan Data
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To smooth data

1. Choose Math (menu) > Smooth.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to smooth and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the polynomial order.

4. Specify the degree of smoothing (number of points in the smoothing formula) by 
dragging the slider:

5. To perform a math operation on the smoothed result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

6. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

7. Click Close to close each displayed math window.

Note  To use the result in another Smooth operation, use Workbook or Temporary 
to add it to the list (see step 6), click Add to make it an operand, and continue with 
step 2.
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Related Topics

About Smoothing

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Normalizing Scan Data

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

About Smoothing

The smoothing feature of INSIGHT software uses a Savitzky-Golay algorithm modified to 
reduce high frequency breakthrough; that is, to reduce noise in the spectrum. The algorithm 
is based on performing a least-squares linear regression fit of a polynomial of order k over at 
least k+1 data points around each point in the spectrum.

Converting Scan Data to a Derivative

Use Derivative in the Math menu to convert scan data to the first, second, third or fourth 
derivative.

To convert scan data to a derivative

1. Choose Math (menu) > Derivative.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.
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2. Select any other listed spectra to convert and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the derivative order.

4. Select the polynomial order of the derivative formula.

5. Specify the number of points in the derivative formula by dragging the slider:

6. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

7. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

8. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to Other Units

Adding Two Scan Spectra

Normalizing Scan Data

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Note  To use the result in another Derivative operation, use Workbook or 
Temporary to add it to the list (see step 7), click Add to make it an operand, and 
continue with step 2.
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Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Converting Scan Data to Other Units

Use Convert Spectra in the Math menu to convert scan data to another Y-axis format.

To convert scan data to another format

1. Choose Math (menu) > Convert Spectra.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to convert and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the desired Y-axis format.

4. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

Note  To use the result in another Convert Spectra operation, use Workbook or 
Temporary to add it to the list (see step 5), click Add to make it an operand, and 
continue with step 2.
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The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

6. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Adding Two Scan Spectra

Normalizing Scan Data

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Adding Two Scan Spectra

Use Add in the Math menu to add two scan spectra.

To add two scan spectra

1. Choose Math (menu) > Add.

The selected spectrum appears in the Operand 1 pane. To use a different listed spectrum, 
select it and click Add in the Operand 1 box.

The list includes only current workbook spectra. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select the second spectrum to add and click Add in the Operand 2 box.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.
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Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500. 

4. To perform a math operation on the addition result, click Operate on Result and choose 
an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

6. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Normalizing Scan Data

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Note  To use the result in another Add operation, use Workbook or Temporary to 
add it to the list (see step 5), click Add in the Operand 1 box, and continue with step 
2.
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Normalizing Scan Data

Use Normalize in the Math menu to adjust the Y scale of a scan spectrum so that a selected 
data point has the desired Y value.

To normalize scan data

1. Choose Math (menu) > Normalize.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to normalize and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the desired Y value for the data point specified in the next step.

4. Select the wavelength of the data point.

5. To perform a math operation on the normalized result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

6. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

Note  To use the result in another Normalize operation, use Workbook or 
Temporary to add it to the list (see step 6), click Add to make it an operand, and 
continue with step 2.
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7. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Subtracting a Scan Spectrum

Use Subtract in the Math menu to subtract a scan spectrum from another.

To subtract a scan spectrum

1. Choose Math (menu) > Subtract.

The selected spectrum appears in the Operand 1 pane. To use a different listed spectrum, 
select it and click Add in the Operand 1 box.

The list includes only current workbook spectra. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select the spectrum to subtract and click Add in the Operand 2 box.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.
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Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500.

4. To perform a math operation on the subtraction result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

6. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Note  To use the result in another Subtract operation, use Workbook or Temporary 
to add it to the list (see step 5), click Add in the Operand 1 box, and continue with 
step 2.
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Ratioing Two Scan Spectra

Use Ratio in the Math menu to divide a scan spectrum by another.

To ratio two scan spectra

1. Choose Math (menu) > Ratio.

The selected spectrum appears in the Operand 1 pane. To use a different listed spectrum, 
select it and click Add in the Operand 1 box.

The list includes only current workbook spectra. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select the spectrum by which to divide the first and click Add in the Operand 2 box.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.

Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500.

4. To perform a math operation on the division result, click Operate on Result and choose 
an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

Note  To use the result in another Ratio operation, use Workbook or Temporary to 
add it to the list (see step 5), click Add in the Operand 1 box, and continue with step 
2.
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6. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Subtracting a Scan Spectrum

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Averaging Scan Spectra

Use Average in the Math menu to find the average of two or more scan spectra.

To use Average

1. Choose Math (menu) > Average.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to average and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. To perform a math operation on the result, click Operate on Result and choose an 
operation. Otherwise, go to the next step.

Note  A spectrum appears in the Result pane only if two or more spectra are in the 
Operands pane.
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Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

4. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

5. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Normalizing Scan Data

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Use Factor in the Math menu to add a constant to the Y value of scan data, subtract a 
constant, multiply by a constant or divide by a constant.

To use Factor

1. Choose Math (menu) > Factor.

Note  To use the result in another Average operation, use Workbook or Temporary 
to add it to the list (see step 4), click Add to make it an operand, and continue with 
step 2.
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The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to operate on and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the arithmetic operation to perform on the Y value of every data point.

4. Specify the factor: type a value, click the up and down arrow buttons, or drag the slider.

5. To perform a math operation on the result, click Operate on Result and choose an 
operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

6. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

Note  To use the result in another Factor operation, use Workbook or Temporary to 
add it to the list (see step 6), click Add to make it an operand, and continue with step 
2.
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7. Click Close to close each displayed math window.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Normalizing Scan Data

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Finding Peaks in Scan Data

Use Peak Pick in the Analyze menu to find peaks, valleys, zero crossings, or maximum and 
minimum values in a spectrum or region.

To locate peaks

1. Choose Analyze (menu) > Peak Pick.

2. Set the parameters and adjust the data display as desired.

Note  Peaks can be found automatically after data acquisition. See Measurement Tab for 
Scan.

Parameter Description

Find Specifies whether to find peaks, valleys, both peaks and 
valleys, or maximum and minimum Y values.

Max number of peaks (or 
valleys, or peaks and valleys)

Maximum number of items to find.

Sort peaks (or valleys, or 
peaks and valleys) by

Order for labeling and listing found items in the results 
table.

Sensitivity How readily small peaks or valleys are found. To 
optimize the sensitivity, select Auto. To set it manually, 
deselect Auto and drag the slider.
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To adjust the data display, use the view finder. To zoom in or move the spectrum, use the 
selection tool:

The results appear in the data display pane and the table below it:

Wavelength Range Wavelength range in which to find items. To use the 
entire range, select Full. To limit the range, deselect Full 
and type the desired limits or use the region-threshold 
tool:

Use threshold Specifies whether to find only those peaks whose Y values 
are greater than or equal to a specified value, the 
threshold. (For % transmittance, the software finds 
valleys less than or equal to the threshold.) To optimize 
the threshold value, select Auto. To set it manually, 
deselect Auto and set Threshold by typing a value or 
dragging the horizontal line in the data display.

Smooth spectrum Specifies whether or not to smooth the data before 
finding peaks or valleys. This tends to reduce the number 
of small peaks, valleys and shoulders. (For more 
information, see About Smoothing.) The (blue) 
smoothed spectrum is overlaid on the original. To 
optimize the degree of smoothing, select Auto. To adjust 
it manually, deselect Auto and drag the slider.

Parameter Description
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3. Click OK.

The found peaks have labels, and the peak results are listed at the right.

The settings are saved in the workbook and will be used for measuring samples with 
Result on the Measurement tab set to Peak Pick.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Value Level Crossings in Scan Data

Finding Value Level Crossings in Scan Data

Use Value Level in the Analyze menu to find the wavelengths where a spectrum crosses a 
specified ordinate value.

Results table Peak label
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To locate value level crossings

1. Choose Analyze (menu) > Value Level.

2. Set the parameters and adjust the data display as desired.

To adjust the data display, use the view finder. To zoom in or move the spectrum, use the 
selection tool:

The results appear in the data display pane and the table below it:

Note  Crossings can be found automatically after data acquisition. See Measurement Tab 
for Scan.

Parameter Description

Level for crossing Specifies the ordinate (Y) value. One can also drag the horizontal 
line in the data display.

Sort crossings by Order for listing crossings in the results table.

Wavelength Range Wavelength range in which to find crossings. To use the entire 
range, select Full. To limit the range, deselect Full and type the 
desired limits or use the region-threshold tool:

Sensitivity How readily small-amplitude crossings are detected. To optimize 
the sensitivity, select Auto. To set it manually, deselect Auto and 
drag the slider. A high sensitivity finds locations where the 
spectrum crosses the horizontal line only a short distance.
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3. Click OK.

The found crossings have labels, and the crossing results are listed at the right.

The settings are saved in the workbook and will be used for measuring samples with 
Result on the Measurement tab set to Value Level.

Related Topics

Smoothing Scan Data

Converting Scan Data to a Derivative

Converting Scan Data to Other Units

Adding Two Scan Spectra

Subtracting a Scan Spectrum

Ratioing Two Scan Spectra

Averaging Scan Spectra

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Finding Peaks in Scan Data

Results table Crossing label
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Options

Applications Tab
Report Master Page Tab
Preferences Tab
Data Store Tab
Formulas and Units Tab

Applications Tab

To add a new group

Enter the desired group name in the Groups box and click Add.

To customize the current group

Drag the desired applications from the Applications list to the buttons at the right. To 
remove an application from the group, drag it from its button to the Applications list.

To delete the current group

Click Delete Group and then click Yes when prompted.

To reset the application buttons for the current group

Click Clear App Buttons and then click Yes when prompted.

To make custom templates available for groups other than Classic

Drag the List of Templates application to one of the top nine menu buttons.

Report Master Page Tab

These are available in Options:

Click Options to display the Applications tab in the 
right pane. Use it to add new user groups and give them 
access to particular applications. The Group drop-down 
list box shows the name of the current group.

Click Options to display the Report Master Page tab in 
the right pane. Use it to define the appearance of all 
printed reports.
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Preferences Tab

Data Store Tab

Feature Description

Company name Enter a company name and press Enter. Select an orientation for the 
name, and use Font to specify the font.

Date Date of the report creation. Use Font to specify the font for Date and 
Time.

Time Time of the report creation. Use Font to specify the font for Time and 
Date.

Logo Select an orientation for the logo, and use Browse to locate and select a 
logo image file.

Footer text Text at the bottom of the report. Use Font to specify the font for the 
footer.

Page number Format for page numbers. Select None to not include page numbers.

Click Options to display the Preferences tab in the right 
pane.

Feature Description

Data Value Digits Specify the number of digits to the right of the decimal point to use 
for X and Y values for spectral data.

Triggering Starting data acquisition normally requires a response to a prompt 
(displayed by Measure or another action button). To start acquisition 
automatically a specified number of seconds after the prompt appears, 
select Enable auto input trigger and set the number of seconds.

Use Output trigger to specify whether and when to produce a signal 
that triggers an installed accessory to begin an operation.

Support DYMO® 
label printer

Select this to use a standalone device to print reports on various sized 
labels.

Directories The paths used for saving template files, Performance Verification 
reports, and workbooks. Type a path for each or click the button to 
specify a path.

Click Options to display the Data Store tab in the right 
pane. Use it to specify how to save workbooks, export 
data and e-mail results.
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Formulas and Units Tab

In the appropriate table, select in the Show column the items to be available.

To add an item, enter it (or the appropriate information) in the row that starts with a plus (+) 
sign.

To delete an item, right-click it and choose Delete Row. Items with a lock icon cannot be 
edited or deleted.

To return to the default selections, click Reset.

Related Topics

Quanto

Quantifying Sample Data

Performing a Quantitative Analysis

Feature Description

Workbook Save Options To be prompted to save data before acquiring it, select Data 
saved on each measure. Save Workbook and Save As Workbook 
will not be available in the File menu.

To save acquired data only by using Save Workbook or Save As 
Workbook, select Data saved only by Save Workbook in File 
menu. (A prompt to save appears when INSIGHT software is 
closed if the current workbook has not been saved.)

Convert Data Select Auto export data to automatically save acquired data 
using the selected format in the specified location. To change the 
location, type a new path or use Browse.

E-mail Select Auto e-mail result (workbook) to automatically e-mail 
the current workbook. Enter the desired recipient address, 
subject and message.

Click Options to display the Formulas and Units tab in 
the right pane. Use it to specify the default formulas, 
units and advanced equations for setting up quantitative 
analyses.
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System Settings

Alignment Tab
Calibrations Tab
Lamp Tab
System Tab
Diagnostics tab

Alignment Tab

Use the Alignment tab in System Settings to view sample and reference detector intensities 
while aligning an accessory.

To perform an alignment

1. To measure intensities using a green light (510 nm), select Green. To use no filter, select 
White.

The correct setting depends on the installed accessory. See Accessories.

2. Set Bandwidth as desired.

The available settings depend on the instrument.

3. Click Start.

Every half second the sample and reference detector intensities are plotted and displayed 
by the Sample beam and Reference readouts.

These are available in System Settings:

Note  The Diagnostics tab is for our use only.
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To overlay the plots instead of stacking them, deselect Stack.

The Time readout shows the elapsed time. Intensities can be measured and plotted for up 
to 15 minutes without restarting the process.

If the plot of sample detector intensity is not at the desired position for viewing, adjust 
the detector gain by dragging the Gain slider up or down.

To adjust the display, use the view finder. To zoom in, draw a box and click inside it. To 
return to full display, double-click the pane.

4. Align the accessory to achieve the desired sample detector intensity (see Accessories).

5. When finished, click Stop.

Related Topics

Calibrations Tab

Lamp Tab

System Tab

Calibrations Tab

Use the Calibrations tab in System Settings to calibrate the instrument wavelength or 
accessories. To calibrate using a particular lamp, click its Calibrate button and follow the 
instructions that appear. See Mercury Lamp for instructions for using a mercury lamp safely.

Note  If the instrument has variable slit wheels, the start of intensity measurement is 
delayed while they move to their 2 nm position.
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Related Topics

Alignment Tab

Lamp Tab

System Tab

Lamp Tab

The Lamp tab in System Settings displays status information about the xenon lamp.

Related Topics

Alignment Tab

Calibrations Tab

System Tab

System Tab

The System tab in System Settings includes:

Related Topics

Alignment Tab

Calibrations Tab

Lamp Tab

Keyboard Shortcuts
These are available in INSIGHT software:

Feature Description

Instrument Control Switches instrument control between the Local Control option and 
INSIGHT software running on an external computer. Select the 
desired setting and respond appropriately to the message that appears.

Firmware Update Click Load Update to install the selected instrument firmware. 
Follow the instructions that appear.

Instrument Boot 
Record

Click Display to view the instrument’s power-up boot record, which 
can be saved or copied.
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Keyboard Shortcut Description

Alt+F4 Exits INSIGHT software.

Ctrl+F (from Home) Displays Fixed.

Ctrl+Q (from Home) Displays Quant.

Ctrl+R (from Home) Displays Rate.

F1 Displays Help.

F2 Displays Home.

F4 Displays the Measure screen for the current application.

F5 Acquires zero or baseline data.

F6 Chooses the Measure button.

F7 Prints the Measure screen.

F8 Prints the report.

F9 Displays My Data.

F10 Creates a new workbook.

F11 (from Home) Displays Performance Verification.

F12 Chooses the Stop button.
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Evolution 200 Series Spectrophotometers

The Evolution™ 200 series UV-visible spectrophotometers include three models:

• Evolution 201

• Evolution 220

• Evolution 260 Bio (includes life science applications).

Safety Considerations
Each person using the spectrophotometer should read the general safety information in the 
Site and Safety Information guide (see the documentation CD) and the instrument-specific 
safety information provided here.

Languages

Contents

• Safety Considerations

• Operating Precautions

• Spectrophotometer Basics

• Accessories

• Using the Spectrophotometer

• Maintenance

• Ordering Parts

Contents

• Safety Label Locations

• Lifting or Moving the Instrument

WARNING  Do not operate this system without following the safety precautions 
described in this manual and the documentation that came with your system.

WARNING  n'utilisez le système qu'en suivant les consignes de sécurité qui figurent dans 
ce manuel et dans la documentation accompagnant le système.
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Safety Label Locations

This section shows the locations of safety labels on the spectrophotometer. Contact us if there 
are questions or problems with the safety labels. See Contacting Us.

Back view

WARNING  Betreiben Sie dieses System nur unter Beachtung der Sicherheitshinweise in 
diesem Handbuch und in der im Lieferumfang des Systems enthaltenen Dokumentation.

WARNING  Non utilizzare questo sistema senza seguire le norme di sicurezza 
descritte in questo manuale e nella documentazione di accompagnamento del 
sistema.

WARNING  No opere este sistema sin seguir las precauciones de seguridad descritas 
en este manual y en la documentación proporcionada con el sistema.

Compliance label
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Right side view

Left side view

Related Topics

Mercury Lamp

Removing and Installing the Detector Module

UV radiation warning label (under mercury lamp access cover)

UV radiation warning label (under detector access cover)
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Lifting or Moving the Instrument

To avoid risk of injury, use proper techniques when lifting or moving the instrument or other 
system components.

Operating Precautions
The spectrophotometer contains precise optical components. Handle it carefully and follow 
these precautions:

• Do not allow moisture to leak into the instrument interior.

• Wipe off spilled chemicals immediately.

• Do not drop the instrument.

• Protect the instrument from mechanical shock.

• Protect the instrument from dust.

Spectrophotometer Basics

Spectrophotometer Components

The following illustration identifies major components visible on the outside of a typical 
spectrophotometer. (Some components may not be present on all instruments.)

Hand hold

Hand hold

Contents

• Spectrophotometer Components

• Connectors

• Removable Panels

• Corrosion Protection
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The z-height (distance from the bottom of the cell to the center of the light beam) for the 

spectrophotometer is 8.5 mm.

Related Topics

Opening and Closing the Sample and Reference Compartment Doors

Local Control or Computer Control

INSIGHT Software

Keypad

Touchscreen

Opening and Closing the Sample and Reference Compartment Doors

To open the sample compartment, press the button on its door. To close the compartment, 
slide the door forward until it latches.

To access the reference compartment, lift or lower the door.

Related Topics

Sample Compartment Front Panel

Tubing Access Panel

Optional touchscreen
Sample compartment

Keypad

Reference compartment
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Local Control or Computer Control

The spectrophotometer can be run from the optional touchscreen (Local Control) or from a 
Windows®-compatible computer connected to the instrument (Computer Control). Local 
Control instruments include an embedded computer preloaded with software. Computer 
Control instruments must be connected to an external computer with the proper software 
installed.

Related Topics

Local Control Instruments

Computer Control Instruments

INSIGHT Software

All instruments include our INSIGHT™ software for data collection and analysis. See 
INSIGHT Software.

Keypad

All instruments include the keypad shown below. For a list of keypad functions, see Using the 
Spectrophotometer.

Related Topics

Keypad Operation

Touchscreen

The touchscreen is included only on Local Control versions of the spectrophotometer.

Related Topics

Touchscreen keyboard

Cleaning the Touchscreen

Connectors

This section shows the locations of the connectors inside and outside the spectrophotometer.



 3 Evolution 200 Series Spectrophotometers
Spectrophotometer Basics

Thermo Scientific Evolution 200 Series User Guide 109

Outside Cover

This illustration shows the connectors on the instrument outside cover.

Back view

Contents

• Outside Cover

• Inside the Sample Compartment

Purge

USB

USB

Computer
Power

Power switch

Hg lamp
Trigger

Label Function

Computer Dedicated USB port for connecting an external computer. See 
Computer Control Instruments.

Hg lamp Connects to optional Mercury Lamp.

Power Connects to main power cord.

Power switch System power On/Off switch.

Purge Connects to optional purge source. See Purging the Sample 
Compartment.
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The system supports these USB devices:

• External USB mouse

• External USB keyboard

• Portable USB memory

• Windows-compatible USB printer

To ensure proper shielding of USB devices, install a Ferrite ring (samples provided) on the end 
of any USB cable connected to the instrument. Loop the cable once and clamp the ring over 
the loop as shown below.

Related Topics

Triggering

Trigger Connects to optional accessories that accommodate external trigger 
input or output. See Attaching Cables and Probes.

INSIGHT can be used to send a 3.3V TTL output signal that triggers 
an installed accessory to begin an operation. The signal can be sent at the 
start or end of a measurement. See Options > Preferences > Triggering.

INSIGHT accepts a contact closure input trigger (equivalent to pressing 
Run on the instrument keypad).

USB General purpose USB connectors (Local Control systems only). See 
below for proper shielding of USB cables.

Label Function

WARNING  Avoid shock hazard. Power off the spectrophotometer and disconnect the 
power cord from the wall outlet or power strip before disconnecting the power cord from 
the spectrophotometer.

Note  The spectrophotometer does not support high power USB devices.

Ferrite ring
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Purging the Sample Compartment

Mercury Lamp

Attaching Cables and Probes

Computer Control Instruments

Inside the Sample Compartment

This illustration identifies the connectors inside the sample compartment.

Related Topics

Installing a Smart Accessory

Removable Panels

This section covers panels that can be removed to allow access to features on the instrument.

Smart Accessory 
connector

Contents

• Sample Compartment Front Panel

• Tubing Access Panel

• Mercury Lamp Access Cover

• Detector Access Cover

• Detector Access Panel
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Sample Compartment Front Panel

To remove the front panel, open the sample compartment door and then pull the panel 
forward and up to free it.

To replace the panel, align the tab on the bottom edge with the slot in the instrument cover 
and press the panel in place.

Related Topics

Installing a Manual Accessory

Installing a Liquid Thermostatted Accessory

Installing a Smart Accessory

Tubing Access Panel

To access external ports for routing fluid from a recirculator to the instrument, remove the 
panel below the sample compartment.

Removable panel

Tab
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Internal fluid ports for routing fluid from the instrument to an installed accessory are located 
inside the sample compartment.

The connectors fit 1/4-inch internal diameter tubing. An adapter may be required to connect 
the tubing to the accessory or recirculator. Purchase adapters separately.

Cords and cables for installed accessories can also be routed behind this panel. Push the cord 
through the foam and the opening below it. The panel itself can be removed temporarily to 
accommodate a large connector. To remove the panel, loosen the screw.

Related Topics

Installing a Liquid Thermostatted Accessory

Mercury Lamp Access Cover

Languages

External fluid ports

Internal fluid ports Screw
Foam

WARNING  Avoid UV radiation hazard in the mercury lamp compartment. Protect eyes 
and skin from exposure.
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Lift the cover to install the optional Mercury Lamp.

Right side view

Related Topics

Mercury Lamp

Detector Access Cover

Some accessories require removing the instrument detector module. The module is beneath 
the detector access cover shown below. Avoid UV radiation hazard in the detector 
compartment. Protect eyes and skin from exposure.

AVERTISSEMENT  Évitez tout risque de rayonnement à l’intérieur du compartiment de la 
lampe à vapeur de mercure. Protéger vos yeux et votre peau de toute exposition au 
rayonnement.

WARNUNG  Gefährliche UV-Strahlung im Gehäuse der Quecksilberlampe ist zu 
vermeiden. Augen und Haut müssen vor der Strahlung geschützt werden. 

AVVERTENZA  Evitare il rischio di radiazione UV nel vano della lampada al mercurio. 
Proteggere occhi e pelle dall’esposizione.

ADVERTENCIA  Evite el riesgo de radiación ultravioleta en el compartimento de la 
lámpara de mercurio. Proteja sus ojos y la piel de la exposición.

Mercury lamp access cover
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Languages

Left side view

Related Topics

Removing and Installing the Detector Module

Detector Access Panel

CAUTION  Safety glasses with side shields or goggles with solid side pieces are the only 
equipment that provides adequate eye protection against direct and reflected UV light.

CAUTION  Seules les lunettes de sécurité avec écrans latéraux ou les lunettes 
protectrices avec parties latérales solides protègent les yeux de façon adéquate 
contre la lumière UV directe et réfléchie.

CAUTION  Sicherheitsbrillen mit seitlichem Schutz bzw. Schutzbrillen mit festen 
Seitenteilen bieten als einzige Ausrüstungsgegenstände adäquaten Schutz der 
Augen gegen direkte und reflektierte UV-Strahlung.

CAUTION  Gli occhiali protettivi con schermi laterali o con schermi laterali 
monolente sono l'unica attrezzatura che fornisce un'adeguata protezione degli 
occhi dalla luce UV diretta e riflessa.

CAUTION  Las gafas protectoras con protección lateral de seguridad o con piezas 
laterales sólidas son el único equipo que proporciona la protección para los ojos 
adecuada contra la luz ultravioleta directa y reflejada.

Detector access cover
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Detector Access Panel

To remove the panel between the detector and sample compartment, remove the sample 
compartment window and then loosen the thumbscrew.

To replace the panel, hook the tabs on the bottom edge over the slots in the sample 
compartment side wall and tighten the thumbscrew.

Related Topics

Removing and Installing the Detector Module

Detector Access Cover

Installing Sample Compartment Windows

Corrosion Protection

The spectrophotometer contains precise optical components that may be damaged by a 
corrosive environment. Before using the instrument to analyze volatile, corrosive or caustic 
samples, install the optional sample compartment windows and, if necessary, purge the sample 
compartment.

Related Topics

Installing Sample Compartment Windows

Purging the Sample Compartment

Installing Sample Compartment Windows

The optional windows attach to the sample compartment side walls using magnets.

Removable panel

Thumbscrew
Window (optional)

Thumbscrew
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Related Topics

Purging the Sample Compartment

Purging the Sample Compartment

Purging the sample compartment removes moisture from the sampling area for subambient 
temperature-controlled measurements. When purging the instrument, install sample 
compartment windows in addition to purge.

Related Topics

Installing Sample Compartment Windows

Selecting a Purge Gas

Installing Purge

Selecting a Purge Gas

Use dry air or dry nitrogen to reduce or eliminate condensation. The purge gas must be free of 
moisture, oil and other reactive materials. To remove particulate matter and oil, install a 
10-micrometer filter.

Languages

NOTICE    The warranty does not cover damage to internal optics or electronics caused by 
failure to use sample compartment windows.

Sample compartment window (2)

WARNING  Never use a flammable gas to purge the instrument.
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Related Topics

Installing Sample Compartment Windows

Installing Purge

Installing Purge

Use 1/4-inch internal diameter tubing to connect a purge gas source to the purge fitting on 
the back of the spectrophotometer.

Related Topics

Installing Sample Compartment Windows

Selecting a Purge Gas

Accessories

Standard Cell Holders

The instrument includes one sample and one reference cell holder. For a list of optional cell 
holders and other accessories, see Accessories.

Related Topics

10 mm Rectangular Sample Cell Holder

AVERTISSEMENT  N'utilisez jamais de gaz inflammable pour purger l'instrument.

WARNUNG  Verwenden Sie niemals entflammbares Gas zum Spülen des Instru¬ments.

AVVERTENZA  Non utilizzare mai un gas infiammabile per spurgare lo strumento.

ADVERTENCIA  Nunca use un gas inflamable para purgar el instrumento.

Contents

• Standard Cell Holders

• Installing a Manual Accessory

• Installing a Smart Accessory

• Installing a Liquid Thermostatted Accessory

• Installing a Reference Cell Holder
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Rectangular Reference Cell Holder

10 mm Rectangular Sample Cell Holder

This single-cell holder is mounted on the standard baseplate and accommodates standard 
10 mm pathlength cells. See Installing a Manual Accessory.

Use the cell lifter to raise the cell for easy removal. This cell holder allows fine adjustment of 
the vertical and horizontal position of the cell. This feature is useful for aligning reduced 
volume and microcuvettes with the light beam. See z-height.

Related Topics

Rectangular Reference Cell Holder

Sample Position Cell Holders

Reference Cell Holders

Spectrophotometer Z-height

Rectangular Reference Cell Holder

For measurements with a reference sample, install a reference cell holder in the reference 
position. See Installing a Reference Cell Holder.

The standard reference holder accommodates rectangular reference cells with these 
pathlengths: 10 mm, 20 mm, 40 mm, 50 mm and 100 mm.

Cell lifter and vertical alignment
Horizontal alignment
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Related Topics

10 mm Rectangular Sample Cell Holder

Sample Position Cell Holders

Reference Cell Holders

Installing a Manual Accessory

Manual sampling accessories are mounted on a common baseplate. The kinematic mount 
ensures correct alignment of the accessory within the instrument.

It is not necessary to power off the instrument while installing or removing a manual 
accessory.

Sample compartment top view

To install a manual accessory

1. Open the sample compartment door. See Opening and Closing the Sample and 
Reference Compartment Doors.

Alignment pins

Toggle

A B
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2. Remove any accessory from the compartment (see the instructions below).

3. Position the accessory so the two alignment holes on its baseplate fit over pins A and B in 
the sample compartment.

4. Gently push down on the front edge of the baseplate until it snaps in place under the 
toggle.

5. Close the sample compartment door. See Opening and Closing the Sample and Reference 
Compartment Doors.

For operating instructions and installation details, see the accessory name under Accessories.

To remove a manual accessory

1. Use the handle or finger hole on the accessory baseplate to release the plate from the 
toggle.

2. Lift the plate off the alignment pins and remove the accessory from the sample 
compartment.

Related Topics

Installing a Liquid Thermostatted Accessory

Installing a Smart Accessory

Installing a Reference Cell Holder

Installing a Smart Accessory

Smart Accessories include cell changers and sample holders that feature auto recognition, 
smart alignment and serial number reporting. Smart Accessories ensure software methods are 
properly configured.

These accessories install in the sample compartment. A connector under the accessory 
baseplate provides data communication and power.

It is not necessary to power off the instrument while installing or removing a Smart Accessory.
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Sample compartment top view

To install a Smart Accessory

1. Open the sample compartment door. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Remove any cell holder or accessory. See To remove a Smart Accessory.

4. Insert the accessory.

a. Grasp the accessory by the handles and lower it into the sample compartment 
aligning the connector under the baseplate with the connector in the sample 
compartment floor.

Use the alignment pins on either side of the connector as guides.

Alignment pins

Toggle

A B

Smart Accessory connector

Alignment pins
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b. Line up the two holes at the back of the accessory with pins A and B in the sample 
compartment.

c. Press down on the front of the accessory to secure the connection.

The software displays a prompt to initialize the accessory.

Languages

Alignment pins

Smart Accessory connector

Smart Accessory

Connector (under baseplate)

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory 
during initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, à 
l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano dall’accessorio 
durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del alcance 
del accesorio durante la inicialización.
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5. Replace the sample compartment front panel. See Sample Compartment Front Panel.

6. Close the sample compartment door. See Opening and Closing the Sample and Reference 
Compartment Doors.

7. Click OK to initialize the accessory.

Initialization reads information about the accessory and, for cell changers, moves it to 
position 1.

For operating instructions and installation details, see the accessory name under Accessories.

To remove a Smart Accessory

1. Open the sample compartment door. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Grasp the handles and pull the accessory up and out of the sample compartment.

The software confirms the accessory has been removed.

4. Replace the sample compartment front panel. See Sample Compartment Front Panel.

5. Close the sample compartment door. See Opening and Closing the Sample and Reference 
Compartment Doors.

Related Topics

Installing a Liquid Thermostatted Accessory

Installing a Manual Accessory

Installing a Reference Cell Holder

Installing a Liquid Thermostatted Accessory

A liquid thermostatted accessory has ports and internal chambers for circulating fluids 
through the unit for temperature-controlled measurements. Other accessories circulate fluids 
to cool heated components.

The Recirculator Tubing Kit provides parts for connecting an accessory to a fluid recirculator.

To install a thermostatted accessory

1. Install the accessory.

See Installing a Manual Accessory or Installing a Smart Accessory.

2. Remove the tubing access panel. See Tubing Access Panel.
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3. Use 1/4-inch internal diameter tubing to connect the water supply or recirculator to the   
external fluid ports on the instrument.

If the connectors on the recirculator are a different size, use a tubing adapter.

4. Use additional tubing and adapters (not included), if necessary, to connect the fluid ports 
inside the sample compartment to the ports on the accessory.

For a cell changer, set the changer to position 1 before connecting the tubing to the ports 
on the accessory. Use just enough tubing to allow the cell changer to move through all 
possible positions. This requires approximately 10 inches (25 cm) of tubing for each port.

Related Topics

Installing a Smart Accessory

Installing a Manual Accessory

Installing a Reference Cell Holder

Note  Ensure the tubing does not obstruct the light beam or prevent the sample 
compartment door from closing. If necessary, secure the tubing using the supplied 
clips.

External fluid ports

Internal fluid ports
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Installing a Reference Cell Holder

To install a reference cell holder

1. Open the reference compartment cover. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Grasp the cell holder by the handle and lower it into the reference compartment.

3. Insert the pin in the alignment hole and press the holder in place.

4. Close the reference compartment cover.

For operating instructions, see Reference Cell Holders.

Related Topics

Installing a Smart Accessory

Installing a Manual Accessory

Installing a Liquid Thermostatted Accessory

Using the Spectrophotometer
This section explains how to set up a Computer Control or Local Control spectrophotometer 
and perform basic operations using the keypad.

Computer Control Instruments

Computer Control instruments must be connected to an external computer with the proper 
software installed.

Handle

Contents

• Computer Control Instruments

• Local Control Instruments
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All instrument features can be run from the computer using our INSIGHT software. Basic 
operations such as powering the spectrophotometer on and off, measuring a sample or 
baseline and running predefined macros can also be performed from the instrument keypad 
(see Keypad Operation).

Related Topics

Setting up a Computer Control Instrument

Turning off a Computer Control Instrument

Local Control Instruments

Setting up a Computer Control Instrument

To set up a Computer Control instrument

1. Connect the supplied USB cable to the Computer port on the back of the 
spectrophotometer.

2. Connect the other end of the cable to the USB port on the back of the computer.

3. Turn on the spectrophotometer main power switch (on the back panel).

4. If the main power switch is already on, press the Power button on the keypad.

Wait for the system to initialize. This may take several minutes. The power indicator on 
the keypad stops blinking when initialization is complete.

5. Turn on the remote computer.

6. Double-click the INSIGHT desktop icon to start the software.

Related Topics

Turning off a Computer Control Instrument

Local Control Instruments

Turning off a Computer Control Instrument

To turn off the instrument

1. Close INSIGHT software.

2. Hold down the Power button on the keypad for 4 seconds.

Note  If the instrument fails to initialize, the power indicator blinks rapidly. Contact us.

Tip  For routine use, leave the power switch on the instrument back panel in the On 
position and use the Power button on the keypad to turn the instrument on and off (press 
and hold the keypad Power button 4 seconds to power off ).
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3. If necessary, turn off the spectrophotometer main power switch (on the back panel).

Related Topics

Setting up a Computer Control Instrument

Local Control Instruments

Local Control Instruments

Local Control instruments include a touchscreen and an embedded computer preloaded with 
INSIGHT software. Follow these steps to set up a Local Control instrument to run from the 
touchscreen or from a remote computer.

All instrument features can be run from the touchscreen or remote computer. Basic operations 
such as powering the spectrophotometer on and off, measuring a sample or baseline and 
running predefined macros can also be performed from the instrument keypad (see Keypad 
Operation).

Related Topics

Setting up a Local Control instrument for touchscreen operation

Setting up a Local Control instrument for remote operation

Turning off a Local Control Instrument

Computer Control Instruments

Setting up a Local Control instrument for touchscreen operation

To set up a Local Control instrument (no computer connected to the instrument)

1. Turn on the spectrophotometer main power switch (on the back panel).

2. Press the Power button on the keypad.

Wait for the system to initialize. The power indicator on the keypad stops blinking when 
initialization is complete. INSIGHT software starts automatically and appears on the 
touchscreen.

Related Topics

Setting up a Local Control instrument for remote operation

Turning off a Local Control Instrument

Tip  For routine use, leave the power switch on the instrument back panel in the On 
position and use the Power button on the keypad to turn the instrument on and off.
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Computer Control Instruments

Touchscreen keyboard

Setting up a Local Control instrument for remote operation

To set up a Local Control instrument to run from a remote computer

1. Connect the supplied USB cable to the Computer port on the back of the 
spectrophotometer.

2. Connect the other end of the cable to the USB port on the back of the computer.

3. Turn on the spectrophotometer main power switch (on the back panel).

4. Press the Power button on the keypad.

Wait for the system to initialize. The power indicator on the keypad stops blinking when 
initialization is complete. INSIGHT software starts automatically and appears on the 
touchscreen.

5. Make sure the remote computer is on.

6. Do one of the following:

• Hold down the Function 4 and Function 2 keys on the instrument keypad for 
4 seconds.

• From the INSIGHT software displayed on the touchscreen, choose System Settings 
> System. In the Instrument Control group, select Computer.

7. Double-click the INSIGHT desktop icon on the remote computer to start the software.

Related Topics

Setting up a Local Control instrument for touchscreen operation

Turning off a Local Control Instrument

Computer Control Instruments

Note  To return control to the touchscreen, from the INSIGHT software displayed on the 
remote computer:

1. Do one of the following:

• Choose System Settings > System. In the Instrument Control group, select 
Instrument Local.

• Hold down the Function 4 and Function 1 keys on the instrument keypad for 
4 seconds.

2. Double-click the INSIGHT desktop icon on the touchscreen to start the software.
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Turning off a Local Control Instrument

To turn off the instrument

1. Close INSIGHT software.

2. Press the Power button on the keypad.

3. Respond to the prompt to shut down Windows software.

4. If necessary, turn off the spectrophotometer main power switch (on the back panel).

Related Topics

Setting up a Local Control instrument for touchscreen operation

Setting up a Local Control instrument for remote operation

Computer Control Instruments

Keypad Operation

Use the keypad to perform the following operations.

Tip  For routine use, leave the power switch on the instrument back panel in the On 
position and use the Power button on the keypad to turn the instrument off.

Button Label Function

Enter Confirm highlighted choices in menus and text entry boxes.

Run Perform the measurements specified using the current settings.
When the Loading Guide is displayed, pressing Run is equivalent 
to clicking the OK button in the software.

Stop Stop the current operation.
When the Loading Guide is displayed, pressing Stop is equivalent 
to clicking the Cancel button in the software.

Zero/Base Perform a zero measurement or baseline scan.

Power Turn the instrument on or off (press and hold 4 seconds to power 
off ).

Function Start an assigned program or CUE script. See Assigning CUE 
Scripts to Function Keys. Use the CUE application to edit scripts. 
See the CUE on-line help for details.
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Keypad Shortcuts

Maintenance

Routine Maintenance

Clean the instrument regularly using approved methods (wipe off spilled chemicals 
immediately).

Related Topics

Cleaning the Instrument

Cleaning the Touchscreen

Removing and Installing the Detector Module

Cleaning the Instrument

Clean the exterior of the instrument and the sample and reference compartment interior 
periodically. These compartments have a port to allow small amounts of liquid to drain from 
the instrument.

To clean the touchscreen, see Cleaning the Touchscreen.

Action Keypad Shortcut

For Local Control instruments:

• Switch INSIGHT control from touchscreen 
to remote computer

• Switch INSIGHT control from remote 
computer to touchscreen

Function 4/Function 2 
(hold down 4 seconds)

Function 4/Function 1 
(hold down 4 seconds)

Contents

• Routine Maintenance

• Cleaning the Instrument

• Cleaning the Touchscreen

• Removing and Installing the Detector Module

NOTICE    Do not allow moisture to leak into the instrument interior.
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To clean the instrument exterior and the sample or reference compartment interior

1. Use a lint-free cloth dampened with a weak solution of detergent and water to wipe the 
surface as necessary.

2. Repeat using a cloth dampened with plain water.

3. Dry the surface with another cloth.

Related Topics

Routine Maintenance

Cleaning the Touchscreen

Removing and Installing the Detector Module

Cleaning the Touchscreen

Clean the instrument touchscreen as needed to remove dust, fingerprints and other materials.

To clean the touchscreen

1. Press the Power button on the keypad to turn off the spectrophotometer.

2. Wipe the screen gently with a soft, lint-free cloth dampened (not wet) with distilled 
water.

To remove stubborn materials or oil, use a standard screen cleaner kit that includes 
antistatic wipes. Spray a little solution on the wipe and rub it gently across the screen.

3. Dry the screen with a clean, lint-free cloth.

Related Topics

Routine Maintenance

Cleaning the Instrument

Removing and Installing the Detector Module

Removing and Installing the Detector Module

Some accessories have a dedicated detector and require removing the instrument detector 
module before they can be installed.

Avoid UV radiation hazard in the detector compartment. Protect eyes and skin from 
exposure.
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Languages

To remove the detector module

1. Turn off the spectrophotometer main power switch (on the back panel).

2. Remove the detector access cover. See Detector Access Cover.

3. Loosen the thumbscrew that attaches the detector module to the instrument, and 
carefully lift the module straight up.

CAUTION  Safety glasses with side shields or goggles with solid side pieces are the only 
equipment that provides adequate eye protection against direct and reflected UV light.

CAUTION  Seules les lunettes de sécurité avec écrans latéraux ou les lunettes 
protectrices avec parties latérales solides protègent les yeux de façon adéquate 
contre la lumière UV directe et réfléchie.

CAUTION  Sicherheitsbrillen mit seitlichem Schutz bzw. Schutzbrillen mit festen 
Seitenteilen bieten als einzige Ausrüstungsgegenstände adäquaten Schutz der 
Augen gegen direkte und reflektierte UV-Strahlung.

CAUTION  Gli occhiali protettivi con schermi laterali o con schermi laterali 
monolente sono l'unica attrezzatura che fornisce un'adeguata protezione degli 
occhi dalla luce UV diretta e riflessa.

CAUTION  Las gafas protectoras con protección lateral de seguridad o con piezas 
laterales sólidas son el único equipo que proporciona la protección para los ojos 
adecuada contra la luz ultravioleta directa y reflejada.

NOTICE    Avoid touching the connector pins on the bottom of the detector module.
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.

4. Replace the detector access cover.

5. Store the detector module in a secure, dust-free location.

To install the detector module

1. Turn off the spectrophotometer. See Using the Spectrophotometer.

2. Remove the detector access cover. See Detector Access Cover.

3. Unplug the accessory detector cable if necessary.

4. Position the detector module so its thumbscrew faces left.

5. Line up the connector on the bottom of the detector module with the connector in the 
detector compartment, and then press down on the module to secure the connection.

6. Tighten the thumbscrew by hand.

7. Replace the detector access cover.

Related Topics

Routine Maintenance

Cleaning the Instrument

Cleaning the Touchscreen

Thumbscrew

Detector module

Thumbscrew
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Detector Access Cover

Detector Access Panel

Ordering Parts
To order replacement parts, see Contacting Us.
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4

Life Science Applications

About the Life Science Applications
There are two types of protein assay methods included, direct UV and colorimetric assays. 
The colorimetric assays include several assays that are similar. Likewise, the direct protein 
methods are also very similar. Use the table below to find the appropriate assay procedure. 
Click the links to access complete information about the assays.

Below are the default values for the methods. Wavelengths are in nanometers.

Contents

• About the Life Science Applications

• Nucleic Acid

• Nucleic Acid Labels

• Protein A280

• Proteins and Labels

• Pierce BCA

• Protein Bradford

• Pierce Modified Lowry

• Pierce 660 nm Protein Assay

Direct UV Assays Colorimetric Assays

Protein A280 Protein A280

Proteins and Labels Protein Bradford

Pierce BCA

Pierce Modified Lowry

Pierce 660 nm Protein Assay

Protein Biuret
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Nucleic Acid

Overview

See Unique Screen Features for information about the results the application calculates. See 
Nucleic Acid Concentration Calculations for information about the calculations.

Method
Analytical 
Wavelength 
(Quant)

Reference 
Wavelength

Start 
(Scan)

Stop 
(Scan) Bandwidth

Integration 
Time (sec) 
(Fixed, Scan)

Data 
Interval 
(Scan)

Scan 
Speed 
(nm/min)

Nucleic Acid 340 220 350 1.0 1.0, 0.08 0.50 375

Nucleic Acid 
Labels

340 220 850 1.0 1.0, 0.16 1.00 375

Protein A280 340 220 850 1.0 1.0, 0.08 0.5 375

Proteins & Labels 340 220 850 1.0 1.0, 0.16 1.0 375

Pierce BCA 562 340 750 450 1.0 1.0, 0.12 1.00 500

Protein Bradford 595 340 750 450 1.0 1.0, 0.12 1.00 500

Pierce Modified 
Lowry

750 405 900 600 1.0 1.5, 0.12 1.00 500

Pierce 660 nm 
Protein Assay

660 340 850 550 1.0 1.5, 0.12 1.00 500

Protein Biuret 550 340 750 450 1.0 1.0, 0.12 1.00 500

Contents

• Overview

• Nucleic Acid Concentration Calculations

• Application Settings

• Unique Screen Features

• Making Nucleic Acid Measurements

• Oligo Calculator

Use the Nucleic Acid application to measure nucleic acid 
samples for concentration and purity.
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Related Topics

Nucleic Acid Concentration Calculations

Application Settings

Unique Screen Features

Making Nucleic Acid Measurements

Oligo Calculator

Nucleic Acid Concentration Calculations

The Nucleic Acid application is used for determining the concentration and purity of nucleic 
acid samples. The nucleic acid concentration is determined by multiplying the absorbance at 
260 nm by a factor (default, 50). This factor is essentially the extinction coefficient in units of 
ng-cm/ml. Using this coefficient gives the manipulated equation

where c is the nucleic acid concentration in ng/microliter, A is the absorbance in AU, ε is the 
wavelength-dependent extinction coefficient in ng-cm/microliter, and  is the pathlength in 
centimeters. 

The generally accepted extinction coefficients for nucleic acids are:

Related Topics

Overview

Application Settings

Unique Screen Features

Making Nucleic Acid Measurements

Oligo Calculator

Nucleic Acid Purity Measurements

The 260/280 nm ratio assay determines the purity of nucleic acids based on the 260/280 
ratio.

Coefficient Value

Double-stranded DNA 50 ng-cm/μl

Single-stranded DNA 33 ng-cm/μl

RNA 40 ng-cm/μl

l)/ *(A = c ε
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The 260/230 ratio assay determines the purity of nucleic acids in the presence of phenol, 
which absorbs strongly at 230 nm.

A ratio of approximately 1.8 is generally accepted as “pure” for DNA, approximately 2.0 for 
RNA. If either ratio is appreciably lower, protein, phenol or other contaminants that absorb 
strongly near 280 nm may be present.

The 260/230 values for a “pure” nucleic acid are often higher than the respective 260/280 
values and are commonly in the range 1.8 to 2.2. If the ratio is appreciably lower, copurified 
contaminants may be present.

Application Settings

Type Tab for Nucleic Acid
Measurement Tab for Nucleic Acid
Instrument Tab for Nucleic Acid
Accessories Tab for Nucleic Acid
Samples Tab for Nucleic Acid

Related Topics

Overview

Nucleic Acid Concentration Calculations

Unique Screen Features

Making Nucleic Acid Measurements

Oligo Calculator

Type Tab for Nucleic Acid

To set data acquisition parameters for a Nucleic Acid 
workbook, click Settings to access: 

Click Settings in Nucleic Acid to display the Type tab in 
the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.
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Related Topics

Measurement Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Accessories Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Nucleic Acid Type Type of analysis to perform.

ssDNA is for single-stranded DNA.

Oligo DNA and Oligo RNA use the appropriate extinction 
coefficient based on entered DNA or RNA base sequence. The 
entry will appear on the Oligo Calculator tab.

For Custom, enter a factor (extinction coefficient) by which to 
multiply the measured absorbance. The factor used for other types 
cannot be changed.

Pathlength Distance the light travels through the sample.

Feature Description

Click Settings in Nucleic Acid to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.



4 Life Science Applications
Nucleic Acid

142 Evolution 200 Series User Guide Thermo Scientific

Related Topics

Type Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Related Topics

Type Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Accessories Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Click Settings in Nucleic Acid to display the Instrument 
tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Nucleic Acid

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Related Topics

Type Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Click Settings in Nucleic Acid to display the Accessories 
tab in the right pane. The available parameters depend 
on the installed accessories. See Accessories for details.

Click Settings in Nucleic Acid to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Accessories Tab for Nucleic Acid

Unique Screen Features

The spectral display shows data for the current sample. 

These features are to the right of the spectral display:

The right pane in Measure Nucleic Acid displays 
workbook parameters specific to the application. Task 
buttons in the left pane are described in Task Buttons.

Feature Description

Type Type of analysis to perform. To the right is the factor value from the 
Type tab.

Conc. Concentration determined by multiplying the absorbance at 260 nm 
by a factor (default, 50) after correction is applied. Beer’s law is used to 
calculate the nucleic acid concentration (see Nucleic Acid 
Concentration Calculations).

A260 Absorbance at 260 nm.
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Related Topics

Overview

Nucleic Acid Concentration Calculations

Application Settings

Making Nucleic Acid Measurements

Oligo Calculator

Making Nucleic Acid Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To measure nucleic acids

1. Click Measure Nucleic Acid in Nucleic Acid.

2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. The buffer should be the same pH and of a similar ionic strength as 
the sample solution.

A280 Absorbance at 280 nm.

260/280 Ratio of sample absorbance at 260 nm and 280 nm, used to assess the 
purity of DNA and RNA. A ratio of about 1.8 is generally accepted as 
“pure” for DNA, about 2.0 for RNA. If either ratio is appreciably 
lower, protein, phenol or other contaminants that absorb strongly 
near 280 nm may be present. See Nucleic Acid Purity Measurements 
for more information.

260/230 Ratio of absorbance at 260 nm and 230 nm, a secondary measure of 
nucleic acid purity.

Feature Description

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Related Topics

Overview

Nucleic Acid Concentration Calculations

Application Settings

Unique Screen Features

Data Display

Oligo Calculator

Oligo Calculator

To use Oligo Calculator 

1. Enter a base sequence on the Oligo Calculator tab.

More:

Use:

• The buttons below the Base Sequence box.

• The A, C, G, T and U keys on the keyboard.

• Copy and paste a base sequence (A, C, G, T and U only) from another application.

To clear the sequence, click Clear. Individual bases can be deleted only manually.

2. Select the nucleic acid type to analyze.

3. Select the degree of phosphorylation if applicable: mono-phosphate for DNA; mono- or 
tri-phosphate for RNA.

4. Select Double-stranded if applicable. The complementary base sequence will be 
included in the analysis.

Use Oligo Calculator to calculate molecular weight, 
extinction coefficients, concentration factors and 
melting points for specific nucleic acid sequences. 
Clicking this task button displays:

Tab Description

Oligo Calculator For entering sequences of interest and selecting appropriate sample type 
variables.

Melting Displays the calculated melting points of a DNA strand. Available only 
for DNA sequences.
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5. Enter the molecular weights of any additions to the base sequence in the Modification 
box.

The calculated results appear:

To calculate the melting point of a DNA sequence

1. Enter the base sequence on the Oligo Calculator tab.

2. Enter appropriate values on the Melting tab:

The calculated results appear:

Nucleic Acid Labels

Result Description

Molecular weight Calculated base sequence molecular weight.

Molar extinction 
coefficient

Calculated 260 nm extinction coefficient in ng-cm/microliter.

Concentration factor Factor, based on the extinction coefficient, used to calculate the 
concentration of the base sequence.

Number of bases Number of bases in the entered sequence.

% GC Percentage of the total number of bases made up by guanine 
and cytosine.

Parameter Description

Oligo molarity Concentration of the Oligo in molar units.

Cation molarity Concentration of cations in the sample.

% Formamide Percentage concentration of formamide in the sample.

Result Description

Salt-adjusted Calculated melting point of the base sequence, corrected for the 
concentration of cation in the sample. This method does not 
account for the effect of interaction between neighboring bases.

Nearest-neighbor Melting point of the base sequence when the effect of interaction 
between neighboring bases is taken into account.

Contents



4 Life Science Applications
Nucleic Acid Labels

150 Evolution 200 Series User Guide Thermo Scientific

Overview

Related Topics

Dye/Chromophore Editor

Application Settings

Unique Screen Features

Making Nucleic Acid Labels Measurements

Oligo Calculator

Dye/Chromophore Editor

To enter a new dye, type its information in the appropriate cells of the bottom row of the table 
and select a unit. Refer to the dye manufacturer for appropriate correction factors. The 
260 nm corrections will be used for nucleic acid sample concentration calculations. Entered 
information is saved automatically.

To delete a user-defined dye, right-click its row and choose Delete Row. Predefined dyes, 
identified by the lock icon, cannot be edited or deleted.

• Overview

• Dye/Chromophore Editor

• Application Settings

• Unique Screen Features

• Making Nucleic Acid Labels Measurements

• Oligo Calculator

Use the Nucleic Acid Labels application to measure 
nucleic acid samples for concentration and purity.

Use the Dye Chromophore Editor to select predefined 
dyes, modify existing dyes for protocols, or enter new 
dyes.
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Application Settings

Type Tab for Nucleic Acid Labels
Measurement Tab for Nucleic Acid Labels
Instrument Tab for Nucleic Acid Labels
Accessories Tab for Nucleic Acid Labels
Samples Tab for Nucleic Acid Labels

Related Topics

Overview

Dye/Chromophore Editor

Unique Screen Features

Making Nucleic Acid Labels Measurements

Oligo Calculator

Type Tab for Nucleic Acid Labels

To set data acquisition parameters for a Nucleic Acid 
Labels workbook, click Settings to access: 

Click Settings in Nucleic Acid Labels to display the Type 
tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Nucleic Acid Type Type of analysis to perform.

ssDNA is for single-stranded DNA.

Oligo DNA and Oligo RNA use the appropriate extinction 
coefficient based on the entered DNA or RNA base sequence. The 
entry will appear on the Oligo Calculator tab.

For Custom, enter a factor (extinction coefficient) by which to 
multiply the measured absorbance. The factor used for other types 
cannot be changed.

Set Dye 1 and Dye 2 to the fluorescent dyes whose absorbance will 
be used in concentration correction calculations.

Pathlength Distance the light travels through the sample.
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Related Topics

Measurement Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Click Settings in Nucleic Acid Labels to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Related Topics

Type Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Click Settings in Nucleic Acid Labels to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Nucleic Acid Labels

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Related Topics

Type Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Click Settings in Nucleic Acid Labels to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. See 
Accessories for details.

Click Settings in Nucleic Acid Labels to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Instrument Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Unique Screen Features

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Making Nucleic Acid Labels Measurements

Oligo Calculator

The right pane in Measure Nucleic Acid Labels 
includes: 

Feature Description

Type Type of analysis to perform. To the right is the factor value from the 
Type tab.

Conc. Concentration based on absorbance at 260 nm, the default or 
user-defined extinction coefficient, and the specified pathlength. (The 
extinction coefficient is reported for a 10 mm pathlength.) Beer’s law 
is used to calculate the nucleic acid concentration (see Nucleic Acid 
Concentration Calculations).

The displayed A260 value is baseline corrected. The A260 value 
actually used to calculate the concentration takes into account the 
appropriate dye correction factors and any absorbance correction due 
to the selected analysis correction wavelength.

A260 Absorbance at 260 nm.

260/280 Ratio of sample absorbance at 260 nm and 280 nm, used to assess the 
purity of DNA and RNA. A ratio of ~1.8 is generally accepted as 
“pure” for DNA, ~2.0 for RNA. If either ratio is appreciably lower, 
protein, phenol or other contaminants that absorb strongly near 
280 nm may be present. See Nucleic Acid Purity Measurements for 
more information.

Dye(s) Conc. Concentration of the user-selected dye(s).
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Making Nucleic Acid Labels Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Nucleic Acid Labels measurement

1. Click Measure Nucleic Acid Labels in Nucleic Acid Labels.

2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. The buffer should be the same pH and of a similar ionic strength as 
the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.

Note  Use a fresh aliquot of sample for each measurement.
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To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Unique Screen Features

Data Display

Oligo Calculator

After the Measurement

• When using the cuvette option, remove the cuvette, rinse thoroughly and dry between 
samples.
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Oligo Calculator

To use Oligo Calculator 

1. Enter a base sequence on the Oligo Calculator tab.

More:

Use:

• The buttons below the Base Sequence box.

• The A, C, G, T and U keys on the keyboard.

• Copy and paste a base sequence (A, C, G, T and U only) from another application.

To clear the sequence, click Clear. Individual bases can be deleted only manually.

2. Select the nucleic acid type to analyze.

3. Select the degree of phosphorylation if applicable: mono-phosphate for DNA; mono- or 
tri-phosphate for RNA.

4. Select Double-stranded if applicable. The complementary base sequence will be 
included in the analysis.

5. Enter the molecular weights of any additions to the base sequence in the Modification 
box.

The calculated results appear:

Use Oligo Calculator to calculate molecular weight, 
extinction coefficients, concentration factors and 
melting points for specific nucleic acid sequences. 
Clicking this task button displays:

Tab Description

Oligo Calculator For entering sequences of interest and selecting appropriate sample type 
variables.

Melting Displays the calculated melting points of a DNA strand. Available only 
for DNA sequences.

Result Description

Molecular weight Calculated base sequence molecular weight.

Molar extinction 
coefficient

Calculated 260 nm extinction coefficient in ng-cm/microliter.

Concentration factor Factor, based on the extinction coefficient, used to calculate the 
concentration of the base sequence.
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To calculate the melting point of a DNA sequence

1. Enter the base sequence on the Oligo Calculator tab.

2. Enter appropriate values on the Melting tab:

The calculated results appear:

Protein A280

Overview

Number of bases Number of bases in the entered sequence.

% GC Percentage of the total number of bases made up by guanine 
and cytosine.

Parameter Description

Oligo molarity Concentration of the Oligo in molar units.

Cation molarity Concentration of cations in the sample.

% Formamide Percentage concentration of formamide in the sample.

Result Description

Salt-adjusted Calculated melting point of the base sequence, corrected for the 
concentration of cation in the sample. This method does not 
account for the effect of interaction between neighboring bases.

Nearest-neighbor Melting point of the base sequence when the effect of interaction 
between neighboring bases is taken into account.

Result Description

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Protein A280 Measurements

The Protein A280 method is used to quantify proteins on 
the basis of their absorbance at 280 nm.
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Tyrosine, tryptophan, phenylalanine and to a small extent lysine and Cys-Cys disulphide 
bonds have an absorbance peak around 280 nm. This method does not require generation of 
a standard curve and is ready for protein sample quantitation at software startup. Colorimetric 
assays such as Pierce BCA, Pierce 660 nm, Bradford and Lowry are more commonly used for 
uncharacterized protein solutions and cell lysates.

The Protein A280 application displays the UV spectrum, measures the protein’s absorbance at 
280 nm (A280), and calculates the concentration (mg/ml).

Related Topics

Application Settings

Unique Screen Features

Making Protein A280 Measurements

Application Settings

Type Tab for Protein A280
Measurement Tab for Protein A280
Instrument Tab for Protein A280
Accessories Tab for Protein A280
Samples Tab for Protein A280

Related Topics

Overview

Unique Screen Features

Making Protein A280 Measurements

Type Tab for Protein A280

To set data acquisition parameters for a Protein A280 
workbook, click Settings to access: 

Click Settings in Protein A280 to display the Type tab in 
the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.
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Related Topics

Measurement Tab for Protein A280

Instrument Tab for Protein A280

Accessories Tab for Protein A280

Samples Tab for Protein A280

Measurement Tab for Protein A280

Protein A280 Type Type of analysis to perform.

1 Abs = 1 mg / mL is a general reference setting based on a 0.1% 
(1 mg/ml) protein solution. It produces an absorbance of 1.0 A at 
280 nm (where the pathlength is 10 mm, or 1 cm).

BSA is a Bovine Serum Albumin reference. Protein concentrations 
are calculated using the mass extinction coefficient of 6.7 at 
280 nm for a 1% (10 mg/ml) BSA solution.

IgG is an IgG reference. Protein concentrations are calculated using 
the mass extinction coefficient of 13.7 at 280 nm for a 1% 
(10 mg/ml) IgG solution.

For Lysozyme, protein concentrations are calculated using the mass 
extinction coefficient of 26.4 at 280 nm for a 1% (10 mg/ml) 
Lysozyme solution.

Other protein (ε & MW) is the entered molar extinction 
coefficient (M-1 cm-1) and molecular weight (MW) in kilodaltons 
(kDa) for the respective protein reference. The maximum values are 
99999000 for ε and 9999000 for MW.

Other protein (ε 1%) is the mass extinction coefficient (l g-1 cm-1) 
for a 10 mg/ml (1%) solution of the respective reference protein. 
Enter an ε/1000 value.

Pathlength Distance the light travels through the sample.

Feature Description

Click Settings in Protein A280 to display the 
Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Protein A280

Instrument Tab for Protein A280

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Protein A280

Samples Tab for Protein A280

Instrument Tab for Protein A280

Related Topics

Type Tab for Protein A280

Measurement Tab for Protein A280

Accessories Tab for Protein A280

Samples Tab for Protein A280

Click Settings in Protein A280 to display the Instrument 
tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Protein A280

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Protein A280

Measurement Tab for Protein A280

Instrument Tab for Protein A280

Samples Tab for Protein A280

Samples Tab for Protein A280

Related Topics

Type Tab for Protein A280

Measurement Tab for Protein A280

Instrument Tab for Protein A280

Click Settings in Protein A280 to display the Accessories 
tab in the right pane. The available parameters depend 
on the installed accessories. See Accessories for details.

Click Settings in Protein A280 to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Accessories Tab for Protein A280

Unique Screen Features

Related Topics

Overview

Application Settings

Making Protein A280 Measurements

Making Protein A280 Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Protein A280 measurement

1. Click Measure Protein A280 in Protein A280.

2. Click Measure.

The right pane in Measure Protein A280 may include: 

Feature Description

Type Type of analysis to perform.

ε/1000 and Molecular 
Weight (kDa)

ε/1000 and molecular weight for the Other protein (ε & 
MW) sample type.

Ext. Coeff, ε 1% (L/g-cm) Extinction coefficient and ε 1% for the Other protein (ε 
1%) sample type.

Conc. Concentration based on absorbance at 280 nm, after 
correction is applied, and the selected extinction coefficient.

A280 Absorbance at 280 nm for the protein sample being 
measured.

260/280 Ratio of absorbance at 260 nm and 280 nm.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. The buffer should be the same pH and of a similar ionic strength as 
the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Application Settings

Unique Screen Features

Data Display

Proteins and Labels

Overview

Related Topics

Dye/Chromophore Editor

Contents

• Overview

• Dye/Chromophore Editor

• Application Settings

• Unique Screen Features

• Making Proteins and Labels Measurements

The Proteins & Labels application determines protein 
concentration using the protein’s intrinsic absorption at 
280 nm as well as the concentration of a fluorescent dye 
modification (protein array conjugates). It can also 
measure the purity of metalloproteins (such as 
hemoglobin) using wavelength ratios.
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Application Settings

Unique Screen Features

Making Proteins and Labels Measurements

Dye/Chromophore Editor

To enter a new dye, type its information in the appropriate cells of the bottom row of the table 
and select a unit. Refer to the dye manufacturer for appropriate correction factors. The 
260 nm corrections will be used for nucleic acid sample concentration calculations. Entered 
information is saved automatically.

To delete a user-defined dye, right-click its row and choose Delete Row. Predefined dyes, 
identified by the lock icon, cannot be edited or deleted.

Application Settings

Type Tab for Proteins and Labels
Measurement Tab for Proteins and Labels
Instrument Tab for Proteins and Labels
Accessories Tab for Proteins and Labels
Samples Tab for Proteins and Labels

Related Topics

Overview

Dye/Chromophore Editor

Unique Screen Features

Making Proteins and Labels Measurements

Type Tab for Proteins and Labels

Use the Dye Chromophore Editor to select predefined 
dyes, modify existing dyes for protocols, or enter new 
dyes.

To set data acquisition parameters for a Proteins and 
Labels workbook, click Settings to access: 

Click Settings in Proteins and Labels to display the Type 
tab in the right pane.
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Related Topics

Measurement Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Feature Description

Name Application name.

Description (optional) Description of the template.

Type Type of analysis to perform.

1 Abs = 1 mg / mL is a general reference setting based on a 0.1% 
(1 mg/ml) protein solution. It produces an absorbance of 1.0 A at 
280 nm (where the pathlength is 10 mm, or 1 cm).

BSA is a Bovine Serum Albumin reference. Protein concentrations 
are calculated using the mass extinction coefficient of 6.7 at 
280 nm for a 1% (10 mg/ml) BSA solution.

IgG is an IgG reference. Protein concentrations are calculated 
using the mass extinction coefficient of 13.7 at 280 nm for a 1% 
(10 mg/ml) IgG solution.

For Lysozyme, protein concentrations are calculated using the 
mass extinction coefficient of 26.4 at 280 nm for a 1% 
(10 mg/ml) Lysozyme solution.

Other protein (ε & MW) is the entered molar extinction 
coefficient (M-1 cm-1) and molecular weight (MW) in kilodaltons 
(kDa) for the respective protein reference. The maximum values 
are 99999 X 1000 for ε and 9999 X 1000 for MW

Other protein (ε 1%) is the mass extinction coefficient 
(l g-1 cm-1) for a 10 mg/ml (1%) solution of the respective 
reference protein.

Dye 1 and Dye 2 Fluorescent dyes whose absorbance will be used in concentration 
correction calculations.

Pathlength Distance the light travels through the sample.
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Measurement Tab for Proteins and Labels

Click Settings in Proteins and Labels to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Proteins and Labels

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Related Topics

Type Tab for Proteins and Labels

Measurement Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Click Settings in Proteins and Labels to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Samples Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Proteins and Labels

Measurement Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Related Topics

Type Tab for Proteins and Labels

Click Settings in Proteins and Labels to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. See 
Accessories for details.

Click Settings in Proteins and Labels to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Measurement Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Unique Screen Features

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Making Proteins and Labels Measurements

Making Proteins and Labels Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Proteins and Labels measurement

1. Click Measure Proteins & Labels in Proteins and Labels.

The right pane in Measure Protein & Labels includes:

Feature Description

Type Type of analysis to perform.

ε/1000 and Molecular Weight 
(kDa)

ε/1000 and molecular weight for the Other protein (ε & 
MW) sample type.

Ext. Coeff, ε 1% (L/g-cm) Extinction coefficient and ε 1% for the Other protein (ε 
1%) sample type.

Conc. Concentration based on absorbance at 280 nm, after 
correction is applied, and the selected extinction 
coefficient.

Dye(s) Conc. Concentration of the user-selected dye(s).

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.



 4 Life Science Applications
Proteins and Labels

Thermo Scientific Evolution 200 Series User Guide 177

2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. This solution should be the same pH and of a similar ionic strength 
as the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Unique Screen Features

Data Display

Pierce BCA
Contents

• Overview

• Application Settings

• Working With Standard Curves

• Making Pierce BCA Measurements
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Overview

Related Topics

Application Settings

Working With Standard Curves

Making Pierce BCA Measurements

BCA Kits and Protocols

Commercial BCA Protein kit manufacturers typically outline procedures for two different 
protein concentration ranges:

• A regular assay uses a 20:1 reagent/sample volume ratio.

• A mini assay uses a 1:1 reagent/sample volume ratio. To prepare sufficient volume of these 
1:1 mixtures for cuvette measurements, use a sample volume of at least 3 ml and 3 ml of 
BCA reagent. 

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns). Ensure each is subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the 
manufacturer for the BCA assay.

The BCA Protein Assay, which was patented by Pierce 
Biotechnology, part of Thermo Fisher Scientific, remains a 
cornerstone for accurately measuring protein 
concentration in biological samples. The method uses 
bicinchoninic acid (BCA) as the detection reagent for 
Cu+, which is formed when Cu2+ is reduced by protein in 
an alkaline environment. A purple-colored reaction 
product is formed by the chelation of two molecules of 
BCA with one cuprous ion (Cu+). The resulting Cu-BCA 
chelate formed in the presence of protein is measured at 
562 nm. While this assay is linear over a wide 
concentration range, the calibration curves are best 
represented as second order. Preformulated reagents of 
BCA and CuSO4 are available in kit form from us.

Note  If running the assay at 60 °C, doubling the volumes may afford greater insurance 
against skewed results from evaporation/condensation within the sealed reaction tube.
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Application Settings

Type Tab for Pierce BCA
Measurement Tab for Pierce BCA
Standards Tab for Pierce BCA
Instrument Tab for Pierce BCA
Accessories Tab for Pierce BCA
Samples Tab for Pierce BCA

Related Topics

Overview

Working With Standard Curves

Making Pierce BCA Measurements

Type Tab for Pierce BCA

Related Topics

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

To set data acquisition parameters for a Pierce BCA 
workbook, click Settings to access: 

Click Settings in Pierce BCA to display the Type tab in 
the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.
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Measurement Tab for Pierce BCA

Click Settings in Pierce BCA to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Pierce BCA

Standards Tab for Pierce BCA

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

Standards Tab for Pierce BCA

Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Click Settings in Pierce BCA to display the Standards 
tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Standard Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Samples Tab for Pierce BCA

Instrument Tab for Pierce BCA

Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

Click Settings in Pierce BCA to display the Instrument 
tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Pierce BCA

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Samples Tab for Pierce BCA

Samples Tab for Pierce BCA

Click Settings in Pierce BCA to display the Accessories 
tab in the right pane. The available parameters depend 
on the installed accessories. See Accessories for details.

Click Settings in Pierce BCA to display the Samples tab 
in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)
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Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Working With Standard Curves

A standard curve is required for colorimetric protein analysis. 

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standards. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest. 

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Overview

Application Settings

Making Pierce BCA Measurements

Making Pierce BCA Measurements

Sample and Standards Preparation

• See the manufacturers’ guidelines and recommendations for standard and sample 
preparation. 

• Prepare both standards and unknowns in the same manner. Use a diluent of the same pH 
and ionic strength for all blanks, standards and unknown samples.

Note  Each workbook will archive only one standard curve.
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Procedure

To make a Pierce BCA measurement

1. Click Measure Pierce BCA in Pierce BCA.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

Note  Standards diluted from a stock standard must cover the expected range of the 
unknown samples. Protein concentrations are not extrapolated beyond measured 
standard concentrations.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Data Display

Protein Bradford

Overview

Contents

• Overview

• Application Settings

• Bradford Standard Curves

• Making Protein Bradford Assay Measurements

The Protein Bradford assay measures absorbance at 
595 nm; it determines concentration for either standard or 
micro sample concentrations.
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This assay is commonly used for determining protein concentration. It is often used for more 
dilute protein solutions where lower detection sensitivity is needed and/or in the presence of 
components that also have significant UV (280 nm) absorbance. Like the other colorimetric 
assays, the Bradford assay requires generating a standard curve before measuring sample 
proteins. 

The Bradford procedure uses the protein-induced absorbance shift of Coomassie Blue dye to 
595 nm to measure protein concentration. The bound protein-dye complex is measured at 
595 nm and normalized at 750 nm. A single stabilized reagent mixture containing Coomassie 
Blue dye, alcohol, and surfactant in kit form is available from numerous manufacturers.

Related Topics

Application Settings

Bradford Standard Curves

Making Protein Bradford Assay Measurements

Bradford Reagent Kits and Protocols

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns), ensuring they are subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the Bradford 
assay manufacturer.

Application Settings

Type Tab for Protein Bradford
Measurement Tab for Protein Bradford
Standards Tab for Protein Bradford
Instrument Tab for Protein Bradford
Accessories Tab for Protein Bradford
Samples Tab for Protein Bradford

Related Topics

Overview

Bradford Standard Curves

Making Protein Bradford Assay Measurements

To set data acquisition parameters for a Protein Bradford 
workbook, click Settings to access: 
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Type Tab for Protein Bradford

Related Topics

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

Measurement Tab for Protein Bradford

Click Settings in Protein Bradford to display the Type 
tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Click Settings in Protein Bradford to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Protein Bradford

Standards Tab for Protein Bradford

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

Standards Tab for Protein Bradford

Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Standards tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Standard Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Samples Tab for Protein Bradford

Instrument Tab for Protein Bradford

Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Protein Bradford

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Samples Tab for Protein Bradford

Samples Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. See 
Accessories for details.

Click Settings in Protein Bradford to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)



 4 Life Science Applications
Protein Bradford

Thermo Scientific Evolution 200 Series User Guide 197

Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Bradford Standard Curves

A standard curve is required for colorimetric protein analysis. 

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standards. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest. 

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Overview

Application Settings

Bradford Standard Curves

Making Protein Bradford Assay Measurements

Making Protein Bradford Assay Measurements

See Sample and Standards Preparation for more information.

Note  Each workbook will archive only one standard curve.
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To make Bradford assay measurements

1. Click Measure Protein Bradford in Protein Bradford.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Bradford Standard Curves

Data Display

Pierce Modified Lowry

Overview

This assay is an alternative method for determining protein concentration based on the widely 
used and cited Lowry procedure for protein quantitation. Like the other colorimetric assays, 
the Lowry assay requires generating a standard curve before measuring sample proteins. 

The Pierce Modified Lowry procedure involves reaction of protein with cupric sulfate in 
alkaline solution, resulting in formation of tetradentate copper-protein complexes. The 
Folin-Ciocalteu Reagent is effectively reduced in proportion to the chelated 
copper-complexes, resulting in a water-soluble blue product that is measured at 650 nm and 
normalized at 405 nm. Preformulated reagents, used in the assay, are available in kit form 
from numerous manufacturers.

Contents

• Overview

• Application Settings

• Lowry Standard Curves

• Making Pierce Modified Lowry Assay Measurements

The Pierce Modified Lowry assay measures absorbance at 
750 nm to determine concentration.
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Related Topics

Application Settings

Lowry Standard Curves

Making Pierce Modified Lowry Assay Measurements

Modified Lowry Kits and Protocols

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns). Ensure each is subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the 
manufacturer for the Lowry assay.

Application Settings

Type Tab for Pierce Modified Lowry
Measurement Tab for Pierce Modified Lowry
Standards Tab for Pierce Modified Lowry
Instrument Tab for Pierce Modified Lowry
Accessories Tab for Pierce Modified Lowry
Samples Tab for Pierce Modified Lowry

Related Topics

Overview

Lowry Standard Curves

Making Pierce Modified Lowry Assay Measurements

Type Tab for Pierce Modified Lowry

To set data acquisition parameters for a Pierce Modified 
Lowry workbook, click Settings to access: 

Click Settings in Pierce Modified Lowry to display the 
Type tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.
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Related Topics

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Feature Description

Click Settings in Protein Lowry to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Standards tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Standard Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Samples Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Pierce Modified Lowry

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. See 
Accessories for details.

Click Settings in Pierce Modified Lowry to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)
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Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Lowry Standard Curves

A standard curve is required for colorimetric protein analysis. 

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standards. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest. 

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Overview

Application Settings

Lowry Standard Curves

Making Pierce Modified Lowry Assay Measurements

Making Pierce Modified Lowry Assay Measurements

See Sample and Standards Preparation for more information.

Note  Each workbook will archive only one standard curve.
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To make Pierce Modified Lowry Assay measurements

1. Click Measure Pierce Modified Lowry in Pierce Modified Lowry.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Lowry Standard Curves

Data Display

Pierce 660 nm Protein Assay

Overview

The proprietary dye-metal complex binds to protein in acidic conditions, causing a shift in 
the dye’s absorption maximum, which is measured at 660 nm. The complex is reddish-brown 
and turns green upon protein binding. This color change is produced by deprotonation of the 
dye at low pH facilitated by interactions with positively charged amino acid groups in the 
protein. Consequently, the complex interacts primarily with basic residues in the protein, such 
as histidine, arginine and lysine, and to a lesser extent tyrosine, tryptophan and phenylalanine.

Contents

• Overview

• Application Settings

• Pierce 660 nm Assay Workbooks

• Standard Curves

• Making Pierce 660 nm Protein Assay Measurements

The Thermo Scientific Pierce 660 nm Protein Assay 
reagent is a ready-to-use formulation that offers rapid, 
accurate and reproducible colorimetric detection of 
minute amounts of protein in solution. The reagent is 
ideal for measuring total protein concentration in samples 
containing reducing agents and/or detergents.
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Related Topics

Application Settings

Pierce 660 nm Assay Workbooks

Standard Curves

Making Pierce 660 nm Protein Assay Measurements

Pierce 660 nm Reagent and Protocols

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns), ensuring they are subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the Pierce 
660 nm assay manufacturer.

Application Settings

Type Tab for Pierce 660 nm Protein Assay
Measurement Tab for Pierce 660 nm Protein Assay
Standards Tab for Pierce 660 nm Protein Assay
Instrument Tab for Pierce 660 nm Protein Assay
Accessories Tab for Pierce 660 nm Protein Assay
Samples Tab for Pierce 660 nm Protein Assay

Related Topics

Overview

Pierce 660 nm Assay Workbooks

Standard Curves

Making Pierce 660 nm Protein Assay Measurements

Type Tab for Pierce 660 nm Protein Assay

To set data acquisition parameters for a Pierce 660 nm 
Protein Assay workbook, click Settings to access: 

Click Settings in Pierce 660 nm Protein Assay to display 
the Type tab in the right pane.
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Related Topics

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Click Settings in Pierce 660 nm Protein Assay to display 
the Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Standards tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Standard Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Samples Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Pierce 660 nm Protein Assay

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Accessories tab in the right pane. The available 
parameters depend on the installed accessories. See 
Accessories for details.

Click Settings in Pierce 660 nm Protein Assay to display 
the Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)
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Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Pierce 660 nm Assay Workbooks

When opened, the Pierce 660 nm Protein Assay application may prompt for a new standard 
curve, requiring the creation of a new workbook. If a previously saved workbook is used, all 
concentration calculations for newly measured samples will be based on the saved curve 
archived in the workbook.

Related Topics

Overview

Application Settings

Standard Curves

Making Pierce 660 nm Protein Assay Measurements

Standard Curves

A standard curve is required for colorimetric protein analysis. 

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standards. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest. 

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Note  Each workbook will archive only one standard curve.
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Related Topics

Overview

Application Settings

Pierce 660 nm Assay Workbooks

Making Pierce 660 nm Protein Assay Measurements

Making Pierce 660 nm Protein Assay Measurements

See Sample and Standards Preparation for more information.

To make Pierce 660 nm Protein assay measurements

1. Click Measure Pierce 660 nm Protein Assay in Pierce 660 nm Protein Assay.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Pierce 660 nm Assay Workbooks

Standard Curves

Data Display

Protein Biuret
Contents

• Overview

• Application Settings

• Standard Curves

• Making Protein Biuret Assay Measurements



4 Life Science Applications
Protein Biuret

224 Evolution 200 Series User Guide Thermo Scientific

Overview

Related Topics

Application Settings

Standard Curves

Making Protein Biuret Assay Measurements

Application Settings

Type Tab for Protein Biuret
Measurement Tab for Protein Biuret
Standards Tab for Protein Biuret
Instrument Tab for Protein Biuret
Accessories Tab for Protein Biuret
Samples Tab for Protein Biuret

Related Topics

Overview

Standard Curves

Making Protein Biuret Assay Measurements

Type Tab for Protein Biuret

The Protein Biuret application is similar to the Pierce 
Modified Lowry application; however, it involves a single 
incubation and requires more protein for the analysis. The 
protein-dye complex that is formed in the assay has a deep 
purple color and is measured at 545 nm. The calibration 
curve for this assay is linear with standards that range in 
concentration from 2 μg/ml to 10 μg/ml.

To set data acquisition parameters for a Protein Biuret 
workbook, click Settings to access: 

Click Settings in Protein Biuret to display the Type tab 
in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.
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Related Topics

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Feature Description

Click Settings in Protein Biuret to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

To use uncorrected data, select None. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, the 
calculated protein concentration may be higher than the true value.

Single point subtracts the sample absorbance at the entered 
wavelength from the absorbance at every data point.

Sloping baseline draws a line between the data points at the entered 
wavelengths, finds its absorbance value at the analytical wavelength, 
and subtracts it from the measured absorbance.

Component name Component to quantify.
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Related Topics

Type Tab for Protein Biuret

Standards Tab for Protein Biuret

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Protein Biuret

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Standards Tab for Protein Biuret

Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Instrument Tab for Protein Biuret

Accessories Tab for Protein Biuret

Click Settings in Protein Biuret to display the Standards 
tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Standard Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Samples Tab for Protein Biuret

Instrument Tab for Protein Biuret

Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Click Settings in Protein Biuret to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Protein Biuret

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Samples Tab for Protein Biuret

Samples Tab for Protein Biuret

Click Settings in Protein Biuret to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. See 
Accessories for details.

Click Settings in Protein Biuret to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use concentration 
limits

Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)
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Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Accessories Tab for Pierce 660 nm Protein Assay

Standard Curves

A standard curve is required for colorimetric protein analysis. 

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standards. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest. 

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Overview

Application Settings

Making Protein Biuret Assay Measurements

Making Protein Biuret Assay Measurements

See Sample and Standards Preparation for more information.

To make Protein Biuret assay measurements

1. Click Measure Protein Biuret in Protein Biuret.

Note  Each workbook will archive only one standard curve.
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2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Standard Curves

Data Display
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Accessories

• Sample Position Cell Holders

• Reference Cell Holders

• 8 Degree Near Normal Specular 
Reflectance

• 15 Degree Specular Reflectance

• 20 Degree Specular Reflectance

• 30 Degree Specular Reflectance

• 45 Degree Specular Reflectance

• 60 Degree Specular Reflectance

• Calibrated Validation Carousel (CVC)

• Depolarizer

• Grazing Angle Specular Reflectance

• Integrated Fiber Optic Module

• Integrating Sphere Diffuse Reflectance

• Mercury Lamp

• Peltier Thermostatted Single Cell 
Holder

• TPS-1500W Sealed Peltier Recirculator

• Probe Handling and Maintenance

• Rapid Mix Accessory

• Smart Linear 8-Cell Changer

• SPE-8W Smart Peltier Linear Cell 
Changer

• Smart Rotary Cell Changer

• Smart Sipper

• Temperature Probe

• Variable Angle Transmission

• VERSA Probe
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8 Degree Near Normal Specular Reflectance
For Local Control instruments:

D://2616_HARRICK_8NN Spec Accy_UG.pdf

For Computer Control instruments:

C://2616_HARRICK_8NN Spec Accy_UG.pdf

If these links do not work, see your documentation CD.

Related Topics

Installing a Manual Accessory

Accessories
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15 Degree Specular Reflectance
For Local Control instruments:

D://2222_PIKE_15spec Accy_UG.pdfFor Computer Control instruments:

C://2222_PIKE_15spec Accy_UG.pdfIf these links do not work, see your documentation 
CD.

Related Topics

Installing a Manual Accessory

Accessories
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20 Degree Specular Reflectance
For Local Control instruments:

D://2614_PIKE_20spec Accy_UG.pdfFor Computer Control instruments:

C://2614_PIKE_20spec Accy_UG.pdfIf these links do not work, see your documentation 
CD.

Related Topics

Installing a Manual Accessory

Accessories
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30 Degree Specular Reflectance
For Local Control instruments:

D://2223_PIKE_30spec Accy_UG.pdfFor Computer Control instruments:

C://2223_PIKE_30spec Accy_UG.pdfIf these links do not work, see your documentation 
CD.

Related Topics

Installing a Manual Accessory

Accessories
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45 Degree Specular Reflectance
For Local Control instruments:

D://2224_PIKE_45spec Accy_UG.pdfFor Computer Control instruments:

C://2224_PIKE_45spec Accy_UG.pdfIf these links do not work, see your documentation 
CD.

Related Topics

Installing a Manual Accessory

Accessories
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60 Degree Specular Reflectance
For Local Control instruments:

D://2615_PIKE_60spec Accy_UG.pdfFor Computer Control instruments:

C://2615_PIKE_60spec Accy_UG.pdfIf these links do not work, see your documentation 
CD.

Related Topics

Installing a Manual Accessory

Accessories
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Calibrated Validation Carousel (CVC)
The Calibrated Validation Carousel (CVC) is an automated performance verification 
accessory.

The CVC carousel uses the same Smart base unit as the Smart Thermostatted Rotary 7-Cell 
Changer (Rotary Cell Changer). The CVC is also supplied without the base unit for 
customers wishing to use the CVC with an existing Rotary Cell Changer base.

The CVC accurately positions the required standards for each test in the sample beam. The 
following table describes the tests and test materials included with the CVC.

INSIGHT software stores all instrument performance specifications and tolerances.

NOTICE    

• Do not touch the exposed surface of the standards in the CVC.

• Do not allow moisture to leak into the accessory.

Contents

• Installing the Carousel on the Smart Base Unit

• Installing Complete CVC in the Instrument

• CVC Test Limits

• Using the CVC

• Maintenance

Test Standard USP EP

Wavelength Accuracy Holmium perchlorate Holmium perchlorate Holmium perchlorate

Wavelength Repeatability Holmium perchlorate Holmium perchlorate Holmium perchlorate

Absorbance Accuracy 1A Neutral Density filter Potassium dichromate Potassium dichromate

UV Absorbance Accuracy  Potassium dichromate Potassium dichromate Potassium dichromate

Absorbance Repeatability 1A Neutral Density filter Potassium dichromate Potassium dichromate

Stray Light  220, 340 nm cut-off filters Sodium Iodide Potassium chloride

Noise 0A and 1A Neutral Density 
filter

Instrument lamp Instrument lamp
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Installing the Carousel on the Smart Base Unit

If purchased as “carousel only”, install the CVC on a Smart base supplied with the Rotary Cell 
Changer.

1. Remove the Rotary Cell Changer (if installed).

Turn the knurled knob counterclockwise on the top of the cell changer and pull it 
upwards.

2. Install the CVC.

• Identify the position of the notch on the motor shaft of the Smart base unit.

• View the underside of the carousel to locate the position of the tab.

3. Place the carousel on the shaft; turn the knurled knob clockwise to tighten.

Related Topics

Installing Complete CVC in the Instrument

CVC Test Limits

Using the CVC

Maintenance

Installing Complete CVC in the Instrument

Install the Smart Accessory as described in Installing a Smart Accessory.

Note  Ensure a positive location of the tab in the notch.

Tab on underside
of carousel

Notch on motor 
shaft of Smart
base unit.

Contents
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Initialization

The accessory must be initialized each time it is installed and after changing the cell holder 
when the Smart base unit is installed. Initializing verifies the cell position and resets the cell 
holder to position 1.

Languages

To initialize a cell changer

1. In the selected application, choose Settings > Accessories > Cell Changer.

2. Click Reset.

Related Topics

Installing a Smart Accessory

Installing the Carousel on the Smart Base Unit

Loading CVC Calibration Data

• Initialization

• Loading CVC Calibration Data

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, à 
l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano dall’accessorio 
durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del alcance 
del accesorio durante la inicialización.
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CVC Test Limits

Using the CVC

Maintenance

Loading CVC Calibration Data

Each CVC has unique calibration data shipped with the accessory. Before a CVC can be used 
for performance testing, it’s serial number and calibration file must be read by INSIGHT 
software. It is not necessary to reload the data unless you purchase a new CVC or have it 
recalibrated.

Make a backup copy of the calibration data before use. Store the master and the Certificate of 
Calibration in a secure location.

To load CVC calibration data

1. From the INSIGHT software Home screen, click Performance Verification.

2. Click Load CVC Calibration. A dialog box lets you browse for the calibration file. The 
file is provided on a memory stick or other medium. The following format is used for the 
file name:

evodata_[x]_[y].cal

where: x is the serial number of the CVC carousel, and
y is the CVC type (e for EP, u for USP and s for Standard).

3. Locate and select the calibration file that matches the installed CVC and click OK.

Related Topics

Installing a Smart Accessory

Installing the Carousel on the Smart Base Unit

Initialization

CVC Test Limits

Using the CVC

Maintenance

Note  The software can store one calibration file for each type of CVC.
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CVC Test Limits

The pass/fail limits are based on the instrument specification and any other tolerances 
associated with the Certified Reference Material (CRM). The software stores all tolerances 
and any instrument pass/fail limits with the calibration data and reports these values as 
appropriate.

Related Topics

Installing a Smart Accessory

Installing the Carousel on the Smart Base Unit

Installing Complete CVC in the Instrument

Loading CVC Calibration Data

Using the CVC

Maintenance

Using the CVC

Before using the CVC, mount the CVC carousel on the base unit and install the accessory in 
the spectrophotometer. See Installing the Carousel on the Smart Base Unit and Installing 
Complete CVC in the Instrument.

If using this CVC for the first time, load the calibration data. See Loading CVC Calibration 
Data.

Running Performance Verification Tests

The CVC performance tests appear only when the CVC is properly installed and a valid 
calibration file has been loaded.

To run CVC performance verification tests

1. Click Performance Verification in Home.

The available tests appear in the right pane.

Contents

• Running Performance Verification Tests

• Viewing CVC Test Reports

Note  If you are running security software, you can perform performance verification tests 
only if you have been given the right to do so by the system administrator.
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2. Select the tests to run.

Languages

Note  The available tests depend on the type of CVC installed.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
operation.

ATTENTION  Évitez les risques de pincement. Éloignez les mains et les objets de 
l’accessoire pendant son fonctionnement.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

PRECAUCIÓN  Evite riesgos de atrapamiento.Mantenga manos y objetos alejados del 
accesorio durante el funcionamiento.

CAUTION  
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3. Click Run.

The status window shows the data and progress.

To end the tests before they are finished, click Stop.

When all the tests are completed, a dialog box shows the report.

The report can be printed or copied. A signature block appears at the end.

The report is saved automatically and appears on the PV Reports tab in My Data. See 
Viewing CVC Test Reports for details.

4. Click Close.

Related Topics

Installing the Carousel on the Smart Base Unit

Installing Complete CVC in the Instrument

Loading CVC Calibration Data

CVC Test Limits

CVC Test Results

Viewing CVC Test Reports

Note  If the serial number of the CVC carousel does not match the serial number 
stored with the current calibration data for the CVC type, an error message appears. 
See Loading CVC Calibration Data.
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Maintenance

CVC Test Results

For each test in the suite, the report shows:

• Test name

• Operator

• Time and date of the test

• Instrument type

• Instrument serial number

• CVC serial number

• Expected result or range, measured result and a pass or fail result

Related Topics

Installing the Carousel on the Smart Base Unit

Installing Complete CVC in the Instrument

Loading CVC Calibration Data

CVC Test Limits

Running Performance Verification Tests

Viewing CVC Test Reports

Maintenance

Viewing CVC Test Reports

To view a CVC test report

1. From the INSIGHT software Home screen, click My Data.

2. Click the PV Reports tab.

The right pane shows all the performance tests run with the instrument.
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• To sort by Report or Date, click the column heading.

• To open a report, double-click the row.

• To combine reports, hold down Shift or Ctrl to select multiple rows, and then 
double-click a selected row.

See My Data and Performance Verification for more information.

Related Topics

Installing the Carousel on the Smart Base Unit

Installing Complete CVC in the Instrument

Loading CVC Calibration Data

CVC Test Limits

Running Performance Verification Tests

CVC Test Results

Maintenance

Maintenance

Contents

• Routine Maintenance

• Recertification

NOTICE    Do not touch the exposed surface of the standards in the CVC.
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Routine Maintenance

Very little maintenance is required to keep the accessory in good working condition. The 
exterior surface of the accessory should be kept clean and free of spilled chemicals and dust.

Use the provided bulb to remove dust from the exposed surface of the standards.

Always keep the accessory in its case when not in use. Always keep the cover closed. Never 
expose the standards to airborne smoke or dust.

Related Topics

Installing the Carousel on the Smart Base Unit

Installing Complete CVC in the Instrument

Loading CVC Calibration Data

Using the CVC

Recertification

Recertification

We offer a recertification and repair service for the CVC. It is recommended that you return 
your accessory for recertification every two years — or whenever you have reason to believe 
that it no longer exhibits its certified value. Before returning your accessory, contact technical 
support.

Related Topics

Installing the Carousel on the Smart Base Unit

Installing Complete CVC in the Instrument

Loading CVC Calibration Data

Using the CVC

Routine Maintenance
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Depolarizer 
For Local Control instruments:

D://2613_HARRICK_Depolarizer Accy_UG.pdfFor Computer Control instruments:

C://2613_HARRICK_Depolarizer Accy_UG.pdfIf these links do not work, see your 
documentation CD.

Related Topics

Installing a Manual Accessory

Accessories



13 

260 Evolution 200 Series User Guide Thermo Scientific



Thermo Scientific Evolution 200 Series User Guide 261

14

Grazing Angle Specular Reflectance
This manual accessory is designed to analyze “mirror like” planar surfaces and/or coatings on 
planar surfaces by recording the specular reflectance at 85 degrees. The energy profile as a 
function of angle is a Gaussian peak centered on 85° and approximately 6° wide.

For more information for Local Control instruments:

D://2625_Grazing Angle Spec Accy_UG.pdfFor Computer Control instruments:

C://2625_Grazing Angle Spec Accy_UG.pdfIf these links do not work, see your 
documentation CD.

Related Topics

Installing a Manual Accessory

Accessories
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Integrated Fiber Optic Module
This accessory provides transfer optics and an integrated detector for SMA (SubMiniature 
version A)-terminated fiber optic probes. Probes must be purchased separately. A test cable is 
included for aligning the accessory.

Safety Considerations

To avoid injury while using the accessory, do not stare at the UV beam or UV light leaving a 
coupled fiber optic cable.

Related Topics

Operating Precautions

Operating Precautions

Handle the accessory carefully:

• Do not allow moisture to leak into the accessory.

Contents

• Safety Considerations

• Operating Precautions

• Installation

• Attaching Cables and Probes

• Operation

• Maintenance

• Troubleshooting

Detector
cable

Test cable

Fiber optic 
module

Detector cable
opening
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• Wipe off spilled chemicals immediately.

• Do not drop the accessory.

• Protect the accessory from mechanical shock.

• Do not touch the exposed optics.

• Keep the protective caps on the ends of the fiber optic ports when they are not in use.

• Store the accessory in a dust-free location.

• Handle the test cable gently and follow the operating precautions for any fiber optic cable 
attached to a probe. See Probe Handling and Maintenance.

Related Topics

Safety Considerations

Installation

To install the accessory

1. Turn off the spectrophotometer. See Using the Spectrophotometer.

2. Remove the instrument detector.

Avoid UV radiation hazard in the detector compartment. Protect eyes and skin from 
exposure.

Languages

CAUTION  Safety glasses with side shields or goggles with solid side pieces are the only 
equipment that provides adequate eye protection against direct and reflected UV 
light.

Remarque  Seules les lunettes de sécurité avec écrans latéraux ou les lunettes protec-
trices avec parties latérales solides protègent les yeux de façon adéquate contre la 
lumière UV directe et réfléchie.

Anmerkung  Sicherheitsbrillen mit seitlichem Schutz bzw. Schutzbrillen mit festen 
Seitenteilen bieten als einzige Ausrüstungsgegenstände adäquaten Schutz der 
Augen gegen direkte und reflektierte UV-Strahlung.

N.B.  Gli occhiali protettivi con schermi laterali o con schermi laterali monolente 
sono l'unica attrezzatura che fornisce un'adeguata protezione degli occhi dalla luce 
UV diretta e riflessa.
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See Removing and Installing the Detector Module.

3. Remove the detector access panel. See Detector Access Panel.

4. Insert the connector on the accessory interface cable into the socket on the bottom of the 
accessory.

5. Install the accessory. See Installing a Manual Accessory.

Before installing, route the interface cable under the baseplate and through the detector 
cable opening so the free connector is above the accessory baseplate.

6. Pass the connector through the opening between the sample and detector compartments. 

7. Plug it into the socket in the detector compartment and press to secure it.

Languages

Nota  Las gafas protectoras con protección lateral de seguridad o con piezas latera-
les sólidas son el único equipo que proporciona la protección para los ojos adecu-
ada contra la luz ultravioleta directa y reflejada.

WARNING  Avoid UV radiation hazard. Do not stare at the beam or light leaving a 
coupled fiber optic cable.

AVERTISSEMENT  Évitez l'exposition au rayonnements UV.  Ne regardez jamais le 
faisceau de lumière qui sort d’une fibre optique couplé.

WARNUNG  Gefahren durch UV-Strahlung sind zu vermeiden. Nicht in den Strahl 
eines gekoppelten Glasfaserkabels blicken.

AVVERTENZA  Evitare il rischio di radiazioni UV.Non fissare il raggio di luce che esce 
dal cavo a fibre ottiche accoppiato.

ADVERTENCIA  Evite el riesgo de radiación ultravioleta.No mire al rayo luminoso que 
sale de un cable de fibra óptica acoplado.
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8. Turn on the spectrophotometer and wait until it initializes. See Using the 
Spectrophotometer.

9. If the instrument has the Application Focused Beam Geometry™ (AFBG) option, select 
an application, click Settings > Instrument and set Bandwidth to Fiber.

10. Align the accessory.

Related Topics

Attaching Cables and Probes

Aligning the Accessory

Attaching Cables and Probes

The accessory is compatible with probes and cables that have SMA connectors. Contact us for 
compatible probes. See Contacting Us.

Install the accessory and align it before installing cables and probes.

To attach cables and probes

1. Remove the protective caps from the probe cables and accessory ports.

Store the caps securely so they can be replaced when the probe or accessory is removed 
from the instrument.

2. Route the cables through the detector compartment on the instrument.

3. Attach the probe’s Light Input cable to the Light Output port on the accessory.

To attach a cable, insert the SMA connector and gently tighten the ferrule by hand.

WARNING  

Note  If you change the application, reset Bandwidth to Fiber, or create a template 
for fiber optic sampling for this application and save your data in a workbook based 
on that template.

NOTICE    When attaching fiber optic cables to the accessory ports, avoid:

• Twisting or bending the cable.

• Touching the tips with your fingers.

• Overtightening or using tools to tighten the connectors.
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4. Attach the probe’s Light Output cable to the Light Input port on the accessory.

Related Topics

Installation

Aligning the Accessory

Operation

Follow the probe manufacturer’s recommendations for compatible samples and operating 
procedures.

If the instrument has the AFBG option, in each application click Settings > Instrument and 
set Bandwidth to Fiber.

Related Topics

Installation

Attaching Cables and Probes

Aligning the Accessory

Maintenance

Light Output port

Light Input port

Contents

• Routine Maintenance

• Aligning the Accessory
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Routine Maintenance

Follow these guidelines:

• Align the accessory each time it is installed or if performance degrades.

• Follow the manufacturer’s recommendations for probe maintenance.

Related Topics

Installation

Attaching Cables and Probes

Aligning the Accessory

Troubleshooting

Aligning the Accessory

Align the accessory each time it is installed it or if performance degrades.

To align the accessory

1. Remove the protective caps from the test cable and from the ports on the accessory.

Store the end caps securely so they can be replaced when the cable or accessory is removed 
from the instrument.

2. Route the test cable through the detector compartment.

3. Attach both connectors to the ports on the accessory.

To attach a cable, insert the SMA connector and gently tighten the ferrule by hand.

4. From INSIGHT software, choose System Settings > Alignment.

See Alignment Tab.

5. Set the filter.

Set Filter to Green (typical) or White (no filter) if the signal is low.

6. Set Bandwidth to Fiber.

NOTICE    When attaching fiber optic cables to the accessory ports, avoid:

• Twisting or bending the cable.

• Touching the cable ends with your fingers.

• Overtightening or using tools to tighten the connectors.

• Scratching the cable ends.
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7. Click Start.

8. Maximize the signal strength:

a. Use the Up/Down knob on the accessory to adjust the signal strength.

b. Adjust the Left/Right knob on the accessory to increase the signal further.

c. Repeat steps a and b until the signal is at its maximum value.

9. Click Stop.

Related Topics

Installation

Attaching Cables and Probes

Routine Maintenance

Troubleshooting

Left/Right alignment knob

Up/Down alignment knob
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Troubleshooting

Related Topics

Installation

Attaching Cables and Probes

Operation

Maintenance

Problem Possible Cause Solution

Unexpected 
changes in signal 
strength or no 
signal

• Soiled probe, optical 
fibers, connectors or 
ports on the Fiber Optic 
Coupler

• Fiber Optic Coupler is 
not aligned properly

• Damaged probe, optical 
fiber or Fiber Optic 
Coupler.

Use the test cable provided with the Fiber 
Optic Coupler to test its performance 
without the probe.

• If performance is acceptable with the 
test cable but not with the probe, 
clean the probe and replace any worn 
seals or O-rings. See Cleaning Probes.

• If performance is still unacceptable, 
contact us. See Contacting Us.
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Integrating Sphere Diffuse Reflectance
This 60 mm Spectralon® integrating sphere accessory supports reflectance and transmittance 
measurements. Specular included and specular excluded measurements are supported for 
reflectance. Solids and solutions, in up to 50 mm pathlength cuvettes, are supported for 
transmittance.

Related Topics

Installing a Manual Accessory

Accessories
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Mercury Lamp
This mercury lamp can be used to calibrate and verify the performance of your UV-Visible 
spectrophotometer.

Safety Considerations

The mercury lamp has a safety interlock to prevent accidental exposure to dangerous levels of 
UV radiation during operation. After the lamp is installed, removing the lamp from the port 
while the instrument is powered on will activate the interlock to block all radiation from the 
lamp.

To avoid defeating the safety interlock, keep all magnets and strong magnetic fields (such as 
those produced by a mass spectrometer or various medical instruments) away from the lamp 
while the instrument is powered on and the lamp cable is connected.

Consignes de sécurité

La lampe à vapeur de mercure comprend un verrouillage de sécurité destiné à prévenir toute 
exposition accidentelle à des doses dangereuses de rayonnement ultraviolet pendant le 
fonctionnement de l’instrument. Une fois la lampe installée, et lorsque l’instrument est sous 
tension, le retrait de la lampe du port active le verrouillage afin de bloquer le rayonnement de 
la lampe.

Pour ne pas déjouer le verrouillage de sécurité, tenez les aimants et autres champs magnétiques 
puissants (tels que ceux produits par un spectromètre de masse ou divers instruments 
médicaux) éloignés de la lampe lorsque l’instrument est sous tension et que le câble de la 
lampe est raccordé.

Contents

• Safety Considerations

• Operating Precautions

• Installation and Operation
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Sicherheitshinweise

Die Quecksilberlampe ist mit einem Sicherheitsschalter ausgerüstet, um während des Betriebs 
eine ungewollte Exposition mit einer gefährlichen Intensität an UV-Strahlung zu vermeiden. 
Wenn die Lampe nach der Lampeninstallation bei eingeschaltetem Instrument aus dem 
Anschluss entfernt wird, wird der Sicherheitsschalter aktiviert, um die Strahlungsabgabe der 
Lampe vollständig zu sperren.

Um eine Deaktivierung des Sicherheitsschalters zu vermeiden, halten Sie alle Magnete und 
starken Magnetfelder (z. B. solche, die von einem Massenspektrometer oder verschiedenen 
Medizingeräten produziert werden) von der Lampe fern, während das Instrument 
eingeschaltet und das Lampenkabel angeschlossen ist.

Considerazioni sulla sicurezza

La lampada al mercurio è dotata di un dispositivo di sicurezza per evitare l’esposizione 
accidentale a livelli pericolosi di radiazione UV durante il funzionamento. Una volta installata 
la lampada, la rimozione della lampada stessa dalla porta mentre lo strumento è acceso, 
attiverà il dispositivo di sicurezza per bloccare tutte le radiazioni prodotte dalla lampada.

Per evitare la disattivazione del dispositivo di sicurezza, tenere tutti i magneti e i forti campi 
magnetici (come quelli prodotti da uno spettrometro di massa o da vari strumenti medicali) 
lontano dalla lampada mentre lo strumento è acceso e il cavo della lampada è collegato.

Consideraciones sobre seguridad

La lámpara de mercurio tiene un sistema de interrupción de seguridad para impedir 
exposiciones accidentales a niveles peligrosos de radiación ultravioleta durante el 
funcionamiento.  Una vez instalada la lámpara, su extracción de la conexión con el 
instrumento encendido activará el sistema de interrupción para bloquear toda su radiación. 

Para evitar neutralizar el sistema de interrupción de seguridad, mantenga todos los imanes y 
campos magnéticos intensos (como los producidos por un espectrómetro de masas o diversos 
instrumentos médicos) lejos de la lámpara mientras el instrumento esté encendido y el cable 
de la lámpara esté conectado. 

Related Topics

Operating Precautions

Installation and Operation
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Operating Precautions

Handle the accessory carefully:

• Do not allow moisture to leak into the accessory.

• Wipe off spilled chemicals immediately.

• Do not drop the accessory.

• Protect the accessory from mechanical shock.

• Do not touch the exposed lens near the end of the lamp shaft (fingerprints and dirt will 
degrade performance.

• Store the accessory in its case.

Related Topics

Safety Considerations

Installation and Operation

Installation and Operation

Use this accessory to perform wavelength and bandwidth tests or a wavelength calibration.

Languages

WARNING  Avoid UV radiation hazard in the mercury lamp compartment. Protect eyes 
and skin from exposure.

AVERTISSEMENT  Évitez tout risque de rayonnement à l’intérieur du compartiment de la 
lampe à vapeur de mercure. Protéger vos yeux et votre peau de toute exposition au 
rayonnement.

WARNUNG  Gefährliche UV-Strahlung im Gehäuse der Quecksilberlampe ist zu 
vermeiden. Augen und Haut müssen vor der Strahlung geschützt werden. 

AVVERTENZA  Evitare il rischio di radiazione UV nel vano della lampada al mercurio. 
Proteggere occhi e pelle dall’esposizione.
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To install the mercury lamp

1. Plug the lamp cable into the Hg Lamp connector on the back of the spectrophotometer. 
See Connectors.

Languages

2. Follow these instructions to run the mercury lamp Performance Verification (PV) tests or 
to perform a wavelength calibration.

• To run a PV test, in INSIGHT software click Home and then click Performance 
Verification. If you have a custom button configuration, click Home, select the 
Classic group and then click Performance Verification.

Select the following PV tests (deselect all other tests) and then click Run:

• Wavelength Accuracy - Hg Lines

• Wavelength Reproducibility - Hg 546

ADVERTENCIA  Evite el riesgo de radiación ultravioleta en el compartimento de la 
lámpara de mercurio. Proteja sus ojos y la piel de la exposición.

WARNING  Avoid defeating the safety interlock. Keep magnets and strong magnetic 
fields away from the mercury lamp when it is installed and the instrument is running.

AVERTISSEMENT  Éviter de déjouer le verrouillage de sécurité. Tenez les aimants et 
autres champs magnétiques puissants éloignés de la lampe à vapeur de mercure 
lorsque celle-ci est installée et que l’instrument est en marche.

WARNUNG  Der Sicherheitsschalter darf nicht deaktiviert werden. Magneten und 
starke Magnetfelder müssen von der Quecksilberlampe fern gehalten werden, wenn 
die Lampe installiert ist und das Instrument läuft. 

AVVERTENZA  Evitare la disattivazione del dispositivo di sicurezza. Tenere i magneti e 
i forti campi magnetici lontano dalla lampada al mercurio mentre è installata e lo 
strumento è in funzione.

ADVERTENCIA  Evite neutralizar el sistema de interrupción de seguridad.  Mantenga 
los imanes y campos magnéticos intensos lejos de la lámpara de mercurio cuando esté 
instalada y el instrumento en funcionamiento.
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See Performance Verification for more information.

• To run wavelength calibration, in INSIGHT software choose System Settings > 
Calibrations. In the Lamps group, under the Hg Lamp heading, click Calibrate.

3. When prompted, lift the Mercury Lamp Access Cover and insert the lamp into the port. 
Press gently until it is secure.

A blue light on the lamp handle indicates when the accessory is properly installed.

4. Click OK to start the selected operation (PV test or calibration).

The lamp requires a few minutes to warm up. When the lamp is ready, the selected 
operation starts automatically. A status bar shows the progress. When the operation is 
completed, a prompt appears showing the calibration or test results.

If the calibration fails, an error message appears. Contact Technical Support. See 
Contacting Us.

If a mercury lamp PV test fails, perform the wavelength calibration and then rerun both 
tests. If a test fails again, contact Technical Support.

5. To run another operation with the mercury lamp, leave the lamp in the instrument, click 
OK and proceed.

6. When finished, click OK at the prompt, remove the mercury lamp from the port and 
secure the access cover.

Samples can be analyzed only when the lamp is not in the port.

To disconnect the mercury lamp

Unplug the lamp cable and place the lamp in the provided case.

Note  Calibrate only if the instrument fails the Wavelength Accuracy test.

Indicator light



17 
Mercury Lamp

278 Evolution 200 Series User Guide Thermo Scientific

Related Topics

Safety Considerations

Operating Precautions
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nanoCell
The nanoCell is designed to make small volume measurements of solutions.

The nanoCell has two basic components: the nanoCell accessory that fits in a standard 1 cm 
cell holder and the mirrored lid used for the measurement.

Getting Started

This section explains how to measure a sample using the nanoCell.

To measure samples with the nanoCell

1. Insert the nanoCell into the sample position single cell holder.

Make sure one of the quartz windows is facing the light beam entering the nanoCell.

Contents

• Getting Started

• Overview

• Introduction to Small Volume Measurements

• Using the nanoCell

• Cleaning the nanoCell

• Pathlength Correction Factors

• Frequently Asked Questions

nanoCell

0.2 mm and 1.0 mm pathlength lids

NOTICE    Never submerge any portion of the nanoCell in liquid.
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2. Load the solution (buffer, water) used for the baseline (scan) or zero (fixed wavelength) 
measurement.

Using a small volume pipette, load 0.7 to 3.0 μL of liquid in the sample loading area at 
the top of the nanoCell.

3. Install an appropriate lid on top of the nanoCell.

Align the grooves in the lid with the two pins near the top of the nanoCell.

4. Measure the zero or baseline.

5. When the measurement is finished, use the pipette to remove the excess liquid.

6. Use a laboratory tissue or microfiber cloth to wipe the sample loading area and the mirror 
in the lid.

7. Repeat the loading and cleaning steps to measure your samples.

Related Topics

Using the nanoCell

Cleaning the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Quartz window

Sample loading area

Locator pins Locator grooves
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Overview

The nanoCell is designed to make accurate, reproducible measurements using very small 
volumes of solution. The nanoCell is most commonly used to measure the concentrations of 
life science samples (DNA, RNA, proteins). The accessory can also be used to measure the 
absorbance of any highly concentrated sample such as small molecule pharmaceuticals or dyes 
used in the textile industry.

The nanoCell allows you to make quick, easy measurements of microliter samples without 
limiting your instrument to only small volume measurements. Simply insert the nanoCell 
into the cell holder, load the cell, install the lid, and begin the measurements.

The nanoCell is identical in dimensions to a standard cuvette, and can be used with a single 
cell holder. Liquid samples are loaded on the sample loading window at the top of the 
accessory and remain there throughout the measurement process.

A schematic of the light path of the nanoCell is shown in Figure 1. Light from the 
spectrophotometer enters the nanoCell and reaches the sample loading area via an optical 
system containing small fiber optic cables. This light passes out the sample loading window, 
through the sample, and reflects off a mirror in the lid of the nanoCell. The position of the 
mirrored lid relative to the sample loading window defines the pathlength of the accessory. 
The lid also helps to prevent rapid evaporation of the sample.

The light that passes through the sample is coupled into a second fiber optic cable and is 
launched out of the nanoCell accessory. The absorbance of the solution is measured using the 
detector in the spectrophotometer.
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Figure 1. Light path of the nanoCell accessory

Related Topics

Using the nanoCell

Cleaning the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Introduction to Small Volume Measurements

Small volume samples are measured by reducing the measurement pathlength to 
accommodate the reduced volume. For example, it would be impossible to measure a 1 μl 
drop of solution in a standard 1 cm cuvette.

To make small volume measurements, the pathlength of the nanoCell accessory is decreased 
by a factor of 10 (1.0 mm pathlength) or 50 (0.2 mm pathlength) compared to a traditional 
10 mm pathlength cuvette.

The Beer Lambert law relates the measured absorbance of a solution to the concentration of 
that solution. The Beer Lambert equation is:



 18 
nanoCell

Thermo Scientific Evolution 200 Series User Guide 283

The linear relationship between absorbance, pathlength, and concentration in the Beer 
Lambert law means that if we decrease the pathlength by a factor of 10, the observed 
absorption will also decrease by a factor of 10.

Related Topics

Using the nanoCell

Cleaning the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Using the nanoCell

The nanoCell accessory has two basic components: the nanoCell and the mirrored lid used for 
the measurement. The nanoCell contains the optics and sample loading window and fits in a 
standard 1 cm cell holder.

Any UV-Visible measurement can be made using the nanoCell over a wavelength range of 
190-1100 nm. This includes scanning, fixed wavelength, and kinetics measurements. The 
measurement range, reproducibility, and wavelength range of the nanoCell is determined by 
the spectrophotometer used to make the measurement.

Installing the nanoCell

The nanoCell ships configured for a z-height (distance from the bottom of the cell to the 
center of the light beam) of 8.5 mm. An adapter is included for 15 mm z-height instruments. 
The adapter simply screws on the base of the nanoCell accessory.

Note  Reducing the pathlength from 1 cm to 1 mm is equivalent to a 10-fold dilution.

Note  The factor(s) multiplied by absorbance measurements to give concentration values 
need to be adjusted for a change in the pathlength. For common DNA, RNA, and 
oligonucleotide concentration factors, see Pathlength Correction Factors.

Contents

• Installing the nanoCell

• Loading a sample

• Measurements
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To install the nanoCell, insert the accessory into a single cell holder in the sample light path of 
the spectrophotometer. One of the quartz windows on the side of the nanoCell accessory (see 
Figure 2) should face the light beam. The nanoCell accessory can be installed with either side 
of the nanoCell facing the light source.

Figure 2. The quartz windows of the nanoCell allow light to enter and exit this accessory. Align 
these windows in the path of the beam.

Related Topics

Loading a sample

Measurements

Cleaning the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Loading a sample

To load a sample on the nanoCell, use a small volume pipette to place between 0.70 μl and 
3.0 μl of solution on the sample loading window.

Tip  To ensure the highest precision data, do not remove the nanoCell from the cell holder 
until all measurements are complete

NOTICE    Install the nanoCell only in accessories designed to hold a single cell. Using the 
nanoCell in a multi-cell holder could lead to inaccurate data.

Quartz window
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Figure 3. Use a small volume pipette to load samples on the nanoCell.

The sample loading window is slightly recessed (see Figure 4) to help the liquid form a drop 
that touches both the sample loading window and the mirror in the lid. Make sure the entire 
surface of the sample loading window is covered with liquid and all of the liquid is loaded into 
the recessed sample loading window. Do no leave excess liquid on the top of the nanoCell 
outside the sample loading window.

Figure 4. Recessed sample loading window at the top of the nanoCell.

Carefully place the appropriate lid on top of the sample loading area so that it sits in each of 
the two locator pins near the top of the nanoCell.

Figure 5. (A) Locator pins on the top of the nanoCell used to position the lid.
(B) Locator grooves in the lid.

Note  Use a calibrated pipette to deliver liquid to the sample loading area of the nanoCell. 
Do not use a standard dropper, transfer pipette, Pasteur pipette, or other large volume 
device.
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Figure 6. The nanoCell accessory with the lid installed.

Related Topics

Installing the nanoCell

Measurements

Cleaning the nanoCell

Storing the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Measurements

Always collect the zero or baseline measurement with a blank solution in the nanoCell.

Related Topics

Installing the nanoCell

Loading a sample

Cleaning the nanoCell

Storing the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Note  Install the lid immediately after loading the sample to prevent evaporation of the 
sample.

Note  If a high background signal or inconsistent data is observed, remeasure the blank 
solution for the baseline or zero. Some measurement errors are due to a poor baseline or 
zero.
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Cleaning the nanoCell

To clean the nanoCell

1. Remove the cap from the nanoCell.

2. Use a pipette to remove the excess sample from the sample loading area on the top of the 
nanoCell.

3. Use a lint-free laboratory tissue, lint-free lens tissue, or microfiber cloth to wipe excess 
liquid from the sample loading area and the mirror in the lid.

Pressurized air can be used to remove lint or dust as necessary.

4. If desired, a suitable solvent such as methanol, ethanol, or isopropanol can be added to 
the cleaning process.

Apply the solvent to a laboratory tissue and wipe the sample loading surface. Never add 
the solvent directly to the sample loading surface.

Related Topics

Using the nanoCell

Storing the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

Storing the nanoCell

Store the nanoCell and lids in the provided case.

Related Topics

Using the nanoCell

Cleaning the nanoCell

Pathlength Correction Factors

Frequently Asked Questions

NOTICE    Never submerge any portion of the nanoCell in liquid.

NOTICE    Do not use strong acids and bases or any of the following solvents with the 
nanoCell: ethylamine, diethylene triamine, methylene chloride, and phosphoric acid.
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Pathlength Correction Factors

Direct UV Assays for DNA, RNA, Oligonucleotides and Protein Concentration

Direct UV Assays for DNA, RNA, Oligonucleotides and Protein Concentration

Assay Unit
Calculation Factor
1.0 cm Pathlength

Calculation Factor
1.0 mm Pathlength
nanoCell

Calculation Factor
0.2 mm Pathlength
nanoCell

Reference

dsDNA ng/μL 50 500 2500 Maniatis, T; Fritch, E. F.; Sambrook, J., 
Molecular Cloning: A Laboratory Handbook, 
2nd Edition, Cold Spring Harbor Laboratory 
Press, Plainview, NY 1989, Vol. 3.

ssDNA ng/μL 37 370 3650

RNA ng/μL 40 400 2000

Oligos ng/μL 33 330 1650

Protein 280 nm mg/mL 1 10 50 Fasman, D. G., Ed. Practical Handbook of 
Biochemistry and Molecular Biology, CRC 
Press, Boston 1992.
Stoscheck, C. M., Methods Enzymol, 1990, 
182, 50-69.

Protein 205 nm mg/mL 31 310 1550

Assay Unit Equation
Factors
1.0 mm 
Pathlength

Calculation 
Factor
1.0 mm 
Pathlength 
nanoCell

Calculation 
Factor
0.2 mm 
Pathlength 
nanoCell

References

260/280

DNA/
Protein

μg/mL DNA and Protein Concentrations determined using:
DNA conc = [(A260 - Aref )f1 - (A230 - Aref )f2]
Protein conc = [(A230 - Aref )f3 - (A260 - Aref )f4]

260:280 Ratio = 

Where:
A260 = absorption at 260 nm
A280 = absorption at 280 nm
Aref = background absorption at 320 nm

f1 = 62.9
f2 = 36.0
f3 = 1,552
f4 = 757.3

f1 = 629
f2 = 360
f3 = 15,520
f4 = 7,573

f1 = 3,145
f2 = 1,800
f3 = 77,600
f4 = 37,865

Warburg, O.; 
Christian, W.
Biochem Z. 1942, 
310, 384-421.
Groves, W. E.; 
Davis, F. C., Jr.; 
Sells, B. H., Anal. 
Biochem. 1968, 22, 
195-210.

260/230

DNA/
Protein

(Phenol)

μg/mL DNA and Protein Concentrations determined using:
DNA conc = [(A260 - Aref )f1 - (A230 - Aref )f2]
Protein conc = [(A230 - Aref )f3 - (A260 - Aref )f4]

260:230 Ratio = 

Where:
A260 = absorption at 260 nm
A230 = absorption at 230 nm
Aref = background absorption at 320 nm

f1 = 49.1
f2 = 3.48
f3 = 183
f4 = 75.8

f1 = 491
f2 = 34.8
f3 = 1,830
f4 = 758

f1 = 12,300
f2 = 870
f3 = 45,750
f4 = 18,950

Kalb, V. F., Jr.; 
Bernlohr, R.W., 
Anal. Biochem. 
1977, 82, 362-371.

Warburg-
Christian

mg/mL Protein concentration is determined using:
Protein conc = [(A280 x f1) - (A260 x f2)]
Where:
A280 = absorption at 280 nm
A260 = absorption at 260 nm

1.55
0.76

15.5
7.6

3,875
1,900

Warburg, O.; 
Christian, W., 
Biochem Z. 1942, 
310, 384-421.

A260 Aref–
A280 Aref–
----------------------------

A260 Aref–
A230 Aref–
----------------------------
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Related Topics

Using the nanoCell

Cleaning the nanoCell

Storing the nanoCell

Frequently Asked Questions

Frequently Asked Questions

Frequently Asked Questions

Q1 My nanoCell has two numbers on the lid (Factor 50 and LP 0.2 mm). What do these 
numbers mean?

A1 Factor 50
This is the correction factor for this lid. If a 1 cm cuvette is used and equations are set 
up for a 1 cm pathlength, multiply the 1.0 mm pathlength result by this factor (1 cm 
result x 50, in this case) to get the correct concentration result. This is a factor of 50 
reduction, or 50-fold dilution. See Pathlength Correction Factors.
LP 0.2 mm (Light Path 0.2 mm)
This is the pathlength of the nanoCell or the total distance the light travels through 
the accessory. This distance is necessary for concentration calculations using the 
Beer-Lambert law, which relates the absorbance of the solution to its concentration. 
See Introduction to Small Volume Measurements and Pathlength Correction Factors.

Q2 When using the nanoCell, is the correction for the pathlength (0.2 mm or 1.0 mm) 
made automatically by the spectrophotometer, or does the end-user have to make this 
correction?

A2 No. There is no mechanism for the instrument to know what pathlength nanoCell is 
installed. The user will need to correct for the pathlength using the factor.

Q3 If the end-user has to make the correction, what is the correction for each nanoCell 
pathlength?

A3 See Pathlength Correction Factors for a comprehensive list of correction factors for 
most life science assays.

Q4 Does the quartz surface at the top of the nanoCell accessory and in the lid have to be 
cleaned of all chemicals and fingerprint residue?

A4 Yes. The quartz sample loading area of the nanoCell accessory and the mirror in the 
lid are the same as a traditional quartz cuvette. See Cleaning the nanoCell.



18 
nanoCell

290 Evolution 200 Series User Guide Thermo Scientific

Related Topics

Using the nanoCell

Cleaning the nanoCell

Storing the nanoCell

Pathlength Correction Factors

Q5 What needs to be cleaned after each use? The top of the nanoCell only, or the inner 
part of the lid as well?

A5 To eliminate sample carry-over or mixing two liquids together and improve accuracy, 
clean the inner part of the lid between measurements. See Cleaning the nanoCell.

Q6 Can I use solvents to clean the surface of the nanoCell? If so, which solvents?

A6 The most suitable solvents for cleaning are methanol, ethanol, and isopropanol. Do 
not use strong acids and bases or any of the following solvents with the nanoCell: 
ethylamine, diethylene triamine, methylene chloride, and phosphoric acid. See 
Cleaning the nanoCell.
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TPS-1500W Sealed Peltier Recirculator
The Peltier Recirculator is a sealed unit that can be used to pump temperature-controlled 
liquid through any thermostatted accessory. The recirculator provides constant temperatures 
in the range between 20 °C and 60 °C (68 °F and 140 °F). The unit comes with fuses, 
insulated tubing, tubing size adapters, a refill bottle and a USB cable.

Related Topics

Peltier Thermostatted Single Cell Holder

Contents

• General Safety Information

• Product Description

• Preinstallation

• Installation

• Operation

• Maintenance

• Troubleshooting

Peltier recirculator
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SPE-8W Smart Peltier Linear Cell Changer

Accessories

General Safety Information

This equipment has been designed with an emphasis on quality, reliability and safety. We 
accept warranty responsibility for this accessory under the following conditions:

• Electrical installation in the room or building complies with regulations specified in the 
country where the equipment is to be used.

• The equipment is used in accordance with the provided instructions for use.

• All modifications and repairs are carried out by an authorized agent.

• Only modifications suggested and documented by us are to be made to any part of the 
accessory.

• The equipment installation is carried out in accordance with local requirements for 
responsibility and warranty.

Related Topics

Product Description

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

CAUTION  Always disconnect the power supply before starting any work inside the instru-
ment.

CAUTION  Take the necessary precautions when using flammable or explosive substances 
in this accessory.
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Product Description

The recirculator is a Peltier-effect thermostatting system. It uses an internal sealed liquid 
circuit that is compatible with all of our thermostattable accessories.

The accessory features:

• Internal flow pump to circulate the liquid.

• Manual or remote control through an RS-232 or USB port.

• Thermally isolated tubing to connect with any thermostattable accessory.

• Water level sensor to prevent operation when the fluid level is below normal.

• High temperature sensor to prevent overheating.

Front and Back Panel

The accessory has two internal fans and front and back vents to dissipate heat.

The front panel features an LCD display with a three-button keypad.

The back panel houses the main power connector with voltage selector, RS-232 and USB 
connectors for remote control, main power switch and connectors for transporting liquid into 
and out of the unit.

Contents

• Front and Back Panel

• Specifications

NOTICE    Blocked vents may affect performance or cause the accessory to fail.
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Related Topics

Specifications

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Specifications

Contents
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Display/Keypad

The accessory has an LCD screen and 3-button keypad to access the functions and set 
temperature.

Programmable Parameters

• Temperature

Displayed Values

• Actual thermostat temperature

• Set temperature

• Heating/cooling power

Operating Specifications

• Temperature range: 20 °C to 60 °C (68 °F to 140 °F)

• Temperature accuracy: ±0.15 °C (±0.27 °F) from 20 °C to 60 °C (68 °F to 140 °F)

• Temperature repeatability: typically ±1 °C (1.8 °F)

• Temperature stability: typically ±0.1 °C (±0.18 °F)

• Specifications valid for ambient temperatures from 15 °C to 35 °C (59 °F to 95 °F)

External Control

• RS-232

• USB

• Display/Keypad

• Programmable Parameters

• Displayed Values

• Operating Specifications

• External Control

• Dimensions

• Electrical Data

• Description of Symbols

• Environmental Conditions
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Dimensions

• Width: 235 mm (9.25 in)

• Height: 254 mm (10 in)

• Depth: 473 mm (18.63 in)

• Weight: 11.6 kg (25.6 lbs)

Electrical Data

• Voltage: 115/120 V or 220/240 V ±10% (factory setting 220/240 V)

• Frequency: 50/60 Hz

• Power: 120 VA

• CE marked

Description of Symbols

Environmental Conditions

Performance and safety of the accessory are guaranteed if operated under the following 
conditions:

• Pollution degree 2 (standard CEI EN 61010-1).

• Installation category II with smaller transient over voltages (standard IEC 664).

• Mains voltage fluctuations must not exceed 10% of the nominal voltage.

• Location of use is indoors at an altitude <2000 m (6562 ft).

• Location of use exhibits a relative humidity <80% noncondensing.

• Location of use exhibits an ambient temperature between 10 °C and 35 °C (50 °F and 
95 °F).

• Location of use is free from dust and vapors of solvents and acids.

Related Topics

Front and Back Panel

General Safety Information

CAUTION  Symbol identifying the use of substances dangerous for health and the 
environment. For these substances, refer to the laws and terms in force for the laboratory 
using the instrument. Take the necessary precautions when using flammable or explosive 
substances.



 19 
TPS-1500W Sealed Peltier Recirculator

Thermo Scientific Evolution 200 Series User Guide 297

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Preinstallation

Review this section before installing the accessory.

Verifying the Power Supply and Fuse

For operation at 120 V, configure the voltage selector on the Peltier back panel and insert the 
correct fuse as described in the following table.

Adjustment for frequency change between 50 and 60 Hz is not necessary.

Contents

• Verifying the Power Supply and Fuse

• Changing the Voltage Setting or Fuse

NOTICE    The unit is factory set to operate at 220 V.

Power Supply Type of fuse - 250 V

240 V T 1A, Slo Blo

120 V T 2A, Slo Blo

Voltage display window

Fuse drawer tab
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Related Topics

Changing the Voltage Setting or Fuse

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Changing the Voltage Setting or Fuse

The current voltage setting is shown in the voltage display window above the power switch.

To change the voltage setting or fuse

5. Turn off the Peltier unit and disconnect the power cord from the wall outlet.

6. Use a small screwdriver to pry the fuse drawer out of the fuse compartment by pulling the 
tab up and away from the drawer.

7. To change the voltage setting, remove the voltage selector cube from the drawer and 
carefully remove the fuse from the cube.

8. Rotate the cube 180 degrees and then replace the cube in the drawer. The correct voltage 
setting should display in the window on the bottom of the fuse drawer.

Fuse drawer

Voltage selector cube
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9. Replace the fuse with a new one that is appropriate for the selected voltage. See Verifying 
the Power Supply and Fuse.

10. Slide the fuse drawer back into the fuse compartment until it locks in place.

11. Connect the power cord to the wall outlet.

12. Turn on the main power switch on the Peltier unit back panel.

If the unit does not perform normally or if the replacement fuse blows, contact technical 
support.

Related Topics

Verifying the Power Supply and Fuse

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Installation

Before powering on the Peltier recirculator:

• Check the power supply voltage setting and fuse. See Verifying the Power Supply and 
Fuse. 

• Connect the recirculator to a thermostatted accessory and fill the reservoir.

Before starting the recirculator, familiarize yourself with the software features described in 
Operation.

To install the recirculator

1. Position the recirculator in a suitable location.

NOTICE    The recirculator is filled with distilled water before shipment. During 
installation, when connecting the tubing, the water level in the reservoir will drop and 
must be refilled before use. Use only distilled water to refill the reservoir. A refill bottle is 
provided for this purpose. See Filling the Reservoir. 

NOTICE    Leave at least 5 cm (2 in) in front and back of the unit for air circulation.
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2. Remove the screw from the vent on the recirculator back panel. Store the screw in a safe 
place and use it to plug the vent before shipment.

3. Screw in the vent connector supplied with the instrument.

4. Close the vent by turning the control ring clockwise until it is tight.

5. Connect the supplied tubes to the Inlet and Outlet ports on the recirculator back panel.

The ports and tubes are equipped with quick connect fittings.

6. Connect the other ends of the tubes to the fluid in and out ports on any thermostatted 
accessory or to the fluid in and out ports on the spectrophotometer. See Installing a 
Liquid Thermostatted Accessory. Use the provided adapters if necessary.

7. Connect the power cord to the power connector on the recirculator back panel and turn 
on the power switch.

Remove and save this screw 
(replace for shipment)

Vent connector
Vent control ring
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Wait one minute for the recirculator to warm up. A water level alarm typically occurs 
because the tubing and reservoir in the thermostatted accessory have increased the 
capacity.

8. If a water level alarm occurs, turn off the recirculator, disconnect the inlet (or outlet) tube 
and fill the reservoir. See Filling the Reservoir.

9. Reconnect the tube and turn on the recirculator.

10. If a water level alarm occurs again, repeat steps 8 and 9.

The recirculator may be operated manually (see Operation) or remotely through an RS-232 
or USB connection.

Related Topics

General Safety Information

Product Description

Preinstallation

Operation

Maintenance

Troubleshooting

Operation

To start the recirculator, turn on the power switch on the back panel. The display appears in 
one of three modes:

• Stand-By mode

• Normal mode

Power switch
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• Alarm mode

The image below indicates Normal mode.

Standby Mode

• Press and hold the Center button for one to two seconds to proceed to Normal Mode.

Related Topics

Normal Mode

Set temperature

Actual thermostat 
temperature

Heating/cooling 
power scale

Table 1. Startup modes and overview of button functions

Page Mode Display Left button Center button Right button

Startup Standby Standby On (go to 
Normal Mode)

Normal Actual temperature

Set temperature

Heating/cooling power (right)

Menu (go to 
Main Menu 
page)

Off (go to 
Standby Mode)

Change (go to 
Change Set Point 
page)

Alarm Alarm description Menu (go to 
Main Menu 
page)

Beep (turn off 
audible alarm)

Reset* (reset audi-
ble alarm)

*Only if the Manual reset prealarm is set to Yes. See Parameters Menu.

Contents

• Standby Mode

• Normal Mode

• Alarm Mode
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Alarm Mode

Preinstallation

Installation

Maintenance

Troubleshooting

Normal Mode

Button Functions

• Press the left (Menu) button to go to the Main Menu page.

• Press and hold the center (Off ) button for one to two seconds to return to Stand-By 
Mode.

• Press the right (Change) button to go to the Change Set Point page.

Changing the set temperature

1. From the main Normal Mode page, press the Change button to highlight Set 
Temperature.

The Change Set Point page appears with down and up arrows above the Left and Center 
buttons.

2. Use the down and up arrow buttons to change the set temperature.

Contents

• Button Functions

• Parameters Menu

• Configure Menu

• Diagnostic Menu

Table 2. Normal Mode functions

Page Display Description Left button Center button Right button

Main Menu Parameter User Parameters Scroll Select Exit

Configure Configuration Parameters Scroll Up Exit

Diagnostic Diagnostic Values Down Up Exit

Change Set 
Point

Flashes selected 
parameter

Change Temperature Set Point Down Up Change



19 
TPS-1500W Sealed Peltier Recirculator

304 Evolution 200 Series User Guide Thermo Scientific

3. When the desired set temperature is displayed, press Change to return to the main 
Normal Mode page.

Parameters Menu

• From the main Normal Mode page, press the Menu button to display the Main Menu 
page.

• Use the left (Scroll) button to highlight Parameters and press the center (Select) button 
to select it. A list of available parameters appears.

• Use the left (Scroll) button to highlight a parameter.

• Use the center (Select) button to select the highlighted parameter.

• Use the right (Exit) button to return to the Parameters Menu.

Configure Menu

• From the main Normal Mode page, press the Menu button to display the Main Menu 
page.

• Use the left (Scroll) button to highlight Configure and press the center (Select) button to 
select it. A password entry page appears.

• Use the right (Exit) button to return to the main Normal Mode page.

Diagnostic Menu

• From the main Normal Mode page, press the Menu button to display the Main Menu 
page.

• Use the left (Scroll) button to highlight Diagnostics and press the center (Select) button 
to select it. A list of diagnostic readouts appears.

• Use the left and center buttons to scroll the screen up and down.

• Use the right (Exit) button to return to the main Normal Mode page.

Table 3. User parameters and button functions

Number Description Default value

P-01 Temperature units °C

P-02 Auto start NO

P-03 Display contrast 5

P-04 Beeper YES

P-05 Manual reset pre-alarm NO

NOTICE    A password is required to display the Configure menu. These parameters are set 
at the factory and cannot be changed by the user.
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Related Topics

Standby Mode

Alarm Mode

Preinstallation

Installation

Maintenance

Troubleshooting

Alarm Mode

System alarms indicate failure of the accessory due to malfunction or incorrect use. See 
Troubleshooting for more information. Here is an alarm mode due to water failure.

• Use the left (Menu) button to display the Main Menu page.

• Use the center (Beep) button to turn off the audible alarm.

• Use the right (Reset) button, if available, to reset the audible alarm. See Manual reset 
prealarm in the Parameters Menu to configure the Reset option to display in Alarm 
Mode.

Description Unit

Cell temperature °C

Radiator temperature °C

Water resistance Kohm

Power %

Cell voltage Volt
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Related Topics

Standby Mode

Normal Mode

Preinstallation

Installation

Maintenance

Troubleshooting

Maintenance

Routine Maintenance

The accessory requires little routine maintenance.

Related Topics

Cleaning the Accessory

Filling the Reservoir

Preinstallation

Installation

Operation

Troubleshooting

Cleaning the Accessory

To clean the accessory, use a cloth dampened with water or neutral detergent only. Do not use 
organic or abrasive solvents.

Contents

• Routine Maintenance

• Cleaning the Accessory

• Filling the Reservoir

CAUTION  Do not open the unit while the power cord is connected. Any action that 
makes it necessary to open the unit must be executed by authorized service personnel.
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Related Topics

Routine Maintenance

Filling the Reservoir

Preinstallation

Installation

Operation

Troubleshooting

Filling the Reservoir

Fill the reservoir after connecting an accessory to the recirculator and after a water level alarm. 
Use distilled water only.

To fill the reservoir

1. Open the vent by turning the control ring counterclockwise. Place a container under the 
vent opening to catch drips.

2. Fill the supplied bottle with distilled water.

The bottle lid has a tube with a quick connect fitting.

Vent control ring
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3. Turn off the power switch on the recirculator back panel.

4. Unplug any tubing from the inlet connector on the recirculator back panel and connect 
the tube from the fill bottle.

5. Turn the fill bottle upside down and squeeze it until liquid escapes through the vent.

The reservoir holds approximately 150 mls.

6. Disconnect the fill bottle and reconnect the tubing.

7. Turn on the recirculator power switch.

8. If a water level alarm occurs, turn off the recirculator and repeat steps 3 through 7.

9. If the water level is okay, open the vent to evacuate any air bubbles in the lines.

10. Close the vent.

Leave the vent closed while the recirculator is in use.

Related Topics

Routine Maintenance

Cleaning the Accessory

Preinstallation

Installation

Operation

Troubleshooting

Troubleshooting

System alarms indicate failure of the accessory due to malfunction or incorrect use. Alarms 
may be visible on the display, indicated acoustically or communicated via RS-232 or USB 
connections.

Acoustic Alarm

The accessory sends an acoustic alarm when it detects a leak or if another failure occurs.

Contents

• Acoustic Alarm

• Water Level Failure

• Other System Failures
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If an alarm occurs

1. Determine the cause of the alarm by consulting the recirculator front panel display.

2. Press the right (Reset) button, if available, on the recirculator front panel.

See Manual reset prealarm in the Parameters Menu to configure the Reset option to 
display in Alarm Mode.

3. Turn off the power switch on the recirculator back panel.

4. Fix the problem. See Water Level Failure and Other System Failures.

5. Turn on the recirculator power switch.

6. If the alarm occurs again, turn off the power switch and contact technical support. See 
Contacting Us.

Related Topics

Water Level Failure

Other System Failures

Preinstallation

Installation

Operation

Maintenance

Water Level Failure

The accessory is equipped with a water level sensor that detects small leaks.

If a water level failure occurs

1. Press the Reset button, if available, on the recirculator front panel.

See Manual reset prealarm in the Parameters Menu to configure the Reset option to 
display in Alarm Mode.

2. Turn off the power switch on the recirculator back panel.

3. Open the sample compartment and clean up any liquids that may have leaked from the 
accessory. 

4. Tighten all connectors to and from the recirculator.

5. Fill the reservoir. See Filling the Reservoir.

6. Turn on the recirculator power switch.
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7. If the water level alarm occurs again, turn off the power switch, fill the reservoir again and 
turn on the power switch.

Related Topics

Acoustic Alarm

Other System Failures

Preinstallation

Installation

Operation

Maintenance

Other System Failures

Related Topics

Acoustic Alarm

Water Level Failure

Preinstallation

Installation

Operation

Maintenance

Note  You may need to fill the reservoir several times before the water level alarm resets.

Problem Possible Cause Solution

Temperature or 
memory failure

Recirculator 
malfunction or 
incorrect use

Immediately turn off the main power switch 
and then turn it on again. If the failure 
reoccurs, turn off the power and contact 
technical support. See Contacting Us.
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Peltier Thermostatted Single Cell Holder
This accessory includes a thermostatted single cell holder for standard 10 mm pathlength 
cuvettes and a Peltier temperature controller that connects to a USB port on the 
spectrophotometer or computer. The accessory requires a water pump or recirculator which 
must be purchased separately. Cell temperature can be controlled two ways: from the Peltier 
controller front panel or from the spectrophotometer using INSIGHT software. The Peltier 
controller may also be used to agitate the sample by placing a magnetic stirrer in the cuvette 
and selecting the stir speed.

Related Topics

TPS-1500W Sealed Peltier Recirculator

Contents

• General Safety Information

• Product Description

• Preinstallation

• Installation

• Operation

• Maintenance

• Troubleshooting

Cell holder

Controller
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SPE-8W Smart Peltier Linear Cell Changer

Accessories

General Safety Information

This equipment has been designed with an emphasis on quality, reliability and safety. We 
accept warranty responsibility for this accessory under the following conditions:

• Electrical installation in the room or building complies with regulations specified in the 
country where the equipment is to be used.

• The equipment is used in accordance with the provided instructions for use.

• All modifications and repairs are carried out by an authorized agent.

• Only modifications suggested and documented by us are to be made to any part of the 
accessory.

• The equipment installation is carried out in accordance with local requirements for 
responsibility and warranty.

Related Topics

Product Description

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

CAUTION  Always disconnect the power supply before starting any work inside the instru-
ment.

CAUTION  Take the necessary precautions when using flammable or explosive substances 
in this accessory.
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Product Description

The Peltier Single Cell Holder delivers precise temperature control in a compact design. The 
accessory permits spectrophotometric measurements at controlled temperatures between 0 °C 
and 100 °C (32 °F and 212 °F). Measurements can be made at constant temperatures.

Related Topics

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Temperature Controller Front and Rear Panels

The controller front panel features an LCD display with a three-button keypad.

The rear panel houses the main power connection with voltage selector, RS-232 and USB 
connectors for remote control, main power switch and cell holder connector.

Contents

• Temperature Controller Front and Rear Panels

• Specifications
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Related Topics

Specifications

Specifications

This section describes the specifications for the Peltier temperature controller.

Display/Keypad

The controller has an LCD screen and 3-button keypad to access the functions and set sample 
temperature and stirring rate. See Operation for details.

Programmable Parameters

• Temperature

Contents

• Display/Keypad

• Programmable Parameters

• Displayed Values

• Operating Specifications

• External Control

• Dimensions

• Electrical Data

• Description of Symbols

• Environmental Conditions
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• Stirring speed

Displayed Values

• Peltier block temperature

• Set temperature

• Stirring speed

• Heating/cooling power

Operating Specifications

• Stirring speed 0 to 1800 rpm

• Temperature range: 0 °C to 100 °C (32 °F to 212 °F)

• Temperature accuracy: ±0.15 °C (±0.27 °F) from 0 °C to 100 °C (32 °F to 212 °F)

• Temperature repeatability: typically ±0.1 °C (±0.18 °F)

• Temperature stability: typically ±0.1 °C (±0.18 °F)

• Specifications valid for ambient temperatures of 15 °C to 35 °C (59 °F to 95 °F)

External Control

• RS-232

• USB

Dimensions

• Width: 213 mm (8.3 in)

• Height: 178 mm (7 in)

• Depth: 269 mm (10.6 in)

• Weight: 3 kg (8 lbs)

Electrical Data

• Voltage: 115/120 V or 220/240 V ±10%

• Frequency: 50/60 Hz

• Power: 80 VA

• CE marked
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Description of Symbols

Environmental Conditions

Performance and safety of the accessory are guaranteed if operated under the following 
conditions:

• Pollution degree 2 (standard CEI EN 61010-1).

• Installation category II with smaller transient over voltages (standard IEC 664).

• Mains voltage fluctuations must not exceed 10% of the nominal voltage.

• Location of use is indoors at an altitude <2000 m (6562 ft).

• Location of use exhibits a relative humidity <80% noncondensing.

• Location of use exhibits an ambient temperature between 10 °C and 35 °C (50 °F and 
95 °F).

• Location of use is free from dust and vapors of solvents and acids.

Related Topics

Temperature Controller Front and Rear Panels

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Preinstallation

Review this section before installing the accessory.

CAUTION  Symbol identifies the use of substances dangerous for health and the 
environment. For these substances, refer to the laws and terms in force for the laboratory 
using the instrument. Take the necessary precautions when using flammable or explosive 
substances.

Contents
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Verifying the Power Supply and Fuse

For operation at 120 V, configure the voltage selector on the Peltier back panel and insert the 
correct fuse as described in the following table.

Adjustment for frequency change between 50 and 60 Hz is not necessary.

Related Topics

Changing the Voltage Setting or Fuse

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

• Verifying the Power Supply and Fuse

• Changing the Voltage Setting or Fuse

NOTICE    The unit is factory set to operate at 220 V.

Power Supply Type of fuse - 250 V

240 V T 1A, Slo Blo

120 V T 2A, Slo Blo

Voltage display window

Fuse drawer tab
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Changing the Voltage Setting or Fuse

The current voltage setting is shown in the voltage display window above the power switch.

To change the voltage setting or fuse

8. Turn off the Peltier unit and disconnect the power cord from the wall outlet.

9. Use a small screwdriver to pry the fuse drawer out of the fuse compartment by pulling the 
tab up and away from the drawer.

10. To change the voltage setting, remove the voltage selector cube from the drawer and 
carefully remove the fuse from the cube.

11. Rotate the cube 180 degrees and then replace the cube in the drawer. The correct voltage 
setting should display in the window on the bottom of the fuse drawer.

12. Replace the fuse with a new one that is appropriate for the selected voltage. See Verifying 
the Power Supply and Fuse.

13. Slide the fuse drawer back into the fuse compartment until it locks in place.

14. Connect the power cord to the wall outlet.

15. Turn on the main power switch on the Peltier unit back panel.

If the unit does not perform normally or if the replacement fuse blows, contact technical 
support.

Related Topics

Verifying the Power Supply and Fuse

General Safety Information

Fuse drawer

Voltage selector cube
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Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Installation

It is necessary to connect the cell holder to a water pump or fluid recirculator and to the 
temperature controller.
.

Use only 12.5 mm (10 mm pathlength) square cuvettes with this accessory. Use at least 3 ml 
of solution for the analysis.

Before starting the Peltier accessory, familiarize yourself with the software features described in 
Operation. To agitate the sample during the measurement, place a magnetic stirrer in the 
cuvette and use the software to set the stirring speed.

To install the cell holder

1. Open the sample compartment cover.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Remove the tubing access panel. See Tubing Access Panel.

4. Remove any existing cell holder or accessory.

5. Connect one end of the provided flat cable to the cell holder.

NOTICE    Avoid damage to the cell block. Do not operate the accessory without a water 
pump or fluid recirculator.

NOTICE    Avoid damage to the electronics. Do not connect or disconnect cables while the 
accessory is powered on.
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6. Install the cell holder in the spectrophotometer sample compartment. See Installing a 
Manual Accessory.

7. Feed the other end of the cable through the opening behind the tubing access panel. See 
Tubing Access Panel.

8. Connect the free end of the cable to the Cell Holder socket on the back of the 
temperature controller.

9. Use appropriate tubing and the provided adapters to connect the two fluid ports on the 
cell holder to a water pump or fluid recirculator. See Installing a Liquid Thermostatted 
Accessory.

Ensure the tubing does not obstruct the light beam.

Cell Holder

Cable
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10. Replace the sample compartment front panel. See Sample Compartment Front Panel.

11. Close the sample compartment cover.

12. Turn on the power switch on the controller back panel.

13. Press and hold the On (center) button on the temperature controller for 2 seconds.

The Normal Mode display shows the current temperature settings.

14. Set the software parameters to configure the temperature controller for operation. See 
Operation.

Related Topics

General Safety Information

Product Description

Preinstallation

Operation

Maintenance

Troubleshooting

Operation

Water
ports

Contents

• Setting the Target Temperature and Stir Speed

• Measuring Samples
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Setting the Target Temperature and Stir Speed

INSIGHT software can be used to define a target temperature and display a temperature 
status monitor. A target temperature can also be set from the temperature controller front 
panel.

Related Topics

Using the Peltier Controller to Set Temperature and Stir Speed

Measuring Samples

Using INSIGHT Software to Set Temperature and Stir Speed

Temperature and Stir Speed Settings

In the selected application, use Settings > Accessories > Temperature to display the available 
settings for a temperature probe or controller. The Temperature features appear only when the 
driver for a temperature probe or controller is installed.

Contents

• Using INSIGHT Software to Set Temperature and Stir Speed

• Using the Peltier Controller to Set Temperature and Stir Speed

Contents

• Temperature and Stir Speed Settings

• Configuring a Target Temperature

• Displaying the Temperature Status Monitor

Feature Description

Record temperature with mea-
surement

If a temperature probe is used, records the temperature of 
the sample after each measurement. Temperature readings 
are stored in the sample properties.

Use temperature controller If a Peltier cell holder or changer is used, defines a setpoint 
temperature for the cell block and a stir speed if desired. 
The available settings depend on the specifications for the 
temperature-controlled accessory.
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Related Topics

Configuring a Target Temperature

Displaying the Temperature Status Monitor

Configuring a Target Temperature

To configure a target temperature

1. Select Start measurement at target temperature.

2. Enter the Target temperature and Tolerance in °C.

• For a temperature probe. 
To start the measurement when the probe reaches the target temperature, set Start on 
to Probe temperature and then select the Probe channel. The number of channels 
in the list box will match the available ports on the temperature probe interface box.

The probe channel, current temperature and target range appear during the 
measurement.

• For a temperature-controlled accessory. 
To start the measurement when the cell block reaches the target temperature, set 
Start on to Block temperature.

Start measurements at target 
temperature

Starts the measurement when the sample (requires a tem-
perature probe) or cell block (requires a Peltier cell holder 
or changer) reaches a specified temperature.

Match probes to cell changer 
positions

If a temperature probe is used, maps probe channels 1 
through 8 with up to eight cell changer positions. Useful 
only when using an automatic cell changer with multiple 
temperature probes.

Deselect this to always record the temperature of probe 1.

Feature Description
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Only the current temperature and target range appear during the measurement.

The Start button is disabled since the measurement is configured to start automatically at 
the target temperature.

3. To allow time for equilibration, select Wait for equilibration and enter the duration.

The remaining equilibration time is displayed during the measurement.

If the temperature moves outside the target range, the countdown resets when the 
temperature is again within range.

The Start button becomes active when the temperature remains in the target range for the 
entire equilibration period.

4. To start the measurement automatically after equilibration, select Start measurement 
after equilibration. This disables the Start button in the status dialog box. The 
measurement starts automatically when the temperature remains in the target range 
during the entire equilibration period.

Related Topics

Temperature and Stir Speed Settings

Displaying the Temperature Status Monitor

Displaying the Temperature Status Monitor

When a Peltier temperature-controlled accessory is installed, the INSIGHT software can be 
configured to display a temperature status monitor above the data display.

To display the temperature status monitor

1. Click the Configure button above the data display for the selected application. See 
Instrument Status Monitors for more information.

A dialog box lists the available status monitors.
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2. Select Temperature controller status and click OK.

The status monitor appears above the data display.

Related Topics

Temperature and Stir Speed Settings

Configuring a Target Temperature

Using the Peltier Controller to Set Temperature and Stir Speed

To start the controller, turn on the power switch on the controller back panel.

Startup Mode

After the controller power is turned on, the display appears in one of three modes: Stand-By, 
Normal, or Alarm. The image below indicates Normal mode.

Note  The temperature controller option appears only when a temperature controller 
software driver is installed.

Contents

• Startup Mode

• Standby Mode

• Normal Mode

Actual block 
temperature

Stirring 
speed

Heating/cooling 
power scale

Block set temperature
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Standby Mode

• Press and hold the Center button for one to two seconds to proceed to Normal Mode.

Normal Mode

Button Functions

• Press the Left button to go to the Main Menu page.

• Press the Right button to go to the Change Set Point page.

• Press and hold the Center button for one to two seconds to return to Stand-By Mode.

• From the Startup page in Normal Mode, use the Change button to move about the 
screen.

Changing the set temperature

1. Highlight Set Temperature.

The Change Set Point page is displayed with down and up arrows above the Left and 
Center buttons.

Table 4. Startup modes and button functions

Page Mode Display Left button Center button Right button

Startup Standby Standby On

Normal Actual block temperature

Block Set temperature

Stirring speed (left)

Heating/cooling power (right)

Menu 

(Go to Main 
Menu)

Off Change (Go to 
Change Set Point 
Page)

Alarm Alarm description Menu Beep on/off Reset alarm/change*

*Only if the manual alarm reset option has been configured

Table 5. Normal Mode functions

Page Display Description Left button Center button Right button

Change Set 
Point

Flashing selected 
parameter

Change Temperature or 
Stirring Speed Set Point

Down Up Change

Main Menu Parameter User Parameters Scroll Select Exit

Configure Configuration Parameters Scroll Up Exit

Diagnostic Diagnostic Values Down Up Exit
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2. Use the down and up arrow buttons to change the set temperature.

3. When the desired set temperature is displayed, press Change to return to the Startup 
page.

Setting the stirring speed

1. Highlight Stirring Speed.

2. The Change Set Point page is displayed with down and up arrows above the Left and 
Center buttons. 

3. Use the down and up arrow buttons to change the stirring speed.

4. When the desired stirring speed is reached, press Change to return to the Startup page.

Parameters Menu

• Use the Left and Center buttons to scroll the screen up and down.

• Use the Right button to exit the screen and return to the Main Menu.

Configure Menu

Diagnostic Menu

• Use the Left and Center buttons to scroll the screen up and down.

• Use the Right button to exit the screen and return to the Main Menu.

Table 6. User parameters and button functions

Number Description Default value

P-01 Temperature units °C

P-02 Auto start NO

P-03 Display contrast 5

P-04 Beeper YES

P-05 Manual reset pre-alarm NO

Note  A password is required to enter this menu.

NOTICE    The Configure menu parameters are set at the factory and cannot be changed 
by the user.

Description Measure unit

Cell temperature °C

Radiator temperature °C
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Measuring Samples

Use INSIGHT software to measure samples with this accessory. See INSIGHT Software.

Related Topics

Using INSIGHT Software to Set Temperature and Stir Speed

Using the Peltier Controller to Set Temperature and Stir Speed

Maintenance

Routine Maintenance

The accessory requires little routine maintenance.

Related Topics

Cleaning the Accessory

Preinstallation

Installation

Operation

Troubleshooting

Cleaning the Accessory

To clean the accessory, use a cloth dampened with water or neutral detergent only. Do not use 
organic or abrasive solvents.

Water resistance Kohm

Power %

Cell voltage Volt

Description Measure unit

Contents

• Routine Maintenance

• Cleaning the Accessory

CAUTION  Do not open the unit while the power cord is connected. Any action that 
makes it necessary to open the unit must be executed by authorized service personnel.
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Related Topics

Routine Maintenance

Preinstallation

Installation

Operation

Troubleshooting

Troubleshooting

Related Topics

General Safety Information

Product Description

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Problem Possible Cause Solution

Temperature or 
memory failure

• Temperature 
controller 
malfunction or 
incorrect use

NOTICE    Immediately turn off the main 
power switch and then turn it on again. If 
the failure reoccurs, turn off the power and 
contact technical support. See Contacting 
Us.
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Probe Handling and Maintenance
This section provides general information for fiber optic probes including:

Safety Considerations

To avoid injury while using cables and probes, do not stare at the UV beam or UV light 
leaving a coupled fiber optic cable.

Related Topics

Operating Precautions

Installation

Operation

Maintenance

Operating Precautions

Handle probes carefully:

• Do not allow hard materials (glass, metal, ceramic, etc.) to contact the probe’s optical 
surfaces.

• Do not drop the probe or knock it against a hard surface.

• Do not subject the probe to rapid or excessive changes in temperature.

• Wipe off spilled chemicals immediately.

Contents

• Safety Considerations

• Operating Precautions

• Installation

• Operation

• Maintenance
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Handle fiber optic cables gently and follow these precautions:

• Do not drop the cables or knock them against a hard surface.

• Do not bend the cables or tightly coil them.

• Do not touch the end of a fiber optic cable connector.

• Do not overtighten or use tools to tighten the connectors when attaching the cables to the 
ports.

• Avoid twisting the cables when attaching them to the connectors.

• Keep a protective cap on each end of the cable when not in use.

Related Topics

Safety Considerations

Installation

Operation

Maintenance

Installation

Install the Integrated Fiber Optic Module before installing a probe.

Languages

WARNING  Avoid UV radiation hazard. Do not stare at the beam or light leaving a 
coupled fiber optic cable.

AVERTISSEMENT  Évitez l'exposition au rayonnements UV.  Ne regardez jamais le 
faisceau de lumière qui sort d’une fibre optique couplé.

WARNUNG  Gefahren durch UV-Strahlung sind zu vermeiden. Nicht in den Strahl eines 
gekoppelten Glasfaserkabels blicken.
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To install a probe, follow instructions for your instrument. See Attaching Cables and Probes.

If the probe has a remote start cable, plug the connector into the Trigger port on the 
spectrophotometer. See Connectors.

Related Topics

Safety Considerations

Operating Precautions

Operation

Maintenance

Operation

Follow the probe manufacturer’s recommendations for compatible samples and operating 
procedures.

Related Topics

Safety Considerations

Operating Precautions

AVVERTENZA  Evitare il rischio di radiazioni UV.Non fissare il raggio di luce che esce dal 
cavo a fibre ottiche accoppiato.

ADVERTENCIA  Evite el riesgo de radiación ultravioleta.No mire al rayo luminoso que sale 
de un cable de fibra óptica acoplado.

WARNING  

NOTICE    When attaching fiber optic cables to the accessory ports, avoid:

• Twisting or bending the cable.

• Touching the tips with your fingers.

• Overtightening or using tools to tighten the connectors.
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Installation

Maintenance

Maintenance

Routine Maintenance

Follow these guidelines:

• Clean probes immediately after each measurement and before storing them. Refer to the 
cleaning instructions that came with the probe or, if you purchased the probe from us, 
follow these steps.

• Follow the manufacturer’s recommendations for probe maintenance. (Check seals and 
O-rings regularly for excessive wear, especially from corrosive samples or extreme 
temperatures).

Related Topics

Safety Considerations

Operating Precautions

Installation

Operation

Cleaning Probes

Troubleshooting

Cleaning Probes

Clean probes immediately after each measurement and before storing them.

Follow these instructions to clean a probe purchased from us. For recommended agents and 
procedures to clean other probes, refer to the manufacturer’s instructions.

Contents

• Routine Maintenance

• Cleaning Probes

NOTICE    

• Do not use an ultrasonic bath to clean fiber optic probes.

• Use only recommended cleaning agents.
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To clean a probe purchased from us

1. Dampen lens paper or a soft cotton swab with one of the following agents:

• Methanol

• Isopropyl alcohol

• Deionized water (can leave spots that affect performance).

2. Using minimal pressure, wipe the probe optics and shaft with the dampened lens paper or 
swab.

To remove stubborn materials, use a small amount of acetone.

Related Topics

Safety Considerations

Operating Precautions

Installation

Operation

Routine Maintenance

Troubleshooting

NOTICE    Do not soak the lens paper or swab with the cleaning agent. This may leave 
pools of liquid that do not dry properly.
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Rapid Mix Accessory
For Local Control instruments:

D://2606_APPL PHOTOPHYSICS_Stop Flow Accy_UG.pdfFor Computer Control 
instruments:

C://2606_APPL PHOTOPHYSICS_Stop Flow Accy_UG.pdfIf these links do not work, see 
your documentation CD.

Related Topics

Installing a Manual Accessory

Accessories
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Reference Cell Holders
This section describes the reference cell holders available for your spectrophotometer. See 
Installing a Reference Cell Holder.

Rectangular Reference Cell Holder

This holder accommodates rectangular reference cells with the following pathlengths: 10 mm, 
20 mm, 40 mm, 50 mm and 100 mm. This is the standard reference cell holder provided 
with your spectrophotometer.

Related Topics

Installing a Reference Cell Holder

Sample Position Cell Holders

Cylindrical Reference Cell Holder

Cylindrical Reference Cell Holder

This holder fits cylindrical cells with the following pathlengths: 10 mm, 20 mm, 50 mm and 
100 mm.

Contents

• Rectangular Reference Cell Holder

• Cylindrical Reference Cell Holder
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Related Topics

Installing a Reference Cell Holder

Sample Position Cell Holders

Rectangular Reference Cell Holder
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Sample Position Cell Holders
This section describes cell holders that can be used in the sample position of your 
spectrophotometer. See Installing a Manual Accessory and Installing a Liquid Thermostatted 
Accessory for installation instructions.

10 mm Rectangular Cell Holder

This single-cell holder is mounted on the standard baseplate and accommodates standard 
10 mm pathlength cells.

Use the cell lifter to raise the cell for easy removal. This cell holder allows fine adjustment of 
the vertical and horizontal position of the cell. This feature is useful for aligning reduced 
volume and microcuvettes with the light beam.

Contents

• 10 mm Rectangular Cell Holder

• Water Thermostatted 10 mm Rectangular Cell Holder

• Cell Holder for 15 mm Beam Height Cells

• Cylindrical Cell Holder

• Solid Sample Holders

• Universal Sample Holder Slide

• Rotatable Test Tube and Cell Holder

• Sample Holder for 1-Inch Square Cells

• Sample Holder for Small Test Tubes and Vials

• Variable Pathlength Rectangular Cell Holder

• Variable Pathlength Cell Holder Slide



24 
Sample Position Cell Holders

342 Evolution 200 Series User Guide Thermo Scientific

Related Topics

Installing a Manual Accessory

Reference Cell Holders

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Water Thermostatted 10 mm Rectangular Cell Holder

This is a temperature-controllable version of the rectangular cell holder. Fluids can be 
circulated through chambers in the cell holder block, allowing temperature-controlled 
measurements in the range between 5 °C and 95 °C (see Installing a Liquid Thermostatted 
Accessory). Two ports are provided to connect the cell holder to a recirculating liquid 
temperature control device. The connectors accept 1/4-inch internal diameter tubing.

Cell lifter and vertical alignment
Horizontal alignment
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Cell Holder for 15 mm Beam Height Cells

This cell holder accommodates 10 mm pathlength cells designed for instruments with a 
15 mm z-height. The holder positions a 15 mm z-height cell properly for use with your 
spectrophotometer.

Cell lifter and vertical alignment
Horizontal alignment Fluid in/out ports
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Cylindrical Cell Holder

This accessory accommodates cylindrical cells with a 22 mm external diameter and a 
pathlength of up to 100 mm. A flexible clip holds the cell in place.
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Solid Sample Holders

There are two types of solid sample holders, fixed position and variable position. These 
holders support slides and sample mounting accessories that conform to industry standard 
dimensions.

The fixed position Sample Slide Holder offers two positioning options, left (detector) side and 
right (monochromator) side.

Height Width Thickness

50.8 mm (2 inches) 76.2 mm (3 inches) 2 mm (1/16 inch)
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The variable position Sample Slide Holder comes with one slide holder that can be adjusted 
along a slide-rail from the extreme detector side of the sample compartment to within 3 cm of 
the monochromator side. For applications requiring more than one mounting slide, right and 
left slide holders are available.

• The right side slide holder can be positioned anywhere along the beam from the extreme 
right (monochromator) side of the sample compartment to within 3 cm of the left 
(detector) side.

• The left side slide holder is identical to the slide holder supplied with the baseplate.
s

Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Right (monochromator) 
side slide holder

Left (detector) side 
slide holder
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Universal Sample Holder Slide

This accessory accommodates custom samples and requires a variable position Solid Sample 
Holder.

Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Rotatable Test Tube and Cell Holder

This sample holder accommodates test tubes up to 1-inch in diameter and 5 inches high or a 
standard 10 mm pathlength cell. The base can be rotated to properly position the cell or test 
tube at the center of the sample compartment. The clip can also be used to secure filters, thin 
films and other solid samples in the light beam.

Universal sample holder slide

Variable position 
sample slide holder
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Sample Holder for 1-Inch Square Cells

This sample holder accommodates cells that are 1-inch square such as Hach® cells and 
AccuVac® vials.
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Sample Holder for Small Test Tubes and Vials

This accessory can be used with test tubes and vials from 10 mm to 16 mm in diameter and 
up to 100 mm high.

NOTICE    Exceeding the recommended diameter will cause the retaining clip to block the 
light beam.
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Variable Pathlength Rectangular Cell Holder

Variable Pathlength Cell Holder Slide

Variable Pathlength Rectangular Cell Holder

This accessory accommodates rectangular cells with pathlengths ranging from 1 mm to 
100 mm.

Use the knob to adjust the accessory to accommodate your cell.

NOTICE    Overtightening the accessory may damage or break the cell.



 24 
Sample Position Cell Holders

Thermo Scientific Evolution 200 Series User Guide 351

Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Cell Holder Slide

Variable Pathlength Cell Holder Slide

This accessory accommodates rectangular cells with pathlengths ranging from 1 mm to 
50 mm and requires a variable position Solid Sample Holder).

Knob
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Related Topics

Installing a Manual Accessory

Reference Cell Holders

10 mm Rectangular Cell Holder

Water Thermostatted 10 mm Rectangular Cell Holder

Cell Holder for 15 mm Beam Height Cells

Cylindrical Cell Holder

Solid Sample Holders

Universal Sample Holder Slide

Rotatable Test Tube and Cell Holder

Sample Holder for 1-Inch Square Cells

Sample Holder for Small Test Tubes and Vials

Variable Pathlength Rectangular Cell Holder

Variable pathlength cell holder slide

Variable position 
sample slide holder
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Smart Linear 8-Cell Changer
The Linear Cell Changer allows automated measurements with up to eight cells. The 
accessory is mounted on our Smart Accessory base and accommodates 10 mm pathlength 
cuvettes. Purchase cells separately.

The unit can be used with a fluid recirculator or other device to control sample temperature 
and is compatible with our temperature probes.

Related Topics

SPE-8W Smart Peltier Linear Cell Changer

Smart Rotary Cell Changer

Accessories

Contents

• Safety Considerations

• Operating Precautions

• Installation

• Operation

• Maintenance

• Troubleshooting

8-cell holder

Smart Accessory base
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Safety Considerations

To avoid injury while using the accessory, keep hands and objects clear of the cell holder when 
calibrating, initializing or measuring samples with the cell changer.

Related Topics

Operating Precautions

Installation

Operation

Maintenance

Troubleshooting

Operating Precautions

Handle the accessory carefully:

• Secure any tubing to avoid blocking the light beam (move the cell holder through all 
possible positions).

• Do not allow moisture to leak into the accessory.

• Wipe off spilled chemicals immediately.

• Do not drop the accessory.

• Protect the accessory from mechanical shock.

Related Topics

Safety Considerations

Installation

Operation

Maintenance

Troubleshooting

Installation

Contents

• Installing a Smart Cell Changer

• Replacing the Cell Holder
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Related Topics

Safety Considerations

Operating Precautions

Operation

Maintenance

Troubleshooting

Installing a Smart Cell Changer

It is not necessary to power off the instrument while installing or removing a Smart Accessory.

To install a cell changer

1. Open the sample compartment door.

2. Remove the sample compartment front panel.

3. Remove any existing cell holder or accessory.

4. Install the accessory.

The software displays a prompt to initialize the accessory.

Languages

Note  The Smart Rotary Cell Changer and the Smart Linear Cell Changer cannot be used 
at the same time for double-beam instruments.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, 
à l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano 
dall’accessorio durante l’inizializzazione.
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5. Replace the sample compartment front panel.

6. Close the sample compartment door.

7. Click OK to initialize the accessory.

Initialization reads information about the accessory and moves it to position 1.

8. To use a temperature probe with the cell changer, see “Temperature Probe”.

9. To connect a fluid recirculator or other device to control sample temperature on a 
thermostatted cell changer, see “Installing a Thermostatted Accessory.”

10. Calibrate the cell changer (linear cell changers only) and set the software parameters to 
display the cell changer status monitor and configure the accessory for operation.

Related Topics

Opening and Closing the Sample and Reference Compartment Doors

Removable Panels

Installing a Smart Accessory

Installing a Liquid Thermostatted Accessory

Temperature Probe

Replacing the Cell Holder

Calibrating the Cell Changer

Cell Changer Settings

Displaying the Cell Changer Status Monitor

Installation

Replacing the Cell Holder

To remove the cell holder

1. Loosen the two locking screws.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del 
alcance del accesorio durante la inicialización.
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2. Lift the cell holder off the base.

To install the cell holder

1. Line up the cell holder with the two alignment pins on the cell changer base.

2. Hand tighten the two locking screws.

3. Initialize the accessory. See Initializing the Cell Changer.

Related Topics

Installing a Smart Cell Changer

Installation

Operation

Related Topics

Safety Considerations

Operating Precautions

Locking screw

Locking screw
Cell holder

Base

Contents

• Calibrating the Cell Changer

• Initializing the Cell Changer

• Cell Changer Settings

• Measuring Samples with the Cell Changer

• Displaying the Cell Changer Status Monitor
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Installation

Maintenance

Troubleshooting

Calibrating the Cell Changer

The linear cell changer must be calibrated the first time it is installed in a spectrophotometer. 
Calibration aligns each cell with the light beam. This is especially important when using 
microcells with the cell changer. The calibration settings are stored in the instrument.

Languages

To calibrate the linear cell changer

1. In INSIGHT software choose System Settings > Calibrations.

2. In the Linear Cell Changer group, click Calibrate.

A status box shows several intensity values collected on each side of the expected best 
location for each cell. The average of the highest readings is stored for each cell.

A message box appears when calibration is completed.

3. Click OK.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during oper-
ation.

Remarque  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

Anmerkung  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten

N.B.  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

Nota  Evite riesgos de atrapamiento.Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.

CAUTION  
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Related Topics

Initializing the Cell Changer

Cell Changer Settings

Measuring Samples with the Cell Changer

Displaying the Cell Changer Status Monitor

Operation

Initializing the Cell Changer

The accessory must be initialized each time it is installed and after changing the cell holder 
when the Smart base unit is installed. Initializing verifies the cell position and resets the cell 
holder to position 1.

Languages

To initialize a cell changer

1. In the selected application, choose Settings > Accessories > Cell Changer.

2. Click Reset.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, à 
l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano dall’accessorio 
durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del alcance 
del accesorio durante la inicialización.
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Related Topics

Calibrating the Cell Changer

Cell Changer Settings

Measuring Samples with the Cell Changer

Displaying the Cell Changer Status Monitor

Operation

Cell Changer Settings

In the selected application, use Settings > Accessories > Cell Changer to display the available 
settings for a cell changer. The Cell Changer features appear only when a cell changer 
accessory is installed.

Related Topics

Calibrating the Cell Changer

Initializing the Cell Changer

Measuring Samples with the Cell Changer

Displaying the Cell Changer Status Monitor

Operation

Feature Description

Accessory name Shows the type and serial number read from the installed sample 
changer.

Current cell

Available cells

The numbered boxes match the cells in the changer head. The 
green box indicates the cell positioned for measurement. To 
manually position a cell in the light beam, click its numbered box.

The check boxes indicate cells enabled for use in the current 
template or active workbook. To disable or enable a cell, click its 
associated check box. Note that cell one is always enabled.

Reset Initializes the cell changer and moves cell one into the light beam.
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Measuring Samples with the Cell Changer

The cell changer performs automated measurements based on the sample list.

Languages

To measure samples with the cell changer

3. Click Home and click an application such as Fixed or Scan.

4. Choose Settings > Accessories> Cell Changer.

5. Under Available Cells, select the check boxes for the cells that will be used in the cell 
changer.

To skip a cell changer position, deselect its check box.

6. Set the other measurement parameters as desired. See the Settings tab for the selected 
application.

7. To measure a blank without using the sample list, click Measure Fixed and then click 
Zero (or Measure Scan and then Baseline).

The Loading Guide shows one entry for the blank measurement.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during oper-
ation.

Remarque  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

Anmerkung  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten.

N.B.  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

Nota  Evite riesgos de atrapamiento. Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.

CAUTION  

Note  Position 1 can not be deselected.
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Place the approproate material (or nothing) in position 1 of the cell changer and click OK 
to perform the measurement.

8. Click Measure.

A dialog box shows the current sample list.

9. Set Number of samples to the number of samples to be measured.

10. Use Load Samples to import the sample list or enter sample names and descriptions if 
desired. See Settings > Samples to create the list ahead of time.

11. Click OK.

The loading guide shows the measurement sequence for the cell changer as defined in the 
sample list.

12. Place the cuvettes in the correct cell changer positions.

Note  If the application requires a blank and it was not measured in step 4, the first 
cell changer position will be measured as the blank.
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13. Click OK or press Run on the instrument keypad.

To cancel, click Cancel or press Stop on the instrument keypad.

If a blank is required, it will be measured first, followed by the samples in order.

If the sample list has more entries than there are spaces in the cell changer, the Loading 
Guide reappears after the last cuvette is measured.

14. If the loading guide appears, remove all cuvettes from the cell changer and fill it with the 
next set of samples as defined in the loading guide.

15. Click OK.

16. Continue as above until all entries in the sample list have been measured.

Related Topics

Calibrating the Cell Changer

Initializing the Cell Changer

Cell Changer Settings

Displaying the Cell Changer Status Monitor

Operation

Displaying the Cell Changer Status Monitor

When a supported cell changer is installed, the selected application can be configured to 
display a cell changer status monitor above the data display.

To display a status monitor for an installed cell changer

1. Click Configure above the data display for the selected application. See “Instrument 
Status Monitors” for more information.

A dialog box appears.

2. Select Cell changer status and click OK.

A status monitor showing the current cell changer position appears above the data display.

Note  The cell changer option appears in the dialog box only when a supported cell 
changer accessory is installed.
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Related Topics

Instrument Status Monitors

Calibrating the Cell Changer

Initializing the Cell Changer

Cell Changer Settings

Measuring Samples with the Cell Changer

Operation

Maintenance

Related Topics

Safety Considerations

Operating Precautions

Installation

Operation

Troubleshooting

Routine Maintenance

Clean the accessory regularly using approved methods (wipe off spilled chemicals 
immediately). See Cleaning the Accessory.

Related Topics

Cleaning the Accessory

Maintenance

Troubleshooting

Cleaning the Accessory

Contents

• Routine Maintenance

• Cleaning the Accessory

NOTICE    Do not allow moisture to leak into the accessory interior.
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To clean the accessory exterior

1. Remove the accessory from the sample compartment. See Installing a Smart Accessory.

2. Use a cloth dampened with plain water to wipe the surface of the Smart Accessory base 
and cell holder.

3. Dry the surface with another cloth.

Related Topics

Routine Maintenance

Maintenance

Troubleshooting

Troubleshooting

Related Topics

Safety Considerations

Operating Precautions

Installation

Operation

Maintenance

Problem Possible Cause Solution

Absorbance 
values are 
inconsistent or 
higher than 
expected

The accessory is not 
aligned properly

Calibrate and then initialize the cell changer. 
See Calibrating the Cell Changer and 
Initializing the Cell Changer.
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SPE-8W Smart Peltier Linear Cell Changer
This accessory includes a thermostatted linear 8-cell changer for 10 mm pathlength square 
cuvettes and a Peltier temperature controller that connects to a USB port on the 
spectrophotometer or computer. The accessory requires a water pump or recirculator, which 
must be purchased separately. Cell temperature can be controlled two ways: from the Peltier 
controller front panel or from the spectrophotometer using INSIGHT software. The Peltier 
controller may also be used to agitate the sample by placing a magnetic stirrer in the cuvette 
and selecting the stir speed.

Contents

Peltier temperature controller Linear cell changer
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Related Topics

Peltier Thermostatted Single Cell Holder

Smart Linear 8-Cell Changer

Accessories

General Safety Information

This equipment has been designed with an emphasis on quality, reliability and safety. We 
accept warranty responsibility for this accessory under the following conditions:

• Electrical installation in the room or building complies with regulations specified in the 
country where the equipment is to be used.

• The equipment is used in accordance with the provided instructions for use.

• All modifications and repairs are carried out by an authorized agent.

• Only modifications suggested and documented by us are to be made to any part of the 
accessory.

• The equipment installation is carried out in accordance with local requirements for 
responsibility and warranty.

• General Safety Information

• Product Description

• Preinstallation

• Installation

• Operation

• Maintenance

• Troubleshooting

CAUTION  Always disconnect the power supply before starting any work inside the instru-
ment.

CAUTION  Take the necessary precautions when using flammable or explosive substances 
in this accessory.
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Related Topics

Product Description

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Product Description

The Peltier Linear Cell Changer permits spectrophotometric measurements at controlled 
temperatures between 0 °C and 100 °C. Measurements can be made at constant temperatures. 

The accessory provides thermoelectric heating and cooling through the cell block.

Related Topics

General Safety Information

Preinstallation

Installation

Operation

Maintenance

Troubleshooting

Contents

• System Connections

• External Connections

• Temperature Controller Front and Rear Panel

• Specifications
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System Connections

Related Topics

External Connections

Temperature Controller Front and Rear Panel

Specifications

External Connections

Communications are performed manually or via remote control through the RS-232 or USB 
connector.

Related Topics

System Connections

Temperature Controller Front and Rear Panel

Specifications

Temperature Controller Front and Rear Panel

The controller front panel features an LCD display with a three-button keypad.



 26 
SPE-8W Smart Peltier Linear Cell Changer

Thermo Scientific Evolution 200 Series User Guide 371

The rear panel houses the main power connection with voltage selector, RS-232 and USB 
connectors for remote control, main power switch and cell holder connector.

Related Topics

System Connections

External Connections

Specifications

Specifications

This section describes the specifications for the Peltier temperature controller.

Contents
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Display/Keypad

The controller has an LCD screen and 3-button keypad to access the functions and set sample 
temperature and stirring rate. See Operation for details.

Programmable Parameters

• Temperature

• Stirring speed

Displayed Values

• Peltier block temperature

• Set temperature

• Stirring speed

• Heating/cooling power

Operating Specifications

• Stirring speed 0 to 1800 rpm

• Temperature range: 0 °C to 100 °C (32 °F to 212 °F)

• Temperature accuracy: ±0.15 °C (±0.27 °F) from 0 °C to 100 °C (32 °F to 212 °F)

• Temperature repeatability: typically ±0.1 °C (±0.18 °F)

• Temperature stability: typically ±0.1 °C (±0.18 °F)

• Specifications valid for ambient temperatures from 15 °C to 35 °C (59 °F to 95 °F)

• Display/Keypad

• Programmable Parameters

• Displayed Values

• Operating Specifications

• External Control

• Dimensions

• Electrical Data

• Description of Symbols

• Environmental Conditions
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External Control

• RS-232

• USB

Dimensions

• Width: 216 mm (8.5 in)

• Height: 184 mm (7.25 in)

• Depth: 269 mm (10.6 in)

• Weight: 3 kg (8 lbs)

Electrical Data

• Voltage: 115/120 V or 220/240 V ±10% (factory setting 220/240 V)

• Frequency: 50/60 Hz

• Power: 100 VA

• CE marked

Description of Symbols

Environmental Conditions

Performance and safety of the accessory are guaranteed if operated under the following 
conditions:

• Pollution degree 2 (standard CEI EN 61010-1).

• Installation category II with smaller transient over voltages (standard IEC 664).

• Mains voltage fluctuations must not exceed 10% of the nominal voltage.

• Location of use is indoors at an altitude <2000 m (6562 ft).

• Location of use exhibits a relative humidity <80% noncondensing.

• Location of use exhibits an ambient temperature between 10 °C and 35 °C (50 °F and 
95 °F).

• Location of use is free from dust and vapors of solvents and acids.

CAUTION  Symbol identifying the use of substances dangerous for health and the 
environment. For these substances, refer to the laws and terms in force for the laboratory 
using the instrument. Take the necessary precautions when using flammable or explosive 
substances.
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Related Topics

System Connections

External Connections

Temperature Controller Front and Rear Panel

Preinstallation

Review this section before installing the accessory.

Related Topics

General Safety Information

Product Description

Installation

Operation

Maintenance

Troubleshooting

Verifying the Power Supply and Fuse

For operation at 120 V, configure the voltage selector on the Peltier back panel and insert the 
correct fuse as described in the following table.

Adjustment for frequency change between 50 and 60 Hz is not necessary.

Contents

• Verifying the Power Supply and Fuse

• Changing the Voltage Setting or Fuse

NOTICE    The unit is factory set to operate at 220 V.

Power Supply Type of fuse - 250 V

240 V T 1A, Slo Blo

120 V T 2A, Slo Blo
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Related Topics

Changing the Voltage Setting or Fuse

Preinstallation

Changing the Voltage Setting or Fuse

The current voltage setting is shown in the voltage display window above the power switch.

To change the voltage setting or fuse

4. Turn off the Peltier unit and disconnect the power cord from the wall outlet.

5. Use a small screwdriver to pry the fuse drawer out of the fuse compartment by pulling the 
tab up and away from the drawer.

6. To change the voltage setting, remove the voltage selector cube from the drawer and 
carefully remove the fuse from the cube.

Voltage display window

Fuse drawer tab

Fuse drawer
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7. Rotate the cube 180 degrees and then replace the cube in the drawer. The correct voltage 
setting should display in the window on the bottom of the fuse drawer.

8. Replace the fuse with a new one that is appropriate for the selected voltage. See Verifying 
the Power Supply and Fuse.

9. Slide the fuse drawer back into the fuse compartment until it locks in place.

10. Connect the power cord to the wall outlet.

11. Turn on the main power switch on the Peltier unit back panel.

If the unit does not perform normally or if the replacement fuse blows, contact technical 
support.

Related Topics

Verifying the Power Supply and Fuse

Preinstallation

Installation

It is necessary to connect the cell holder to a water pump or fluid recirculator and to the 
temperature controller. 
.

Use only 12.5 mm (10 mm pathlength) square cuvettes with this accessory. Use at least 3 ml 
of solution for the analysis.

Before starting the accessory, familiarize yourself with the software features described in 
Operation. To agitate the sample during the measurement, place a magnetic stirrer in the 
cuvette and use the software to set the stirring speed.

Voltage selector cube

NOTICE    Avoid damage to the cell block. Do not operate the accessory without a water 
pump or fluid recirculator.

NOTICE    Avoid damage to the electronics. Do not connect or disconnect cables while the 
accessory is powered on.
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To install the cell changer

1. Open the sample compartment cover.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Remove the tubing access panel. See Tubing Access Panel.

4. Remove any existing cell holder or accessory.

5. Connect one end of the provided flat cable to the cell holder.

6. Install the cell changer in the spectrophotometer sample compartment. See Installing a 
Smart Accessory.

The software displays a prompt to initialize the accessory.

Languages

Cable Connector

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, 
à l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.
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7. Feed the other end of the cable through the opening behind the tubing access panel. See 
Tubing Access Panel.

8. Connect the free end of the cable to the Cell Holder socket on the back of the 
temperature controller.

9. Use appropriate tubing and the provided adapters to connect the two fluid ports on the 
cell holder to a water pump or fluid recirculator. See Installing a Liquid Thermostatted 
Accessory.

Ensure the tubing and cable do not obstruct the light beam. Use the provided clips if 
necessary and test all cell changer positions.

10. Replace the sample compartment front panel. See Sample Compartment Front Panel.

11. Close the sample compartment cover.

12. Turn on the power switch on the controller back panel.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano 
dall’accessorio durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del 
alcance del accesorio durante la inicialización.

Water ports
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13. Press and hold the On (center) button on the temperature controller for 2 seconds.

The Normal Mode display shows the current temperature settings.

14. Calibrate the cell changer. See Calibrating the Cell Changer.

15. Set the software parameters to display status monitors and configure the temperature 
controller and cell changer for operation. See Operation.

Related Topics

General Safety Information

Product Description

Preinstallation

Operation

Maintenance

Troubleshooting

Operation

Related Topics

General Safety Information

Product Description

Preinstallation

Installation

Maintenance

Troubleshooting

Contents

• Calibrating the Cell Changer

• Initializing the Cell Changer

• Setting the Target Temperature and Stir Speed

• Configuring the Cell Changer

• Measuring Samples with the Cell Changer
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Calibrating the Cell Changer

The linear cell changer must be calibrated the first time it is installed in a spectrophotometer. 
Calibration aligns each cell with the light beam. This is especially important when using 
microcells with the cell changer. The calibration settings are stored in the instrument.

Languages

To calibrate the linear cell changer

1. In INSIGHT software choose System Settings > Calibrations.

2. In the Linear Cell Changer group, click Calibrate.

A status box shows several intensity values collected on each side of the expected best 
location for each cell. The average of the highest readings is stored for each cell.

A message box appears when calibration is completed.

3. Click OK.

Related Topics

Initializing the Cell Changer

Setting the Target Temperature and Stir Speed

Configuring the Cell Changer

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during oper-
ation.

Remarque  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

Anmerkung  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten

N.B.  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

Nota  Evite riesgos de atrapamiento.Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.

CAUTION  
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Operation

Initializing the Cell Changer

The accessory must be initialized each time it is installed and after changing the cell holder 
when the Smart base unit is installed. Initializing verifies the cell position and resets the cell 
holder to position 1.

Languages

To initialize a cell changer

1. In the selected application, choose Settings > Accessories > Cell Changer.

2. Click Reset.

Related Topics

Calibrating the Cell Changer

Configuring the Cell Changer

Operation

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, à 
l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano dall’accessorio 
durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del alcance 
del accesorio durante la inicialización.
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Setting the Target Temperature and Stir Speed

INSIGHT software can be used to define a target temperature and display a temperature 
status monitor. A target temperature can also be set from the temperature controller front 
panel.

Related Topics

Calibrating the Cell Changer

Initializing the Cell Changer

Configuring the Cell Changer

Operation

Using INSIGHT Software to Set Temperature and Stir Speed

Related Topics

Using the Peltier Controller to Set Temperature and Stir Speed

Operation

Temperature and Stirrer Settings

In the selected application, use Settings > Accessories > Temperature to display the available 
settings for a temperature probe or controller. The Temperature features appear only when the 
driver for a temperature probe or controller is installed.

Contents

• Using INSIGHT Software to Set Temperature and Stir Speed

• Using the Peltier Controller to Set Temperature and Stir Speed

Contents

• Temperature and Stirrer Settings

• Configuring a Target Temperature

• Displaying the Temperature Status Monitor
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Related Topics

Configuring a Target Temperature

Displaying the Temperature Status Monitor

Using INSIGHT Software to Set Temperature and Stir Speed

Configuring a Target Temperature

To configure a target temperature

1. Select Start measurement at target temperature.

2. Enter the Target temperature and Tolerance in °C.

• For a temperature probe. 
To start the measurement when the probe reaches the target temperature, set Start on 
to Probe temperature and then select the Probe channel. The number of channels 
in the list box will match the available ports on the temperature probe interface box.

The probe channel, current temperature and target range appear during the 
measurement.

Feature Description

Record temperature with mea-
surement

If a temperature probe is used, records the temperature of 
the sample after each measurement. Temperature readings 
are stored in the sample properties.

Use temperature controller If a Peltier cell holder or changer is used, defines a setpoint 
temperature for the cell block and a stir speed if desired. 
The available settings depend on the specifications for the 
temperature-controlled accessory.

Start measurements at target 
temperature

Starts the measurement when the sample (requires a tem-
perature probe) or cell block (requires a Peltier cell holder 
or changer) reaches a specified temperature.

Match probes to cell changer 
positions

If a temperature probe is used, maps probe channels 1 
through 8 with up to eight cell changer positions. Useful 
only when using an automatic cell changer with multiple 
temperature probes.

Deselect this to always record the temperature of probe 1.
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• For a temperature-controlled accessory. 
To start the measurement when the cell block reaches the target temperature, set 
Start on to Block temperature.

Only the current temperature and target range appear during the measurement.

The Start button is disabled since the measurement is configured to start automatically at 
the target temperature.

3. To allow time for equilibration, select Wait for equilibration and enter the duration.

The remaining equilibration time is displayed during the measurement.

If the temperature moves outside the target range, the countdown resets when the 
temperature is again within range.

The Start button becomes active when the temperature remains in the target range for the 
entire equilibration period.

4. To start the measurement automatically after equilibration, select Start measurement 
after equilibration. This disables the Start button in the status dialog box. The 
measurement starts automatically when the temperature remains in the target range 
during the entire equilibration period.

Related Topics

Temperature and Stirrer Settings
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Displaying the Temperature Status Monitor

Using INSIGHT Software to Set Temperature and Stir Speed

Displaying the Temperature Status Monitor

When a Peltier temperature-controlled accessory is installed, the INSIGHT software can be 
configured to display a temperature status monitor above the data display.

To display the temperature status monitor

1. Click the Configure button above the data display for the selected application. See 
Instrument Status Monitors for more information.

A dialog box lists the available status monitors.

2. Select Temperature controller status and click OK.

The status monitor appears above the data display.

Related Topics

Temperature and Stirrer Settings

Configuring a Target Temperature

Using the Peltier Controller to Set Temperature and Stir Speed

Using the Peltier Controller to Set Temperature and Stir Speed

To start the controller, turn on the power switch on the controller back panel.

Startup Mode

After the controller power is turned on, the display appears in one of three modes: Stand-By, 
Normal, or Alarm. The image below indicates Normal mode.

Note  The temperature controller option appears only when a temperature controller 
software driver is installed.

Contents

• Startup Mode

• Standby Mode

• Normal Mode



26 
SPE-8W Smart Peltier Linear Cell Changer

386 Evolution 200 Series User Guide Thermo Scientific

Standby Mode

• Press and hold the Center button for one to two seconds to proceed to Normal Mode.

Normal Mode

Button Functions

• Press the Left button to go to the Main Menu page.

• Press the Right button to go to the Change Set Point page.

• Press and hold the Center button for one to two seconds to return to Stand-By Mode.

• From the Startup page in Normal Mode, use the Change button to move about the 
screen.

Actual block 
temperature

Stirring 
speed

Heating/cooling 
power scale

Block set temperature

Table 7. Startup modes and button functions

Page Mode Display Left button Center button Right button

Startup Standby Standby On

Normal Actual block temperature

Block Set temperature

Stirring speed (left)

Heating/cooling power (right)

Menu 

(Go to Main 
Menu)

Off Change (Go to 
Change Set Point 
Page)

Alarm Alarm description Menu Beep on/off Reset alarm/change*

*Only if the manual alarm reset option has been configured
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Changing the set temperature

1. Highlight Set Temperature.

The Change Set Point page is displayed with down and up arrows above the Left and 
Center buttons.

2. Use the down and up arrow buttons to change the set temperature.

3. When the desired set temperature is displayed, press Change to return to the Startup 
page.

Setting the stirring speed

1. Highlight Stirring Speed.

2. The Change Set Point page is displayed with down and up arrows above the Left and 
Center buttons. 

3. Use the down and up arrow buttons to change the stirring speed.

4. When the desired stirring speed is reached, press Change to return to the Startup page.

Parameters Menu

• Use the Left and Center buttons to scroll the screen up and down.

• Use the Right button to exit the screen and return to the Main Menu.

Table 8. Normal Mode functions

Page Display Description Left button Center button Right button

Change Set 
Point

Flashing selected 
parameter

Change Temperature or 
Stirring Speed Set Point

Down Up Change

Main Menu Parameter User Parameters Scroll Select Exit

Configure Configuration Parameters Scroll Up Exit

Diagnostic Diagnostic Values Down Up Exit

Table 9. User parameters and button functions

Number Description Default value

P-01 Temperature units °C

P-02 Auto start NO

P-03 Display contrast 5

P-04 Beeper YES

P-05 Manual reset pre-alarm NO
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Configure Menu

Diagnostic Menu

• Use the Left and Center buttons to scroll the screen up and down.

• Use the Right button to exit the screen and return to the Main Menu.

Related Topics

Using INSIGHT Software to Set Temperature and Stir Speed

Operation

Configuring the Cell Changer

Related Topics

Calibrating the Cell Changer

Initializing the Cell Changer

Setting the Target Temperature and Stir Speed

Operation

Note  A password is required to enter this menu.

NOTICE    The Configure menu parameters are set at the factory and cannot be changed 
by the user.

Description Measure unit

Cell temperature °C

Radiator temperature °C

Water resistance Kohm

Power %

Cell voltage Volt

Contents

• Cell Changer Settings

• Displaying the Cell Changer Status Monitor
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Cell Changer Settings

In the selected application, use Settings > Accessories > Cell Changer to display the available 
settings for a cell changer. The Cell Changer features appear only when a cell changer 
accessory is installed.

Related Topics

Displaying the Temperature Status Monitor

Operation

Displaying the Cell Changer Status Monitor

When a supported cell changer is installed, the selected application can be configured to 
display a cell changer status monitor above the data display.

To display a status monitor for an installed cell changer

1. Click Configure above the data display for the selected application. See “Instrument 
Status Monitors” for more information.

A dialog box appears.

2. Select Cell changer status and click OK.

A status monitor showing the current cell changer position appears above the data display.

Feature Description

Accessory name Shows the type and serial number read from the installed sample 
changer.

Current cell

Available cells

The numbered boxes match the cells in the changer head. The 
green box indicates the cell positioned for measurement. To 
manually position a cell in the light beam, click its numbered box.

The check boxes indicate cells enabled for use in the current 
template or active workbook. To disable or enable a cell, click its 
associated check box. Note that cell one is always enabled.

Reset Initializes the cell changer and moves cell one into the light beam.

Note  The cell changer option appears in the dialog box only when a supported cell 
changer accessory is installed.
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Related Topics

Configuring a Target Temperature

Operation

Measuring Samples with the Cell Changer

The cell changer performs automated measurements based on the sample list.

Languages

To measure samples with the cell changer

3. Click Home and click an application such as Fixed or Scan.

4. Choose Settings > Accessories> Cell Changer.

5. Under Available Cells, select the check boxes for the cells that will be used in the cell 
changer.

To skip a cell changer position, deselect its check box.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during oper-
ation.

Remarque  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

Anmerkung  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten.

N.B.  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

Nota  Evite riesgos de atrapamiento. Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.

CAUTION  

Note  Position 1 can not be deselected.
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6. Set the other measurement parameters as desired. See the Settings tab for the selected 
application.

7. To measure a blank without using the sample list, click Measure Fixed and then click 
Zero (or Measure Scan and then Baseline).

The Loading Guide shows one entry for the blank measurement.

Place the approproate material (or nothing) in position 1 of the cell changer and click OK 
to perform the measurement.

8. Click Measure.

A dialog box shows the current sample list.

9. Set Number of samples to the number of samples to be measured.

10. Use Load Samples to import the sample list or enter sample names and descriptions if 
desired. See Settings > Samples to create the list ahead of time.

11. Click OK.

The loading guide shows the measurement sequence for the cell changer as defined in the 
sample list.
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12. Place the cuvettes in the correct cell changer positions.

13. Click OK or press Run on the instrument keypad.

To cancel, click Cancel or press Stop on the instrument keypad.

If a blank is required, it will be measured first, followed by the samples in order.

If the sample list has more entries than there are spaces in the cell changer, the Loading 
Guide reappears after the last cuvette is measured.

14. If the loading guide appears, remove all cuvettes from the cell changer and fill it with the 
next set of samples as defined in the loading guide.

15. Click OK.

16. Continue as above until all entries in the sample list have been measured.

Related Topics

Calibrating the Cell Changer

Initializing the Cell Changer

Setting the Target Temperature and Stir Speed

Configuring the Cell Changer

Operation

Maintenance

Note  If the application requires a blank and it was not measured in step 4, the first 
cell changer position will be measured as the blank.

Contents

• Routine Maintenance

• Cleaning the Accessory
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Related Topics

General Safety Information

Product Description

Preinstallation

Installation

Operation

Troubleshooting

Routine Maintenance

The accessory requires little routine maintenance.

Related Topics

Cleaning the Accessory

Maintenance

Troubleshooting

Cleaning the Accessory

To clean the accessory, use a cloth damped with water or neutral detergent only. Do not use 
organic or abrasive solvents.

Related Topics

Routine Maintenance

Maintenance

Troubleshooting

CAUTION  Do not open the unit while the power cord is connected. Any action that 
makes it necessary to open the unit must be executed by authorized service personnel.
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Troubleshooting

Related Topics

General Safety Information

Product Description

Preinstallation

Installation

Operation

Maintenance

Problem Possible Cause Solution

Absorbance val-
ues are inconsis-
tent or higher 
than expected

The accessory is not 
aligned properly

Calibrate and then initialize the cell changer. See 
Calibrating the Cell Changer and Initializing the 
Cell Changer.

Temperature or 
memory failure

Recirculator 
malfunction or 
incorrect use

NOTICE    Immediately turn off the main 
power switch and then turn it on again. If the 
failure reoccurs, turn off the power and 
contact technical support. See Contacting Us.
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Smart Rotary Cell Changer
The Smart Rotary Cell Changer includes a cell holder mounted on a Smart Accessory base. 
The cell holder accommodates seven standard 10 mm pathlength cuvettes.

The accessory can be connected to a fluid recirculator or other device to control sample 
temperature and is compatible with our temperature probes.

Related Topics

Smart Linear 8-Cell Changer

Accessories

Contents

• Safety Considerations

• Operating Precautions

• Installation

• Operation

• Maintenance

Cell holder

Smart Accessory base

Standard cuvette
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Safety Considerations

To avoid injury while using the accessory, keep hands and objects clear of the cell holder when 
initializing or measuring samples with the cell changer.

Related Topics

Operating Precautions

Installation

Operation

Maintenance

Operating Precautions

Handle the accessory carefully:

• Secure all tubing to avoid blocking the light beam (move the cell holder through all 
possible positions).

• Do not allow moisture to leak into the accessory.

• Wipe off spilled chemicals immediately.

• Do not drop the accessory.

• Protect the accessory from mechanical shock.

Related Topics

Safety Considerations

Installation

Operation

Maintenance

Installation

Related Topics

Safety Considerations

Contents

• Installing a Smart Cell Changer

• Replacing the Cell Holder
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Operating Precautions

Operation

Maintenance

Installing a Smart Cell Changer

It is not necessary to power off the instrument while installing or removing a Smart Accessory.

To install a cell changer

1. Open the sample compartment door.

2. Remove the sample compartment front panel.

3. Remove any existing cell holder or accessory.

4. Install the accessory.

The software displays a prompt to initialize the accessory.

Languages

5. Replace the sample compartment front panel.

Note  The Smart Rotary Cell Changer and the Smart Linear Cell Changer cannot be used 
at the same time for double-beam instruments.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, 
à l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano 
dall’accessorio durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del 
alcance del accesorio durante la inicialización.
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6. Close the sample compartment door.

7. Click OK to initialize the accessory.

Initialization reads information about the accessory and moves it to position 1.

8. To use a temperature probe with the cell changer, see “Temperature Probe”.

9. To connect a fluid recirculator or other device to control sample temperature on a 
thermostatted cell changer, see “Installing a Thermostatted Accessory.”

10. Calibrate the cell changer (linear cell changers only) and set the software parameters to 
display the cell changer status monitor and configure the accessory for operation.

Related Topics

Opening and Closing the Sample and Reference Compartment Doors

Removable Panels

Installing a Smart Accessory

Installing a Liquid Thermostatted Accessory

Temperature Probe

Replacing the Cell Holder

Installation

Replacing the Cell Holder

Initialize the accessory after installing a cell holder.

To install a cell holder

1. Line up the tab on the underside of the cell holder with the notch on the motor shaft.

2. Place the cell holder on the shaft.

Tab on 
underside of 
cell holder

Notch on motor 
shaft of Smart base 
unit
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3. Turn the knurled knob clockwise until tight.

4. Initialize the accessory. See Initializing the Cell Changer.

To remove a cell holder

1. Grasp the cell holder with one hand and turn the knurled knob counterclockwise until 
the holder is released.

2. Lift the cell holder off the cell changer base.

Related Topics

Installing a Smart Cell Changer

Installation

Operation

Related Topics

Safety Considerations

Operating Precautions

Installation

Maintenance

Initializing the Cell Changer

The accessory must be initialized each time it is installed and after changing the cell holder 
when the Smart base unit is installed. Initializing verifies the cell position and resets the cell 
holder to position 1.

Contents

• Initializing the Cell Changer

• Cell Changer Settings

• Measuring Samples with a Cell Changer

• Measuring Standards with a Cell Changer

• Displaying the Cell Changer Status Monitor

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.



27 
Smart Rotary Cell Changer

400 Evolution 200 Series User Guide Thermo Scientific

Languages

To initialize a cell changer

1. In the selected application, choose Settings > Accessories > Cell Changer.

2. Click Reset.

Related Topics

Cell Changer Settings

Measuring Samples with a Cell Changer

Measuring Standards with a Cell Changer

Displaying the Cell Changer Status Monitor

Operation

Cell Changer Settings

In the selected application, use Settings > Accessories > Cell Changer to display the available 
settings for a cell changer. The Cell Changer features appear only when a cell changer 
accessory is installed.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, à 
l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano dall’accessorio 
durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del alcance 
del accesorio durante la inicialización.
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Related Topics

Initializing the Cell Changer

Measuring Samples with a Cell Changer

Measuring Standards with a Cell Changer

Displaying the Cell Changer Status Monitor

Operation

Measuring Samples with a Cell Changer

The cell changer performs automated measurements based on the sample list.

Languages

Feature Description

Accessory name Shows the type and serial number read from the installed sample 
changer.

Current cell

Available cells

The numbered boxes match the cells in the changer head. The 
green box indicates the cell positioned for measurement. To 
manually position a cell in the light beam, click its numbered box.

The check boxes indicate cells enabled for use in the current 
template or active workbook. To disable or enable a cell, click its 
associated check box. Note that cell one is always enabled.

Reset Initializes the cell changer and moves cell one into the light beam.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during oper-
ation.

Remarque  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

Anmerkung  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten.
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To measure samples with the cell changer

3. Click Home and click an application such as Fixed or Scan.

4. Choose Settings > Accessories> Cell Changer.

5. Under Available Cells, select the check boxes for the cells that will be used in the cell 
changer.

To skip a cell changer position, deselect its check box.

6. Set the other measurement parameters as desired. See the Settings tab for the selected 
application.

7. To measure a blank without using the sample list, click Measure Fixed and then click 
Zero (or Measure Scan and then Baseline).

The Loading Guide shows one entry for the blank measurement.

Place the approproate material (or nothing) in position 1 of the cell changer and click OK 
to perform the measurement.

8. Click Measure.

A dialog box shows the current sample list.

N.B.  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

Nota  Evite riesgos de atrapamiento. Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.

CAUTION  

Note  Position 1 can not be deselected.
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9. Set Number of samples to the number of samples to be measured.

10. Use Load Samples to import the sample list or enter sample names and descriptions if 
desired. See Settings > Samples to create the list ahead of time.

11. Click OK.

The loading guide shows the measurement sequence for the cell changer as defined in the 
sample list.

12. Place the cuvettes in the correct cell changer positions.

13. Click OK or press Run on the instrument keypad.

To cancel, click Cancel or press Stop on the instrument keypad.

If a blank is required, it will be measured first, followed by the samples in order.

If the sample list has more entries than there are spaces in the cell changer, the Loading 
Guide reappears after the last cuvette is measured.

14. If the loading guide appears, remove all cuvettes from the cell changer and fill it with the 
next set of samples as defined in the loading guide.

15. Click OK.

Note  If the application requires a blank and it was not measured in step 4, the first 
cell changer position will be measured as the blank.
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16. Continue as above until all entries in the sample list have been measured.

Related Topics

Initializing the Cell Changer

Cell Changer Settings

Measuring Standards with a Cell Changer

Displaying the Cell Changer Status Monitor

Operation

Measuring Standards with a Cell Changer

The cell changer can be used to measure blanks, reference samples, standards and samples for 
quantitative analysis. The measurement sequence depends on the quantitative analysis type 
and other measurement settings. During the measurement, the loading guide will indicate 
when and how to load the cell changer. Follow the instructions that appear.

Related Topics

Initializing the Cell Changer

Cell Changer Settings

Measuring Samples with a Cell Changer

Displaying the Cell Changer Status Monitor

Displaying the Cell Changer Status Monitor

When a supported cell changer is installed, the selected application can be configured to 
display a cell changer status monitor above the data display.

To display a status monitor for an installed cell changer

1. Click Configure above the data display for the selected application. See “Instrument 
Status Monitors” for more information.

A dialog box appears.

2. Select Cell changer status and click OK.

Note  The cell changer option appears in the dialog box only when a supported cell 
changer accessory is installed.
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A status monitor showing the current cell changer position appears above the data display.

Related Topics

Initializing the Cell Changer

Cell Changer Settings

Measuring Samples with a Cell Changer

Measuring Standards with a Cell Changer

Operation

Maintenance

Related Topics

Safety Considerations

Operating Precautions

Installation

Operation

Routine Maintenance

Clean the accessory regularly using approved methods (wipe off spilled chemicals 
immediately). See Cleaning the Accessory.

Related Topics

Cleaning the Accessory

Maintenance

Cleaning the Accessory

Contents

• Routine Maintenance

• Cleaning the Accessory

NOTICE    Do not allow moisture to leak into the accessory interior.
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To clean the accessory exterior

1. Remove the accessory from the sample compartment. See Installing a Smart Accessory.

2. Use a cloth dampened with plain water to wipe the surface of the Smart Accessory base 
and cell holder.

3. Dry the surface with another cloth.

Related Topics

Routine Maintenance

Maintenance
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Smart Sipper
The Smart Sipper™ includes a pump (see Pump Specifications for details) and cell holder 
mounted on a Smart Accessory base, standard and acid-compatible tubing packs, and a special 
sample compartment front panel.

The provided tubing packs include:

• Pump tubing (silicone rubber or Viton®).

• Flow cell tubing (fluorinated ethylene polymer, or FEP).

• Low volume flow cell tubing (polytetrafluoroethylene, or PTFE).

• Connectors.

Related Topics

Accessories

Safety Considerations

To avoid injury, remove the Smart Sipper from the spectrophotometer or turn off the 
spectrophotometer main power switch before installing pump tubing.

Contents

• Safety Considerations

• Operating Precautions

• Installation

• Calibration

• Maintenance

• Specifications

• Troubleshooting

Pump

Cell holder

Smart 
Accessory base
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Consignes de sécurité

Pour éviter tout risque de blessure, retirez le système d’aspiration Smart Sipper du 
spectrophotomètre ou mettez l’interrupteur d’alimentation du spectrophotomètre en position 
off avant d’installer la tubulure de la pompe.

Sicherheitshinweise

Entfernen Sie vor der Installation der Pumpenschläuche den Smart-Sipper aus dem 
Spektrophotometer oder schalten Sie den die Spannungsversorgung am Hauptschalter des 
Spektrophotometers aus, um Verletzungen zu vermeiden.

Considerazioni sulla sicurezza

Per evitare lesioni rimuovere lo Smart Sipper dallo spettrofotometro oppure spegnere 
l’interruttore di alimentazione dello spettrofotometro prima di installare le tubazioni della 
pompa.

Consideraciones sobre seguridad

Para evitar lesiones, extraiga el aspirador de muestras Smart del espectrofotómetro o ponga el 
interruptor de alimentación en la posición de apagado antes de instalar los tubos de la bomba.

Related Topics

Operating Precautions

Installation

Calibration

Operation

Maintenance

Specifications

Troubleshooting
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Operating Precautions

Handle the accessory carefully:

• Do not drop the accessory.

• Protect the accessory from mechanical shock.

• Use tubing that is compatible with your sample material.

• Remove the tubing from the pump before storing the accessory.

• Leave the instrument and accessory powered on when the pump is idle and some liquid in 
the sample intake container. The accessory will periodically “sip” a small volume to 
redistribute the pressure on the tubing.

Related Topics

Safety Considerations

Installation

Calibration

Operation

Maintenance

Specifications

Troubleshooting

Installation

Related Topics

Safety Considerations

Operating Precautions

Calibration

Operation

Contents

• Installing Pump Tubing

• Installing the Smart Sipper

• Installing a Flow Cell
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Maintenance

Specifications

Troubleshooting

Installing Pump Tubing

We provide two kinds of pump tubing with the Smart Sipper: silicone rubber (Standard 
Tubing Pack) and Viton® (Acid Tubing Pack).

Verify tubing size and sample compatibility prior to installation. See Specifications.

Languages

To install pump tubing

1. Remove the Smart Sipper from the spectrophotometer or turn off the spectrophotometer 
main power switch.

2. Cut an 18 cm length of pump tubing.

3. Taking care not to stretch, slacken or twist the tubing, feed it counterclockwise around 
the track while manually rotating the pump head.

CAUTION  Avoid pinch hazard. Do not install pump tubing while the instrument is 
powered on.

ATTENTION  Évitez tout risque de pincement. N’installez pas la tubulure de la pompe 
lorsque l’instrument est sous tension.

VORSICHT  Quetschungen sind zu vermeiden. Die Pumpenschläuche dürfen nicht 
installiert werden, während das Instrument eingeschaltet ist.

CAUTELA  Evitare il rischio di pizzicamento. Non installare le tubazioni della pompa 
mentre lo strumento è acceso.

PRECAUCIÓN  Evite riesgos de atrapamiento. No instale los tubos de la bomba con el 
instrumento encendido.
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4. Press the tubing into both clamps.

5. Insert a nipple (provided) into each end of the tubing.

Related Topics

Installing the Smart Sipper

Installing a Flow Cell

Installation

Installing the Smart Sipper

It is not necessary to power off the instrument when installing or removing a Smart Accessory.

NOTICE    Leave at least 2 cm of tubing extending beyond each clamp.

NOTICE    Remove the tubing from the pump before storing the accessory. Leave the 
instrument and accessory powered on when the pump is idle.

Open clamps

Rotate pump head

Insert tubing

Pump In

Pump Out

Nipple
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To install the Smart Sipper

1. Open the sample compartment. See Opening and Closing the Sample and Reference 
Compartment Doors.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Remove any existing cell holder or accessory.

4. Install the accessory. See Installing a Smart Accessory.

The software displays a prompt to initialize the accessory.

Languages

5. Click OK to initialize the accessory.

Initialization reads information about the accessory and reset the pump motors.

6. Install the Sipper sample compartment front panel.

Align the tab on the bottom edge with the slot in the instrument cover and press the 
panel in place.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, 
à l’écart de l’accessoire pendant l’initialisation.

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano 
dall’accessorio durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del 
alcance del accesorio durante la inicialización.
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7. Connect the cable from the Sipper front panel to the socket on the Smart Sipper base and 
hand tighten the collar.

Align the pins before plugging in the connector.

Related Topics

Installing Pump Tubing

Installing a Flow Cell

Installation

Installing a Flow Cell

The provided cell holder accommodates 12.5 mm x 12.5 mm flow cells. Other compatible 
holders and flow cells are available. All compatible cell holders have a central screw that 
mounts to the Smart Sipper base.

Sipper front panel

Connector
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Do not stretch, slacken or twist the tubing during installation.

To install a flow cell

1. Connect a length of appropriate tubing between the Flow Cell Out connector and the 
pump In connector on the Smart Sipper.

Use pump tubing if it fits the cell port. If the flow cell ports are not marked, check the 
documentation that came with the cell.

For flow cells with glass connectors, slide one end of the tubing over the Flow Cell Out 
connector and the other end over the connector on the Pump In tubing.

For flow cells with screw-caps, install screw connectors, O-rings and washers that fit the 
cell ports, and tubing that has a flanged end (samples are provided).

a. In this order, slide the plastic O-ring, rubber washer and screw connector over the 
open end of the tubing until they contact the flange.

b. Screw the cap into the Out port on the flow cell.

c. Attach the open end of the tubing to the Pump In connector.

Tip  To prevent leaks, push tubing onto connectors as far as possible (wet the tubing first if 
necessary).

Flow Cell In

Cell holder

Pump In
Pump Out

Flow Cell Out

From Sipper front panel

To waste container

Flanged tube

Screw connector

Rubber washer
Plastic O-ring
Flange
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If the flow cell tubing does not fit over the connector, attach a short piece of extra 
pump tubing to the connector and insert the flow cell tubing into the sleeve. If the 
connection is too loose, use a clamp or add another sleeve of narrower tubing to 
ensure a tight fit.

2. Cut an appropriate length of PTFE or FEP tubing to reach from the Flow Cell In port 
through the Sipper front panel to the sample container. 

Depending on the depth of your sample container, leave at least 5 cm of tubing 
protruding from the guide.

3. Feed one end of the tubing all the way through the metal guide in the Sipper front panel.

4. Connect the loose end to the Flow Cell In port.

If the tubing does not fit over the Flow Cell In connector, make a sleeve with extra tubing 
as described above.

For a screw-cap flow cell, use flanged tubing and another screw cap, O-ring and washer to 
connect the tubing to the Flow Cell In port.

5. Position the flow cell with the In port on the right, and place it in the cell holder on the 
Smart Sipper.

6. Connect an appropriate length of tubing to the Pump Out port, and route it through one 
of the slits in the Sipper front panel to your waste container.

7. Calibrate the sipper configuration. See Calibration.

8. Set the parameters to operate the Sipper manually or configure workflows for 
autosampling with the Sipper. See Operation.

Related Topics

Installing Pump Tubing

Installing the Smart Sipper

Installation

Calibration

Calibrate the Sipper configuration before using the accessory to analyze samples.

Install the pump tubing, Smart Sipper and flow cell, including all tubing connections (see 
Installation) before calibration.

Languages

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during oper-
ation.
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To calibrate the Smart Sipper

1. Fill a measuring cylinder with laboratory grade purified water or the solvent to be used for 
sample measurements. 

The calibration will be more accurate if the viscosity of the solution used for calibration is 
similar to the viscosity of the sample solution.

2. Place the Sipper intake tube in the cylinder.

3. Open INSIGHT software and click System Settings > Calibrations.

A prompt appears.

4. Enter the volume to be drawn for the calibration test in the Sip Volume box (typically 
10 ml).

5. To display a prompt before each test, select Prompt.

To sip automatically after a period of time, select Count down and enter the time.

Remarque  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

Anmerkung  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten.

N.B.  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

Nota  Evite riesgos de atrapamiento. Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.
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6. Click Next.

A prompt appears. The contents depends on the Prompting setting.

7. Record the volume of liquid in the cylinder.

8. Click OK or Pump Now (or wait until the counter is finished).

The Sipper attempts to draw the specified volume, and then a prompt requests the actual 
volume drawn.

9. Remove the inlet tube from the cylinder and record the volume of liquid remaining.

10. Subtract the volume remaining in the cylinder from the initial volume to calculate the 
actual volume drawn through the inlet tube. Enter this value in the Actual box and click 
Next.

11. Repeat steps 7 through 10 until the Actual volume matches the Expected volume.

12. Click Done.

Related Topics

Safety Considerations

Operating Precautions

Installation

Operation

Maintenance

Specifications

Troubleshooting
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Operation

In the selected INSIGHT software application, click Settings > Accessories > Sipper to 
display the settings for the Smart Sipper. The Sipper features appear only when a Smart Sipper 
is installed.

Feature Description

Sip volume entry box For automated sipper workflows, defines the volume to 
draw for each measurement. The sip volume must be 
greater than 0.

Use sufficient volume to push any previous solution out of 
the flow cell. When the cell is filled, the sample material 
should also fill at least 8 cm of the inlet tube in front of the 
flow cell to prevent air bubbles from entering the cell. (Use 
an air gap if the sample material is limited.) Check the 
system for cross-contamination before taking 
measurements.

Settle time For automated sipper workflows, specifies a delay before 
the sample is measured to allow air bubbles to dissipate. 
Enter 0 to skip this step.

Air gap duration For automated sipper workflows that include a “draw air” 
step, defines how long to draw air through the system to 
move a small sample volume to the flow cell. The correct 
setting depends on the Sip volume setting and the length 
of the inlet tube. Typically, draw sufficient air to push the 
sample into the cell but leave enough sample material to 
fill at least 8 cm of the inlet tube in front of the flow cell.

Enter 0 to skip this step.

Rinse duration For automated sipper workflows that include a “rinse” 
step, specifies how long to draw the rinse solution through 
the system. Enter 0 to skip this step.
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Related Topics

Safety Considerations

Operating Precautions

Installation

Calibration

Maintenance

Sipper Workflows Defines automated sipper workflows. Use the Measure 
button in the software to start the workflow. 

• Sip, settle, measure, prompt, return draws the 
specified sip volume, delays the specified settle time, 
measures the sample, and prompts to move the inlet 
tube to the return container. When the user clicks OK 
or presses the Sipper front panel switch, returns the 
sample to the container.

• Sip, draw air, settle, measure, prompt, rinse, draw 
air draws the specified sip volume and prompts to 
remove the inlet tube. When the user clicks OK or 
presses the front panel switch, draws air for the 
specified period, waits the specified settle time, 
measures the sample and prompts to place the inlet 
tube in the rinse solution. When the user clicks OK or 
presses the switch, draws the rinse solution for the 
specified time and prompts to remove the inlet tube. 
When the user clicks OK or presses the switch, draws 
air for the specified period.

Samples are measured using the selected application. 
Results are placed in the selected workbook.

Manual Control Activates the Sipper front panel switch as a pump control. 
When the check box is selected, pressing the switch once 
causes the pump to draw through the inlet tube; pressing it 
again stops it.

Sip Volume button Immediately causes the pump to draw the specified sip 
volume through the inlet tube.

Pump On/Pump Off buttons Toggles between Pump On and Pump Off. Pump On 
causes the pump to draw continuously through the inlet 
tube; Pump Off causes it to stop.

Feature Description
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Specifications

Troubleshooting

Maintenance

Related Topics

Safety Considerations

Operating Precautions

Installation

Calibration

Operation

Specifications

Troubleshooting

Routine Maintenance

Clean the accessory regularly using approved methods (wipe off spilled chemicals 
immediately).

Related Topics

Cleaning the Accessory

Replacing Pump Tubing

Cleaning Flow Cells

Replacing Flow Cell Tubing

Maintenance

Cleaning the Accessory

Contents

• Routine Maintenance

• Cleaning the Accessory

• Replacing Pump Tubing

NOTICE    Do not allow moisture to leak into the accessory interior.
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To clean the accessory exterior

1. Remove the accessory from the sample compartment. See Installing a Smart Accessory.

2. Use a lint-free cloth dampened with plain water to wipe the area near the cell holder.

3. Dry the surface with another cloth.

Related Topics

Routine Maintenance

Replacing Pump Tubing

Cleaning Flow Cells

Replacing Flow Cell Tubing

Maintenance

Replacing Pump Tubing

Examine pump tubing weekly and when pumping efficiency is impaired. Replace crimped or 
worn tubing (see Installing Pump Tubing).

If you install a different type or size tubing, recalibrate before analyzing samples (see 
Calibration).

Related Topics

Routine Maintenance

Cleaning the Accessory

Cleaning Flow Cells

Replacing Flow Cell Tubing

Maintenance

Cleaning Flow Cells

Rinse the flow cell and inlet tubing thoroughly with laboratory grade purified water after each 
analysis and before turning off the Smart Sipper. Keep the cell filled with purified water when 
not in use.

At least once a week, remove the flow cell from the accessory and soak it in a solution of 
Decon™ detergent (or equivalent), diluted according to the manufacturer’s instructions. When 
finished, reconnect the cell and flush it thoroughly with laboratory grade purified water.
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Related Topics

Routine Maintenance

Cleaning the Accessory

Replacing Pump Tubing

Replacing Flow Cell Tubing

Maintenance

Replacing Flow Cell Tubing

Examine flow cell tubing regularly. Replace tubing that is kinked, worn or contaminated with 
sample material.

Related Topics

Routine Maintenance

Cleaning the Accessory

Replacing Pump Tubing

Cleaning Flow Cells

Maintenance

Specifications

Related Topics

Safety Considerations

Operating Precautions

Installation

Calibration

Operation

Maintenance

Contents

• Pump Tubing Chemical Compatibility

• Pump Tubing Specifications

• Pump Specifications
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Troubleshooting

Pump Tubing Chemical Compatibility

We provide two kinds of pump tubing: silicone rubber (Standard Tubing Pack) and Viton® 
(Acid Tubing Pack). Silicone rubber is suitable for most aqueous solutions and is 
recommended when the pump will be used for prolonged periods. Viton withstands many 
strong acids, alkalis and organic solvents, which corrode silicone rubber.

Use the table below to verify that your chemicals are compatible with the provided tubing, or 
other tubing that is compatible and meets our specifications.

The table is only a general guide. Each rating is based on ideal testing conditions used by 
tubing manufacturers. Temperature, length of service, chemical concentration, etc. can affect 
chemical resistance. Test the tubing under your experimental conditions.

Chemical Compatibility for Silicone, Viton and Norprene Tubing

Key Meaning

X Can be used

— Marginal

Blank Not tested

N Not recommended

Chemical Nor Sil Vit Chemical Nor Sil Vit

Acetaldehyde X X N Arsenic salts X X

Acetates X — N Barium salts X X X

Acetic acid (<5%) X X X Benzaldehyde X N N

Acetic acid (>5%) X X — Benzene N N X

Acetic anhydride X N Benzene sulfonic acid X

Acetonitrile — Benzoic acid X — X

Acetone X — Benzyl alcohol X X

Acetyl bromide Bleaching liquors X — X

Acetyl chloride Boric acid X X X

Air X X X Bromine X N X

Alcohols X X X Butane X N X

Aliphatic hydrocarbon X — N Butyl acetate N

Aluminum chloride X — N Butyl alcohol X — N

Aluminum sulfate X X X Butyric acid X —
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Alums X X Calcium oxide X X

Ammonia X X N Calcium salts X — X

Ammonium acetate X Carbon bisulfide X

Ammonium carbonate X Carbon dioxide X — X

Ammonium chloride X Carbon tetrachloride N N X

Ammonium hydroxide X X X Chloracetic acid X N

Ammonium nitrate X — Chlorine (wet) X N X

Ammonium phosphate X X Chlorine (dry) X N N

Ammonium sulfate X X X Chlorobenzene N X

Amyl acetate X N N Chlorobromomethane N X

Amyl alcohol X N X Chloroform N N X

Amyl chloride N X Chloronaphthalene N N

Aniline N — Chlorosulfonic acid N N

Aniline hydrochloride N X Chromic acid X N X

Antimony salts X — Chromium salts X

Aqua regia X — Copper salts X X X

Aromatic hydrocarbons N — X Cresol X X

Cyclohexane N N X Hydrobromic acid X — X

Cyclohexanone N X Hydrochloric acid (dil) X N X

Diacetone alcohol N N Hydrochloric acid (med) X N

Dichloromethane N N Hydrochloric acid (conc) X N X

Dimethyl formamide — N Hydrocyanic acid X N X

Dimethyl sulfoxide X X Hydrofluoric acid N N X

Essential oils X Hydrogen peroxide (dil) X X X

Ethers X N — Hydrogen peroxide (conc) X X —

Ethyl acetate N N N Hydrogen sulfide X X N

Ethyl alcohol X — X Hydrochlorous acid X

Ethyl bromide X Iodine solutions X X

Ethyl chloride N N X Kerosene N N X

Ethylamine X Ketones N N N

Ethylene dichloride N X Lacquer solvents N N

Ethylene glycol X X X Lactic acid X — X

Chemical Nor Sil Vit Chemical Nor Sil Vit
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Ethylene oxide N N Lead acetate X N N

Fatty acids — X Lithium hydroxide (5%) N X

Ferric chloride X — X Magnesium chloride X X X

Ferric sulfate X — X Magnesium sulfate X

Ferrous chloride — X Malic acid X X

Ferrous sulfate — X Manganese salts X X X

Fluoroborate salts X Mercury salts X X

Fluoroboric acid X Methane X N X

Formaldehyde X — X Methanol X X

Formic acid X — N Methyl chloride — X

Freon N N — Methylethyl ketone N N

Gasoline — N X Molybdenum disulfide —

Glucose X X X Monoethanolamine —

Glue X Naphtha N N X

Glycerine X X X Natural gas X X X

Hydrazine (64% in H2O) X X Nickel salts X X X

Nitric acid (dil) X — X Sodium borate X X X

Nitric acid (med) — N X Sodium carbonate X X X

Nitric acid (conc) N N — Sodium chlorate X X

Nitrobenzene N N XN Sodium chloride X X X

Nitrogen oxides X — — Sodium ferrocyanide X X

Nitrous acid X — Sodium hydrosulfite X — X

Oils, animal X — X Sodium hydroxide (dil) X — X

Oils, mineral X — X Sodium hydroxide (med) X — X

Oils, vegetable X X X Sodium hydroxide (conc) — — —

Oleic acid X N — Sodium hypochlorite (<5%) X X

Oxalic acid X — X Sodium hypochlorite (>5%) X X

Perchloric acid N N X Sodium sulfide X X X

Perchloroethylene N N X Sodium sulfite X X X

Phenol N N X Steam (up to 40psi) N N

Phosphoric acid X — X Stearic acid X — X

Phthalic acid X X X Sulfur chloride N X

Chemical Nor Sil Vit Chemical Nor Sil Vit
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Related Topics

Pump Tubing Specifications

Pump Specifications

Specifications

Pump Tubing Specifications

Plating solutions X N X Sulfur dioxide X — X

Polyglycol Sulfur hexafluoride — N

Potassium carbonate X X Sulfur trioxide X — X

Potassium chlorate X X Sulfuric acid (dil) X N X

Potassium hydroxide (med) — Z Sulfuric acid (med) X N X

Potassium hydroxide (conc) — X Sulfuric acid (conc) — N X

Potassium iodide X X Tannic acid X — X

Pyridine X N N Tanning extracts X X

Silicone fluids — X Tartaric acid — X

Silicone oil — Z Tetrachloroethane N N

Silver nitrate X X X Tetrahydrofuran N N

Soap solutions X X X Tin salts

Sodium bicarbonate X X X Titanium salts

Sodium bisulfate X X Toluene N N X

Sodium bisulfite X X X Trichloroaecetic acid N

Trichloroethylene X Vinyl plastisol —

Trichlorofluoroethane N N Water X X X

Trisodium phosphate X X Water (brine) X X X

Turpentine X N X Xylene N N X

Urea X X X Zinc chloride X X

Uric acid X

Chemical Nor Sil Vit Chemical Nor Sil Vit

Note  Tubing that is too tight will cause excessive pump strain and wear. Tubing that is too 
loose will decrease pumping efficiency.
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Related Topics

Pump Tubing Chemical Compatibility

Pump Specifications

Specifications

Pump Specifications

Related Topics

Pump Tubing Chemical Compatibility

Pump Tubing Specifications

Specifications

Pump Tubing Specifications

Maximum outer diameter 5.08 mm (0.200 in)

Minimum outer diameter 2.54 mm (0.100 in)

Inner diameter 1.65 mm ±0.127 mm (0.065 in ±0.005 in)

Wall thickness 0.89 mm ±0.07 mm (0.035 in ±0.003 in)

Volume repeatability ±5% for all pump times >3 sec

Pump Specifications

Setting Speed (rpm) Flow Rate (ml/min)

Slow 60 8.0

Medium 105 14.0

Fast 150 20.0

Pump time (seconds) Variable: 0.0 to 999.0

Purge time (seconds) Variable: 0.0 to 999.0

Auto function Purge, Return, Off

Setting time (seconds) Variable: 0.0 to 999.0

Number of rinses Variable: 0 to 4
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Troubleshooting

Problem Possible Cause Solution

Pump does not 
operate

The accessory is not 
installed properly or 
the wrong pump 
tubing is used. 

Remove and reinstall the accessory, install the 
Sipper front panel and connect the data cable. See 
Installation.

Ensure the pump tubing is the correct diameter 
and material. See Pump Tubing Specifications 
and Pump Tubing Chemical Compatibility.

Pump does not 
draw

Pump tubing is 
crimped or damaged

Check the entire pumping system for damage or 
excessive wear and replace sections as necessary. 
See Installing Pump Tubing and Installing a Flow 
Cell.

To prevent crimping, remove pump tubing before 
storing the accessory. When the pump is idle, 
leave the instrument and accessory powered on 
and some liquid in the sample intake container. 
The accessory periodically “sips” a small volume 
to redistribute the pressure on the tubing.

Ensure the tubing is compatible with your sample 
material. Many factors (temperature, length of 
service, chemical concentration, etc.) can affect 
chemical resistance; test the tubing under your 
conditions. See Pump Tubing Chemical 
Compatibility.

Rinse flow cells and tubing thoroughly after use. 
See Cleaning Flow Cells.

Noise peaks in 
the spectral data 
or inconsistent 
results

There are air bubbles 
in the flow cell

Inspect the flow cell for bubbles, which diffract 
the light so less energy is passed to the detector. 
To prevent air bubbles from entering the cell, use 
sufficient volume so the sample material fills at 
least 8 cm of the inlet tube in front of the flow 
cell. (Use an air gap if the sample material is 
limited.) See Operation.

To remove air bubbles adhering to flow cell walls 
(occurs frequently with biological materials), 
remove the cell and soak it in a recommended 
detergent. See Cleaning Flow Cells. When 
finished, reconnect the cell and flush it 
thoroughly with laboratory grade purified water.
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Related Topics

Safety Considerations

Operating Precautions

Installation

Calibration

Operation

Maintenance

Specifications
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Temperature Probe
The Temperature Probe allows measurements with the following specifications:

• Range: 0 °C to 100 °C

• Accuracy: ±0.5 °C + 0.2% of the temperature reading

The kit includes a probe, two Teflon® stoppers, a multi-channel USB interface and a software 
driver. The probe has a 304 stainless-steel tip that resists many chemicals. A square stopper 
accommodates standard 10 mm pathlength rectangular cuvettes with square lids, and a round 
one fits cuvettes with stoppers.

Related Topics

Accessories

Operating Precautions

Handle the accessory carefully:

• Do not allow moisture to leak into the accessory.

• Allow liquid to contact only the narrow measurement tip; do not submerge the probe.

• Wipe off spilled chemicals immediately.

Contents

• Operating Precautions

• Installation

• Operation

• Maintenance

• Troubleshooting

Probe

Stoppers

USB interface
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• Do not drop the accessory.

• Protect the accessory from mechanical shock.

• Do not bend the probe tip.

Related Topics

Installation

Operation

Maintenance

Troubleshooting

Installation

The interface box can be connected to any USB port on the instrument or remote computer. 
Probes are routed behind the tubing access panel and into the sample compartment.

To connect the temperature probe

1. Remove the tubing access panel. See Tubing Access Panel.

2. Connect the interface box cable to a standard USB port on the spectrophotometer.

If the spectrophotometer is set up for computer control, the cable also connects to any 
USB port on the remote computer.

3. Install a cell holder or changer that accommodates cuvettes that are compatible with the 
temperature probe.

4. Install a cuvette in the cell holder or changer.

5. Insert the probe into an appropriate stopper (round or square, depending on the selected 
cuvette).

Note  Install the driver for the temperature probe on the system computer (local or 
remote) to enable the probe features in INSIGHT software. If using a Local Control 
instrument that has an optional remote computer, install the driver on both computers 
and connect the interface box to the active computer.

NOTICE    Do not force the probe into the stopper.
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a. Loosen the screw on the stopper base.

b. Align the probe tip with the central hole in the stopper and gently push the probe 
into the stopper as far as it will go.

Ensure the probe tip extends about 2 mm beyond the stopper.

c. Tighten the screw on the stopper base.

6. Route the probe cable into the sample compartment and out the tubing access 
compartment. (Push it through the slit in the foam panel.)

7. Insert the probe connector into an open port on the interface box.

8. Fill the cuvette with the sample or reference solution.

Use sufficient volume to wet the probe tip when installed, but do not overfill the cell. The 
probe will displace a small amount of liquid.

9. Insert the probe and stopper into the cuvette.

Ensure the probe extends at least 2 mm below the surface of the liquid but not so deep 
that it blocks the light beam.

Ensure the cable does not obstruct the light beam, especially when using probes with a 
cell changer (move the changer through all positions).

10. Set the software parameters to display the probe status monitor and record sample 
temperature. See Operation.

Related Topics

Operating Precautions

Operation

Maintenance

Troubleshooting

Operation

Stopper Probe tip

Contents
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Related Topics

Operating Precautions

Installation

Maintenance

Troubleshooting

Temperature Settings

In the selected application, use Settings > Accessories > Temperature to display the available 
settings for a temperature probe or controller. The Temperature features appear only when the 
driver for a temperature probe or controller is installed.

Related Topics

Configuring a Target Temperature

Displaying a Temperature Status Monitor

• Temperature Settings

• Configuring a Target Temperature

• Displaying a Temperature Status Monitor

Feature Description

Record temperature with mea-
surement

If a temperature probe is used, records the temperature of 
the sample after each measurement. Temperature readings 
are stored in the sample properties.

Use temperature controller If a Peltier cell holder or changer is used, defines a setpoint 
temperature for the cell block and a stir speed if desired. 
The available settings depend on the specifications for the 
temperature-controlled accessory.

Start measurements at target 
temperature

Starts the measurement when the sample (requires a tem-
perature probe) or cell block (requires a Peltier cell holder 
or changer) reaches a specified temperature.

Match probes to cell changer 
positions

If a temperature probe is used, maps probe channels 1 
through 8 with up to eight cell changer positions. Useful 
only when using an automatic cell changer with multiple 
temperature probes.

Deselect this to always record the temperature of probe 1.
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Operation

Configuring a Target Temperature

To configure a target temperature

1. Select Start measurement at target temperature.

2. Enter the Target temperature and Tolerance in °C.

• For a temperature probe. 
To start the measurement when the probe reaches the target temperature, set Start on 
to Probe temperature and then select the Probe channel. The number of channels 
in the list box will match the available ports on the temperature probe interface box.

The probe channel, current temperature and target range appear during the 
measurement.

• For a temperature-controlled accessory. 
To start the measurement when the cell block reaches the target temperature, set 
Start on to Block temperature.

Only the current temperature and target range appear during the measurement.

The Start button is disabled since the measurement is configured to start automatically at 
the target temperature.

3. To allow time for equilibration, select Wait for equilibration and enter the duration.

The remaining equilibration time is displayed during the measurement.
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If the temperature moves outside the target range, the countdown resets when the 
temperature is again within range.

The Start button becomes active when the temperature remains in the target range for the 
entire equilibration period.

4. To start the measurement automatically after equilibration, select Start measurement 
after equilibration. This disables the Start button in the status dialog box. The 
measurement starts automatically when the temperature remains in the target range 
during the entire equilibration period.

Related Topics

Temperature Settings

Displaying a Temperature Status Monitor

Operation

Displaying a Temperature Status Monitor

The INSIGHT software can be configured to display a temperature status monitor for each 
installed probe.

To display a temperature probe status monitor

1. Click the Configure button above the data display for the selected application. See 
“Instrument Status Monitors” for more information.

A dialog box lists the available status monitors.

2. Select the Temperature status option that matches the probe channel and click OK.

The status monitor appears above the data display. Here is an example.

Note  Temperature options appear only when a software driver for the temperature 
probe is installed.



 29 
Temperature Probe

Thermo Scientific Evolution 200 Series User Guide 437

3. To edit the probe name or channel, double-click the probe status monitor. A dialog box 
appears.

Enter a name in the Description box, select the Channel and click OK.

Related Topics

Instrument Status Monitors

Temperature Settings

Configuring a Target Temperature

Operation

Maintenance

Related Topics

Operating Precautions

Installation

Operation

Troubleshooting

Contents

• Routine Maintenance

• Cleaning Temperature Probes

• Replacing Stopper O-Rings
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Routine Maintenance

• Clean probes immediately after each measurement and before storing them. See Cleaning 
Temperature Probes.

• Check stopper O-rings regularly for wear and replace them when necessary. See Replacing 
Stopper O-Rings.

Related Topics

Cleaning Temperature Probes

Replacing Stopper O-Rings

Maintenance

Cleaning Temperature Probes

Clean temperature probes frequently to avoid contaminating subsequent samples. Wipe off 
spilled chemicals immediately.

To clean a probe, rinse the tip with water and then with methanol or isopropyl alcohol and air 
dry.

Related Topics

Routine Maintenance

Replacing Stopper O-Rings

Maintenance

Replacing Stopper O-Rings

Check stopper gaskets and O-rings regularly for wear and replace them when necessary. The 
square stopper has two gaskets and internal O-ring. The round stopper has an internal 
O-ring.

A 4 mm screw (at least 3 mm long) is required to remove the liner that supports the internal 
O-ring.

To replace the internal O-ring (round or square stopper)

1. Insert the 4 mm screw several turns into the stopper base, and use it to pull the liner out 
of the base (leave the screw in the liner).

Note  Use of the temperature probe with corrosive samples or extreme temperatures can 
cause O-rings to break down faster.
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2. Use tweezers or a pointed tool to remove the small O-ring from the end of the liner.

3. Press the new O-ring fully into the liner.

The O-ring must remain in place when you turn the liner upside down.

4. Use the screw to insert the liner back into the stopper (press to secure the O-ring).

5. Remove the screw from the liner.

To replace the gaskets on the square stopper

1. Use tweezers or a pointed tool to remove the gaskets.

2. Stretch each new gasket onto the stopper and press it into the groove.

Related Topics

Routine Maintenance

Cleaning Temperature Probes

Maintenance

Screw

Liner
O-ring

Gaskets
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Troubleshooting

Related Topics

Operating Precautions

Installation

Operation

Maintenance

Problem Possible Cause Solution

Temperature readings do not 
match expected values.

The probe is soiled or 
damaged, or there is not 
enough liquid in the cuvette.

Clean and reseat the probe in 
the cuvette ensuring at least 
2 mm of the probe tip 
extends below the sample 
surface. If performance is still 
unacceptable, replace the 
probe.

The temperature of the 
sample or reference solution 
(as measured by the probe) 
does not match the 
temperature of the external 
fluid recirculator.

Sample temperature is 
affected by the:

• type of cell used for the 
measurement

• length of the recirculator 
tubing

• degree of insulation 
around the tubing

• difference between the 
recirculator set 
temperature and the 
ambient temperature.

Set the external recirculator 
temperature slightly higher 
than the target temperature 
for the measurement (or 
apply a correction factor if 
your recirculator offers that 
feature).

When using multiple 
thermostatted accessories 
with a common recirculator, 
it may be necessary to 
increase the Tolerance setting 
in the software to account for 
the temperature differential 
between the heated 
components.
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Variable Angle Transmission
For Local Control instruments:

D://2612_HARRICK_Var Angle Trans Accy_UG.pdfFor Computer Control instruments:

C://2612_HARRICK_Var Angle Trans Accy_UG.pdfIf these links do not work, see your 
documentation CD.

Related Topics

Installing a Manual Accessory

Accessories
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VERSA Probe
The VERSA fiber optic probe uses a standard SMA connector and disposable quartz tips. The 
probe is compatible with measurements between 200 and 1100 nm at temperatures up to 
125 °C. Quartz tips are available with a pathlength of 10 mm or 20 mm.

Related Topics

Integrated Fiber Optic Module

Probe Handling and Maintenance

Accessories

Operating Precautions

Fiber Optic Probes

Handle probes carefully:

• Do not allow hard materials (glass, metal, ceramic, etc.) to contact the probe’s optical 
surfaces.

• Do not drop the probe or knock it against a hard surface.

• Do not subject the probe to rapid or excessive changes in temperature.

Contents

• Operating Precautions

• Installation

• Operation

• Routine Maintenance

Quartz tip

VERSA probe



31 
VERSA Probe

444 Evolution 200 Series User Guide Thermo Scientific

• Wipe off spilled chemicals immediately.

Fiber Optic Cables

Handle fiber optic cables gently and follow these precautions:

• Do not drop the cables or knock them against a hard surface.

• Do not bend the cables or tightly coil them.

• Do not touch the end of a fiber optic cable connector.

• Do not overtighten or use tools to tighten the connectors when attaching the cables to the 
ports.

• Avoid twisting the cables when attaching them to the connectors.

• Keep a protective cap on each end of the cable when not in use.

Related Topics

Installation

Operation

Routine Maintenance

Installation

Related Topics

Operating Precautions

Operation

Routine Maintenance

Installing the VERSA Probe

Install the Integrated Fiber Optic Module before installing a probe.

Contents

• Installing the VERSA Probe

• Installing Tips
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Languages

To install a probe, follow instructions for your instrument. See Attaching Cables and Probes 
in Integrated Fiber Optic Module.

If the probe has a remote start cable, plug the connector into the Trigger port on the 
spectrophotometer. See Connectors.

Related Topics

Installing Tips

WARNING  Avoid UV radiation hazard. Do not stare at the beam or light leaving a 
coupled fiber optic cable.

AVERTISSEMENT  Évitez l'exposition au rayonnements UV.  Ne regardez jamais le 
faisceau de lumière qui sort d’une fibre optique couplé.

WARNUNG  Gefahren durch UV-Strahlung sind zu vermeiden. Nicht in den Strahl 
eines gekoppelten Glasfaserkabels blicken.

AVVERTENZA  Evitare il rischio di radiazioni UV.Non fissare il raggio di luce che esce 
dal cavo a fibre ottiche accoppiato.

ADVERTENCIA  Evite el riesgo de radiación ultravioleta.No mire al rayo luminoso que 
sale de un cable de fibra óptica acoplado.

WARNING  

NOTICE    When attaching fiber optic cables to the accessory ports, avoid:

• Twisting or bending the cable.

• Touching the ends with your fingers.

• Overtightening or using tools to tighten the connectors.
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Installation

Installing Tips

Tips must be installed to take measurements.

To install a tip

1. Slide a quartz tip onto the probe shaft.

2. Align the notch at the base of the tip with the pin on the probe handle.

3. Press and hold the release button and slide the notch under the pin.

4. Release the button.

Verify the tip is secure by touching the middle portion of the tip and gently attempting to 
slide it. If the tip is secure, it will not move.

To remove the tip

Press the release button.

Related Topics

Installing the VERSA Probe

Installation

Operation

Install a tip before using the probe. See Installing Tips.

When inserting the probe into a solution, shake the probe gently to release any air bubbles 
trapped in the probe tip.

Pin

Notch

ShaftRelease button

Quartz tip
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To improve the signal-to-noise ratio, try using slower scan speeds and longer integration 
times.

Languages

To use the VERSA probe

1. Insert the probe into the baseline solution and collect a baseline or zero measurement.

WARNING  Avoid UV radiation hazard. Do not stare at the beam or light leaving a 
coupled fiber optic cable.

AVERTISSEMENT  Évitez l'exposition au rayonnements UV.  Ne regardez jamais le 
faisceau de lumière qui sort d’une fibre optique couplé.

WARNUNG  Gefahren durch UV-Strahlung sind zu vermeiden. Nicht in den Strahl eines 
gekoppelten Glasfaserkabels blicken.

AVVERTENZA  Evitare il rischio di radiazioni UV.Non fissare il raggio di luce che esce dal 
cavo a fibre ottiche accoppiato.

ADVERTENCIA  Evite el riesgo de radiación ultravioleta.No mire al rayo luminoso que sale 
de un cable de fibra óptica acoplado.

WARNING  
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2. When finished collecting a baseline, dry the tip and insert the probe into the sample.

3. When finished measuring a sample, discard the tip or clean it before making additional 
measurements.

Related Topics

Operating Precautions

Installation

Routine Maintenance
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Routine Maintenance

Follow these guidelines:

• Clean the probe immediately after each measurement and before storing it. See Cleaning 
Probes.

• Follow the manufacturer’s recommendations for probe maintenance.

Related Topics

Cleaning Probes

Troubleshooting

Operating Precautions

Installation

Operation
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Performance Verification

Overview of PV

Contents

• Overview of PV

• PV Test Descriptions

• Running PV Tests

Use Performance Verification to set up and run tests to 
check the performance of the instrument. Click here for 
information on running the tests. Test results are 
displayed in reports that are saved automatically and can 
be opened later (see My Data).
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PV Test Descriptions
Test Description

Wavelength Accuracy (Hg lamp) Locates the peaks from the external Mercury Lamp 
Calibration accessory and displays their measured and 
allowed range of wavelengths. A mercury lamp has 
strong, fundamental lines throughout the UV-visible 
range. These emission lines are a property of the lamp 
and serve as a fundamental wavelength standard that 
does not require calibration. The wavelengths and 
tolerance values cannot be changed. Use an empty cell 
holder and install the mercury lamp accessory properly 
in the instrument.

Wavelength Reproducibility (Hg 
lamp)

Measures the ability of the spectrophotometer to return 
to an identical wavelength in a repeatable manner. The 
test uses the external mercury lamp, which has a strong, 
fundamental line near 546 nm. This emission line is an 
intrinsic property of the lamp and serves as a 
fundamental wavelength standard that does not require 
calibration. The wavelength and tolerance values cannot 
be changed. Use an empty cell holder and install the 
Mercury Lamp Calibration accessory properly in the 
instrument.

Wavelength Accuracy (Xe lamp) Locates the peak near 542 nm of the internal xenon 
lamp and displays the measured and allowed range of 
wavelengths. A xenon lamp has strong, fundamental 
lines throughout the UV-visible range. These are an 
intrinsic property of the lamp and serve as a 
fundamental wavelength standard that does not require 
calibration. The wavelength and tolerance values cannot 
be changed. Use an empty cell holder.

Wavelength Reproducibility (Xe 
lamp)

Measures the ability of the spectrophotometer to return 
to an identical wavelength in a repeatable manner. The 
test uses the internal xenon lamp, which has a strong, 
fundamental emission line near 542 nm. This line is a 
property of the lamp and serves as a fundamental 
wavelength standard that does not require calibration. 
The wavelength and tolerance values cannot be changed. 
Use an empty cell holder.
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Wavelength Accuracy (Holmium 
oxide liquid)

Locates the peaks of a holmium oxide standard and 
displays their measured and allowed range of 
wavelengths. A holmium oxide solution prepared in 
dilute perchloric acid has well defined absorption peaks 
throughout the UV-visible range. These peaks are a 
property of the material and serve as a wavelength 
standard. The wavelengths and tolerance values are 
cannot be changed.

Wavelength Reproducibility 
(Holmium oxide liquid)

Measures the ability of the spectrophotometer to return 
to an identical wavelength in a repeatable manner using 
a holmium oxide standard. A holmium oxide solution 
prepared in dilute perchloric acid has well defined 
absorption peaks throughout the UV-visible range. 
These peaks are a property of the material and serve as a 
wavelength standard. The wavelengths and tolerance 
values are cannot be changed.

Photometric Accuracy 
(Customized)

Automates the comparison of measured absorbance (or 
%T) of photometric accuracy standards with their 
certified values. Use Photometric Accuracy standards 
calibrated to known absorbance values at specified 
wavelengths. If a custom standard is being used instead 
of a CVC, enter its wavelength, absorbance and 
tolerance values in the boxes to the right.

Resolution (Toluene/Hexane) Measures the ability of the spectrophotometer to resolve 
adjacent features in a spectrum. Use a 0.02% (v/v) 
solution of toluene in hexane and a hexane blank. The 
wavelengths and tolerance values cannot be changed.

Stray Light (KCl, 198 nm), Stray 
Light (KI, 220 nm), Stray Light 
(NaI, 220 nm), and Stray Light 
(NaNO2, 340 nm)

Compare measured stray light at the indicated 
wavelength with the allowed range of values. Use the 
Stray Light standard designed to measure stray light at 
the indicated wavelength.

Photometric Noise: 0A 
(260 nm), Photometric Noise: 
1A (260 nm), and Photometric 
Noise: 2A (260 nm)

Measure the amount of noise at 260 nm. For 
Photometric Noise: 0A (260 nm), use an empty cell 
holder. For the latter two tests, use a 1A and 2A 
metal-on-quartz filters suitable for the UV region for 
these tests.

Baseline Flatness (Abs, 
800-200 nm)

Measures the flatness of a baseline scan over the region 
800 nm to 200 nm with smoothing applied to the data. 
Use an empty cell holder.

Photometric Drift Measures the absorbance drift of the instrument over a 
one-hour period. Use an empty cell holder and let the 
instrument warm up fully before initiating this test.

Test Description
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Related Topics

Overview of PV

Running PV Tests

Running PV Tests
To run PV tests

1. Click Performance Verification in the right pane in Home.

The available tests appear in the right pane.

2. Select the tests to run.

To select or deselect all the listed tests, double-click Run above the column of check 
boxes.

3. For selected tests that require it, enter information such as wavelength, value and 
tolerance in the provided boxes.

Heed the following precaution if using an accessory:

Languages

Note  Select the Classic group in Home if Performance Verification is not available 
for the current group.

Note  The CVC performance tests appear only when a CVC is properly installed and 
a valid calibration file has been loaded. See Calibrated Validation Carousel (CVC) for 
instructions. The available tests depend on the type of CVC installed.

Note  Tests that require the Mercury Lamp Calibration accessory can be selected only 
after the accessory has been properly connected and installed in the instrument.

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
operation.

ATTENTION  Évitez tout risque de pincement. Gardez vos mains, ainsi que tout objet, à 
l’écart de l’accessoire pendant l’initialisation.
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4. Click Run.

5. Follow the instructions that appear.

To end the tests before they are finished, click Stop. Alternatively, click Cancel when a 
prompt appears during a test.

The test results appear in a window from which they can be printed or copied. A 
signature block appears at the end.

Completed PV reports are saved automatically and appear on the PV Reports tab in My 
Data. See My Data for instructions for viewing results later.

6. Click Close.

Related Topics

Overview of PV

PV Test Descriptions

VORSICHT  Quetschungen sind zu vermeiden. Hände und Objekte sind während der 
Initialisierung vom Zubehör fern zu halten.

CAUTELA  Evitare il rischio di pizzicamento. Tenere mani e oggetti lontano dall’accessorio 
durante l’inizializzazione.

PRECAUCIÓN  Evite riesgos de atrapamiento. Mantenga manos y objetos lejos del alcance 
del accesorio durante la inicialización.
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INSIGHT Security Software

Optional INSIGHT Security software adds features for digitally signing files and verifying 
digital signatures, as explained in this Help system.

INSIGHT Security software, together with Thermo Security Administration software, also 
lets the system administrator set system policies and control user access to INSIGHT software 
features. See Access Control and System Policies for complete information.

To see information about the signature status of the current workbook, click any of these 
icons.

If INSIGHT Security software is installed...

• The root directory for template groups shown on the Preference tab in Options is set 
using Thermo Security Administration.

• A Sign button appears in the Performance Verification report window. Use it to sign the 
displayed report.

Related Topics

Signing a File

Verifying a Signature

This icon at the bottom of the INSIGHT window indicates that the current 
workbook is signed.

This icon indicates that current workbook has not been signed since it was last 
changed.

This icon indicates that current workbook has not been saved (or signed).
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Signing a File
If INSIGHT Security software is installed, use the following procedures to digitally sign 
workbook and template files. The visible portion of a digital signature consists of a user name, 
a date and a stated reason for signing. A digital signature also contains encrypted information 
used to detect whether the file has changed since it was signed.

To sign the open workbook

1. Choose Security (menu) > Sign > Active Workbook.

2. Enter a password.

3. Select a signature reason (if permitted).

4. Choose OK.

A verification message appears.

5. Choose OK.

To sign a saved workbook

1. Choose Security (menu) > Sign > Workbook File.

2. Locate and select the desired file and then click Open.

3. Enter a password.

4. Select a signature reason (if permitted).

5. Choose OK.

A verification message appears.

6. Choose OK.

To sign a saved template

1. Choose Security (menu) > Sign > Template File.

2. Locate and select the desired file and then click Open.

3. Enter a password.

4. Select a signature reason (if permitted).

5. Choose OK.

A verification message appears.

6. Choose OK.
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Related Topics

INSIGHT Security Software

Verifying a Signature

Verifying a Signature
If INSIGHT Security software is installed, use the following procedures to verify digital 
signatures for workbook and template files.

To verify the signature for a workbook

1. Choose Security (menu) > Verify Signature > Workbook File.

2. Locate and select the desired file and then click Open.

A verification message appears.

3. Choose OK.

To verify the signature for a template

1. Choose Security (menu) > Verify Signature > Template File.

2. Locate and select the desired file and then click Open.

A verification message appears.

3. Choose OK.

Related Topics

INSIGHT Security Software

Signing a File

Access Control and System Policies
The Access Control features and System Policies described below are available in Security 
Administration for INSIGHT software when INSIGHT Security software is installed.

Use the Access Control features to set the rights of individual users or groups of users to use 
the protected features of INSIGHT software (the features included in the security database). 
A protected feature will be available only if the logged-in user has the right to use it.

See “Controlling access to client application features” in the “Using Security Administration” 
chapter of the Security Administration User’s Guide for instructions for using the Access 
Control features. See “Setting system policies for the client application” in that chapter for 
instructions for using the System Policies features.
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After specifying access control and setting the policies, save the settings in the security 
database. See “Saving your security policy settings” in the “Using Security Administration” 
chapter of the Security Administration User’s Guide for details.

Feature Description

Ability to tun INSIGHT Specifies which users can run INSIGHT software. (See 
“Controlling access to client application features” in the 
“Using Security Administration” chapter of the Security 
Administration User’s Guide for general instructions.) If a user 
has not been granted the ability to run the software, an error 
message appears when the user attempts to start it.

Ability to delete workbooks Specifies which users can delete workbook files with the 
Delete button in My Data.

Ability to delete PV reports Specifies which users can delete Performance Verification 
reports with the Delete button in My Data.

Ability to delete templates Specifies which users can delete template files with the Delete 
button in My Data.

Ability to delete Scan 
samples

Specifies which users can delete Scan sample data files from 
the current workbook by right-clicking a sample in the results 
table in Measure Scan and choosing Remove.

Ability to edit templates Specifies which users can set parameters in Settings.

Ability to configure reports Specifies which users can change settings in Reports.

Ability to perform PV tests Specifies which users can run Performance Verification tests.

Ability to perform 
wavelength calibration

Specifies which users can use the Wavelength Calibration 
buttons on the Calibrations tab in System Settings.

Ability to calibrate Sipper Specifies which users can use the Sipper Calibrate button on 
the Calibrations tab in System Settings.

Ability to calibrate Linear 
Cell Changer

Specifies which users can use the Linear Cell Changer 
Calibrate button on the Calibrations tab in System Settings.

Ability to update CVC 
calibration

Specifies which users can use the Load CVC Calibration 
button in Performance Verification.

Ability to select CVC tests 
to perform in PV

Specifies which users can select listed tests for the CVC in 
Performance Verification.

Math menu Specifies which users can use the commands in the Math 
menu.

Analyze menu Specifies which users can use the commands in the Analyze 
menu.

Ability to set Rate 
parameters

Specifies which users can set parameters in Settings for the 
Rate application.
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Options tabs Specifies which users can change settings on the tabs in 
Options.

System Settings tabs Specifies which users can change settings on the tabs in 
System Settings.

Authenticate on startup Requires users in the specified policy groups to enter a valid 
name and password when starting INSIGHT software.

Prevent overwriting of files Ensures that existing files are not overwritten when users in 
the specified policy groups save workbook or template files.

If a user for whom this policy is selected attempts to save a file 
using the same file name as an existing file, a message says the 
file cannot be overwritten. The user can choose OK to close 
the message and then save the file using a different file name.

If a user saves a file while this policy is selected, the file will be 
set to read-only in its properties. In the future, users will not 
be able to overwrite this file, even when this policy is not 
selected.

Prevent delete, rename and 
right-click in file dialog 
boxes

Prevents users in the specified policy groups from performing 
these operations in file dialog boxes:

• Deleting a file by selecting it and pressing the Delete key 
on the keyboard.

• Renaming a file by selecting its name (by slowly clicking 
the name twice) and typing a new name.

• Displaying a shortcut menu by right-clicking a file. 
Normally a menu displayed this way lets the user perform 
operations such as copying, deleting or renaming the file.

This policy can be used in conjunction with the Prevent 
changing directories when saving files policy (see below) to 
achieve the desired type of control over file operations for each 
user.

Prevent printing unsaved 
data

Prevents users in the specified policy groups from printing 
spectral data that has not been saved.

Prevent changing 
directories when saving files

Prevents users in the specified policy groups from changing 
directories (“browsing”) when saving files.

Feature Description
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Prevent signature reason 
entry when signing files

Prevents users in the specified policy groups from entering a 
custom signature meaning when signing a file.

When this policy is selected, only the standard signature 
meanings are available for the affected users.

When this policy is not selected, the prompt requesting a 
signature lets the user type a meaning in the Reason For 
Signature text box.

Require signature when 
saving workbook files

Requires users in the specified policy groups to provide a 
digital signature when saving workbooks with Save Workbook 
or Save As Workbook in the File menu. If this policy is not 
selected, users in the specified policy group must use Security 
(menu) > Sign > Active Workbook or Workbook File to sign a 
workbook after it has been saved.

Require signature when 
saving template files

Requires users in the specified policy groups to provide a 
digital signature when saving templates with Save Workbook 
Settings as Template in the File menu. If this policy is not 
selected, users in the specified policy group must use Security 
(menu) > Sign > Template File to sign a workbook after it has 
been saved.

Require signature when 
saving PV results

Requires users in the specified policy groups to provide a 
digital signature when saving Performance Verification results.

Directory for workbooks Designates for each policy group a directory for saving 
workbooks with Save Workbook or Save As Workbook in the 
File menu.

Directory for templates Designates for each policy group a directory for saving 
templates with Save Workbook Settings as Template in the 
File menu.

Feature Description
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Assigning Signature Meanings
Use the Signature Meanings features of Security Administration to specify the meanings that 
will be available for electronic signatures supplied by specified users. For example, the 
Signature Meanings features can be set so that only a particular user—for instance, the lab 
manager—is allowed to sign a file with the “Approval” meaning.

The default list of signature meanings appears when the Signature Meanings icon for 
“INSIGHT” is clicked in the navigation pane the first time Security Administration is run. If 
changes have been made to the list, the available meanings in INSIGHT software may be 
different. See “Assigning signature meanings” in the “Using Security Administration” chapter 
of the Security Administration User’s Guide for general instructions for using the Signature 
Meanings features to change the available meanings or to specify which users can select each 
meaning when signing a file.

Use the signature meanings in the default list as follows.

Directory for PV reports Designates for each policy group a directory for automatically 
saving Performance Verification reports.

Allow access only to listed 
button groups (blank field 
allows access to all groups)

Specifies the INSIGHT software user groups that are available 
to users in the specified policy group. Selecting a user group in 
Home displays the application buttons for that group. See 
Applications Tab for more information.

Type the desired user groups in the text box in the Description 
box, with a comma and a space between them; for example:

Classic, Quality Control

In this example, these users would have access to the 
applications for the Classic group (Fixed, Scan, Quant, Rate, 
Bio Applications and Performance Verification) and the 
applications for the Quality Control group.

Leave the text box blank to give users in the specified policy 
group access to all applications.

Feature Description

Note  Users can be allowed to enter custom signature meanings. See “Prevent signature 
reason entry when signing files” in Access Control and System Policies.
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Signature Meaning Description

Authorship - signifies ownership Indicates that the user signing the file is the person who 
created it.

Approval - the record is 
approved for use

Indicates that the user signing the file has approved it for 
use.

Reviewed - record contents have 
been reviewed

Indicates that the user signing the file has reviewed it.

Revision - the record has been 
revised

Indicates that the user signing the file has changed it.
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Numerics
15 Degree Specular Reflectance accessory  239
20 Degree Specular Reflectance accessory  241
30 Degree Specular Reflectance accessory  243
45 Degree Specular Reflectance accessory  245
60 Degree Specular Reflectance accessory  247
8 Degree NN Specular Reflectance accessory  237
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access control  457, 459
access cover

instrument detector  114
mercury lamp  114
sample compartment  112
tubing  112

accessories
aligning  99
parameters  44, 50, 66, 71, 144, 155, 166, 175, 185, 196, 207, 

218
standard  118
status  23
tubing connectors  113

Accessories tab
cell changer settings  360, 400
Fixed  44
Nucleic Acid  144
Nucleic Acid Labels  155
Peltier Single Cell Holder settings  322
Pierce 660 nm Protein Assay  218
Pierce BCA  185
Pierce Modified Lowry  207
Protein A280  166
Protein Biuret  229
Protein Bradford  196
Proteins & Labels  175
Quant  66
Rate  71
Scan  50
Smart Sipper settings  418
Temperature Probe settings  434

accessories, manual
installing  120
removing  121

accessories, Smart
installing  121
removing  124

accessories, thermostatted
installing  124

accessory
diffuse reflectance  271
near normal specular reflectance  237
specular reflectance  239, 241, 243, 245, 247
transmission  441

AccuVac vial sample holder  348
acid-compatible tubing pack  407
acids

precautions with nanoCell  287
acoustic alarm  308
acquiring data  24–25, 31, 146, 157, 167, 176, 187, 197, 208, 
220, 230

action buttons  13
adapter

for 15 mm z-height instruments and nanoCell  283
tubing  113, 125, 291

adapters
for connecting tubing  113

Add  82
adding

constant to spectrum  89
group  96
spectra  82

advanced equations for Quant  98
AFBG option, Bandwidth setting  266
air bubbles

and Smart Sipper sampling  418
and VERSA Probe sampling  446

air, for instrument purge  117
alarm

acoustic  308
water level  301, 309

Index
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Index: B

aligning
accessory  99
detector module  134
Fiber Optic Module  268
single cell holder  119

Alignment tab  99
Analyze menu  21, 88–89
annotation  15
antistatic wipes, for cleaning touchscreen  132
application  9

action buttons  13
associating with group  96
data display  15
Fixed  9, 42
Nucleic Acid  138
Nucleic Acid Labels  150
parameters  41
Pierce 660 nm Protein Assay  212
Pierce Modified Lowry  201
Protein A280  160
Protein Bradford  190
Proteins & Labels  169
Quant  10, 25
Rate  10, 68
sample measurement  24
Scan  10, 46
task buttons  12

application buttons  14
Application Focused Beam Geometry option

Bandwidth setting  266
applications

life science  137
Applications tab  96
area

peak  38
arithmetic operations for Quant equations  58
Auto Trigger  97
Average  88
averaging

concentration  67, 144, 155, 166, 175, 185, 196, 207, 218, 229
spectra  88

axis
attributes  15

B
background  42, 46
backing up

CVC calibration data  252
bandwidth  42, 46, 65, 70, 143, 154, 165, 174, 184, 195, 206, 
217, 228

Bandwidth setting

and AFBG option  266
for fiber optic sampling  267

bandwidth test
with Hg Lamp  275

baseline
correcting  48
flatness  452
measuring with nanoCell  280

Baseline button  13
baseline scan

initiating from instrument keypad  130
bases, precautions with nanoCell  287
beam height

adapter for nanoCell  283
cell holder for 15 mm  343
spectrophotometer  107

beam path
nanoCell  281

block temperature
for Peltier Single Cell Holder  323

boot record
System tab  101

bubbles
and Smart Sipper sampling  418
and VERSA Probe sampling  446

button
Enter  130
Function  130
Power  130
Run  130
Stop  130
Zero/Base  130

C
cable

connecting fiber optic detector  265
fiber optic test  263
precaution for connecting detector  133
remote start  445
routing to sample compartment  113, 116
shielding USB  110
unplugging Hg lamp  277

cables, fiber optic
attaching  266
test  263

calibrated pipette
and nanoCell  285

calibrated standard  48
Calibrated Validation Carousel  249
calibrating

instrument wavelength  100
Smart Linear 8-Cell Changer  358
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Index: C

Smart Peltier Linear Cell Changer  380
Smart Sipper  415
wavelength with Hg Lamp  277

calibration
wavelength  275
when to calibrate wavelength  277

calibration data
loading CVC  252

Calibrations tab  100
carousel

installing CVC  250
installing Smart Rotary  398

caustic samples
protecting instrument from  116

caution
pinch hazard  355, 377, 399, 410, 412, 415
UV radiation hazard  115, 132, 265

cell
aligning micro  341
cleaning flow cells  421
compatible with Smart Sipper  413
for Peltier Single Cell Holder  319
for Smart Peltier Linear Cell Changer  376

cell changer
CVC  249
Smart Linear 8-Cell  353
Smart Peltier Linear  367
Smart Rotary  395
status monitor  404

Cell Changer tab
Smart Linear settings  360
Smart Peltier Linear settings  389
Smart Rotary settings  400

cell holder
alignment  119
available reference  339
available sample  341
cylindrical reference  339
cylindrical sample  344
for 15 mm beam height cells  343
for nanoCell  283
for solids  345
for test tubes and vials  349
installing  120–121, 124, 126, 357, 398
rectangular reference  339
rectangular sample  341
removing  356, 399
rotatable  347
standard reference  119
standard sample  119
variable pathlength rectangular  350
variable pathlength slide  351
water thermostatted sample  342

certificate of calibration
storing  252

chemicals
precautions for  106

cleaning
fiber optic probes  334
flow cells  421
instrument exterior  131
instrument touchscreen  132
nanoCell  287
Peltier Recirculator  306
Peltier Single Cell Holder  328
Smart Linear 8-Cell Changer  364
Smart Peltier Linear Cell Changer  393
Smart Rotary Cell Changer  405
Smart Sipper  420
Temperature Probe  438
VERSA Probe  449

closing
reference compartment door  107
sample compartment door  107

color
axis  15
spectrum  15

company name  96
comparison operations for Quant equations  58
compartment

reference  107
sample  107

compartment, reference
cleaning  131
installing cell holder in  126

compartment, sample
cleaning  131
installing manual accessory in  120
installing Smart Accessory in  121
installing thermostatted accessory in  124

compliance label  104
component

concentration  53, 141, 152, 162, 172, 181, 192, 203, 214, 225
INSIGHT software  108
keypad  108
molecular weight  53
name  53, 141, 152, 162, 172, 181, 192, 203, 214, 225
reference compartment  107
sample compartment  107
touchscreen  108

computer
connector  109
external  108
remote  129
switching between local and remote  129

computer control  108
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Computer Control instrument
setting up  127
turning off  127

computer, remote
attaching to Local Control instrument  129
switching control to  129

concentration
averaging  67, 144, 155, 166, 175, 185, 196, 207, 218, 229
factor  148, 159
limits  67, 144, 155, 166, 175, 185, 196, 207, 218, 229
nucleic acid  139
unit  53, 141, 152, 162, 172, 181, 192, 203, 214, 225

connecting
computer  127
detector cable  133
external computer  109
external trigger  110
fiber optic detector  265
fiber optic probes  266
mercury lamp  109, 276
power cord  109
purge gas  118
recirculator  125
remote start cable  445
USB devices  110

connector  109
external trigger  110
external tubing  112
for Smart Accesories  111
instrument detector  114
internal tubing  113
mercury lamp  109, 114
power cord  109
purge  109
remote computer  109
USB  110

connector, electrical
routing to sample compartment  113

connectors
for fiber optic cables  266

constant from spectrum  89
contact closure trigger  110
control

local or computer  108
switching from local to remote  129

control limits  42, 46
conventions  3
Convert Spectra  81
copying

CVC reports  255
quantitative analysis results  26, 28

cord
routing to sample compartment  113, 116

correction
Nucleic Acid  141
pathlength for nanoCell  288
quantitative analysis  53, 141, 152, 162, 172, 181, 192, 203, 

214, 225
Correction tab

Scan  48
corrosion protection  116
cover

instrument detector  114
mercury lamp  114
reference compartment  107
sample compartment  107

CUE script
running from instrument keypad  130

CVC  249
available tests  253
copying, printing and saving reports  255
initializing  251
installing  250
installing carousel  250
loading calibration data  252
maintaining  258
proper handling for standards  249
recertifying  258
running performance tests  253
standards  249
storing  258
test limits  253
test results  256
viewing reports  256

cycle time  69
cylindrical cell holder

reference  339
cylindricalcell holder

sample  344

D
data acquisition  24–25, 31, 146, 157, 167, 176, 187, 197, 208, 
220, 230

data display  15
data interval  42, 46, 65, 70, 143, 154, 165, 174, 184, 195, 206, 
217, 228

Data Store tab  97
data, CVC calibration  252
date  96
decimal digits  97
default values

life science applications  137
default workbook settings  21
deleting

group  96
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spectrum from workbook  21
workbook, template or PV report  74

Depolarizer accessory  259
Derivative  79
derivative  46, 65, 70

converting spectrum to  79
detector

access cover  114
access panel  116
connector, accessing  114
fiber optic module  263
installing  134
intensity  99
precaution for connecting cable  133
removing  133
routing cable  116
storing  134

detector compartment
and UV radiation hazard  115

detector side sample holder  345
devices

external keyboard  110
external mouse  110
high power USB  110
portable memory  110
printer  110
supported  110

diameter
for flow cell tubing  407
for fluid tubing  113
for purge tubing  118

dichromate, potassium
as CVC standard  249

diethylene triamine, precaution with nanoCell  287
diffuse reflectance accessory

integrationg sphere  271
digital signature  458

verifying  459
digits  97
directory  97
dividing

spectra  87
spectrum by constant  89

document
organization  2

drain
for sample and reference compartments  131

dry air or nitrogen, for instrument purge  117
duplicate standard  63, 183, 194, 205, 216, 227
duplicates  26, 28
dust

precautions for  106

removing from CVC standards  258
removing from touchscreen  132

dwell time  69
Dye Chromophore Editor  150, 170
DYMO printer  97

E
editing

CUE scripts  130
label  19

e-mailing
data files  4
workbook  21, 97

Enter keypad button  130
equations for Quant  98
equilibration time  323
ethylamine, precaution with nanoCell  287
Evolution 200 spectrophotometer

models  103
exporting

Measure Rate results  21
report  75

external
computer  108
computer connector  109
instrument connectors  108

extinction coefficient  53, 148, 159

F
Factor  89
factor, correction for nanoCell  289
FEP tubing

for Sipper flow cells  407
Ferrite ring

for shielding USB devices  110
Fiber Optic accessory

aligning  268
attaching cables and probes  266
Bandwidth setting  268
compatible probes  266
components  263
filter setting  268
installing  264
maintenance  267
operating  267
operating precautions  263
radiation hazard from coupled cables  263
radiation hazard in detector compartment  264
routine maintenance  268
storing  264
troubleshooting  270
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fiber optic cables
operating precautions  331

fiber optic probes
cleaning  334
installing  332
maintaining  334
operating  333
operating precautions  331
remote start cable  333
safety considerations  331
UV radiation hazard  332
VERSA Probe  443

fiber optic sampling
with Fiber Optic Module  267
with nanoCell  281

fiber optic test cable
proper handling  264

file
CVC calibration  252

File menu  21
films sample holder  347
filter holder  347
Filter setting

for Fiber Optic Module  268
filter, purge gas  117
filters

as CVC standards  249
fingerprints

removing from touchscreen  132
firmware

updating  101
Fixed  9

Accessories tab  44
data acquisition parameters  42
Instrument tab  42
Samples tab  45

fixed kinetics data acquisition  32
fixed position sample slide holder  345
flammable gases

precautions for purge  117
flanged tubing

for Sipper flow cells  414
flow cell

cleaning  421
compatible with Smart Sipper  413
installing in Smart Sipper  413
installing screw-cap  414
replacing tubing  422
tubing materials  407

fluid
external connectors  112
internal connectors  113

fluorinated ethylene polymer tubing
for Sipper flow cells  407

font  96
footer  96
Formula and Units tab  98
formulas for Quant  98
front panel

sample compartment, removing  112
function buttons

for switching control to remote computer  129
Function keypad buttons  130
functions

keypad  130
functions for Quant  53, 58
fuse

changing Peltier Recirculator  298
changing Peltier Single Cell Holder  318
changing Smart Peltier Linear Cell Changer  375

G
gas

installing for purge  118
precautions for purge  117

gasket
replacing for temperature probe stopper  438

goggles, safety  132
protection from UV radiation  264

Grazing Angle Specular Reflectance accessory  261
grid  15
group  14

adding or deleting  96
applications  96

H
Hach cell sample holder  348
hazard

explosion  117
pinch  251, 254, 355, 410, 412
UV radiation  264–265, 444
UV radiation in detector compartment  115
UV radiation in mercury lamp compartment  113

header  96
height of peak  37
Help

organization  2
Help menu  21
Hg lamp

access cover  114
connector  109, 114
description  273
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disconnecting  277
for wavelength calibration  100
installing  275
operating  275
operating precautions  275
safety considerations  273
UV radiation hazard  113

hiding
label  19

high power USB devices  110
holmium perchlorate, as CVC standard  249
Home button  12

I
icon

Peltier Single Cell Holder temperature status  324
Smart Linear 8-Cell Changer status  363
Smart Peltier Linear Cell Changer temperature status  385
Temperature Probe status  436

importing
CVC calibration data  252
spectrum  21
standards  28

indicator
power  127–129

initializing
CVC  251
instrument  127–129
Smart Linear 8-Cell Changer  359
Smart Peltier Linear Cell Changer  381
Smart Rotary Cell Changer  399

INSIGHT Security  457–459, 463
INSIGHT software  101

for Evolution 200 series spectrophotometer  108
INSIGHT window  11

navigation pane  12
right pane  14

installation qualification  24
installing

CVC  250
CVC carousel  250
fiber optic cables  266
Fiber Optic Module  264
fiber optic probes  266, 332
Hg Lamp  275
instrument detector  134
manual accesory  120
nanoCell  279
Peltier Recirculator  299
Peltier Single Cell Holder  319
purge gas  118
purge gas filter  117

reference cell holder  126
sample cell holders  120
sample compartment windows  116
Sipper flow cell  413
Sipper pump tubing  410
Smart Accessory  122
Smart Linear 8-Cell Changer  355
Smart Peltier Linear Cell Changer  376
Smart Rotary Cell Changer  397
Smart Rotary Changer cell holder  398
Smart Sipper  411
Temperature Probe  432
thermostatted accessory  124
VERSA Probe  444
VERSA Probe tips  446

instrument  130
cleaning exterior  131
cleaning touchscreen  132
computer  109
Computer Control  126
corrosion protection  116
Enter button  130
initalizing  127–129
installing detector  134
installing manual accessories  120
installing reference holder  126
installing Smart Accessories  121
installing thermostatted accessories  124
keypad buttons  108
keypad functions  130
keypad shortcuts  131
lifting or moving  106
Local Control  128
major components  106
operating precautions  106
ordering parts  135
performance verification  451–452, 454
removable panels  111
removing detector  133
repairing  5
routine maintenance  131
Run button  130
running CUE scripts from keypad  130
safety considerations  103
safety label locations  104
setting up  126
standard cell holders  118
Stop button  130
Zero/Base button  130
z-height  107

Instrument Local parameter  129
instrument status monitors  23
Instrument tab
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Fixed  42
Nucleic Acid  143
Nucleic Acid Labels  154
Pierce 660 nm Protein Assay  217
Pierce BCA  184
Pierce Modified Lowry  206
Protein A280  165
Protein Biuret  228
Protein Bradford  195
Proteins & Labels  174
Quant  65
Rate  70
Scan  46
settings for fiber optic sampling  267

instrument, Computer Control
setting up  127
turning off  127

instrument, Local Control
attaching remote computer  129
setting up  128
switching INSIGHT between local and remote  131
turning off  130

Integrated Fiber Optic Module  263
Integrating Sphere Diffuse Reflectance accessory  271
integration time  42, 46, 65, 69–70, 143, 154, 165, 174, 184, 195, 
206, 217, 228

intensity crossings  47
iodide, sodium

as CVC standard  249
IQ  24

K
keyboard

connecting  110
Local Control instrument  11
right-clicking with  11
shortcuts  101

keypad
buttons  108
location  107
operation  130
shortcuts  131

keypad button
Enter  130
Function  130
Power  130
Run  130
Stop  130
Zero/Base  130

kinetics  31
data acquisition  32, 34

L
labels  15, 19

safety  104
Lamp tab  101
lamp, mercury  273

access cover  114
connector  109
for wavelength calibration  100

lamp, xenon
status  101

layout  96
left pane

action buttons  13
task buttons  12

left side sample holder  345
legend  15
lid, nanoCell

installing  280
life science applications  137

default values  137
Nucleic Acid  138–139, 145–146
Nucleic Acid Labels  150, 156–157
Pierce 660 nm Protein Assay  212–213, 219–220
Pierce BCA  179, 186–187
Pierce Modified Lowry  201–202, 208
Protein A280  160, 167
Protein Biuret  230
Protein Bradford  190–191, 197
Proteins & Labels  169, 176

light beam
height  107

light path
nanoCell  281, 289

limits
for CVC tests  253

liquid thermostatted accessories
connecting tubing  112
installing  124

loading
CVC calibration data  252
sample  45, 50

Loading Guide
and Run button  130
and Smart Linear 8-Cell Changer  360
and Smart Peltier Linear Cell Changer  390
and Smart Rotary Cell Changer  401
and Stop button  130

Local Control instrument  101, 108
cleaning touchscreen  132
keyboard  11
setting up  128–129
switching INSIGHT software to  129
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touchscreen  108
turning off  130

logarithmic functions for Quant equations  58
logical operations for Quant equations  58
logo  96
low volume tubing

for Sipper flow cells  407

M
magnets

precaution for Hg Lamp  273
maintenance

cleaning instrument  131
cleaning touchscreen  132
CVC  258
Fiber Optic Module  267
fiber optic probe  334
installing instrument detector  134
nanoCell  287
Peltier Recirculator  306
Peltier Single Cell Holder  328
removing instrument detector  133
Smart Linear 8-Cell Changer  364
Smart Peltier Linear Cell Changer  392
Smart Rotary Cell Changer  405
Smart Sipper  420
Temperature Probe  437
VERSA Probe  449

manual accessories
installing  120
removing  121

Math menu  21, 77, 79, 81–82, 84–85, 87
maximum values

finding  47, 91
Measure button  13
measurement

initiating from instrument keypad  130
stopping from instrument keypad  130

measurement functions for Quant equations  58
measurement results  21
Measurement tab

Nucleic Acid  141
Nucleic Acid Labels  152
Pierce 660 nm Protein Assay  214
Pierce BCA  181
Pierce Modified Lowry  203
Protein A280  162
Protein Biuret  225
Protein Bradford  192
Proteins & Labels  172
Quant  53
Rate  69

Scan  47
measuring samples  24

with CVC  253
with fiber optic accessories  267
with nanoCell  279
with Peltier Single Cell Holder  321
with Smart Linear Cell Changer  360
with Smart Peltier Linear Changer  390
with Smart Rotary Changer  401
with Smart Sipper  418
with Temperature Probe  434
with VERSA Probe  446

mechanical shock
precautions for  106

melting point  148, 159
memory

failure  329, 394
memory device

connecting  110
memory failure

for Peltier Recirculator  310
menus  21
Mercury Lamp  273

disconnecting  277
installing  275
operating  275
operating precautions  275
PV tests  276
safety considerations  273
storing  275
UV radiation hazard  275

mercury lamp
access cover  114
connector  109
for wavelength calibration  100
UV radiation hazard  113

Mercury Lamp compartmart
UV radiation hazard  275

methylene chloride, precaution with nanoCell  287
microcuvettes

aligning  119, 341
minimum r squared  63, 183, 194, 205, 216, 227
minimum values

finding  47, 91
module, detector

installing  134
removing  133
storing  134

moisture
precaution for CVC  249
precaution for Fiber Optic Module  263
precaution for instrument  106
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precaution for nanoCell  287
precaution for Smart Linear 8-Cell Changer  364

molecular weight  53, 148, 159
component  53

monochromator side sample holder  345
mouse

connecting  110
moving

label  19
multiplying

spectrum by constant  89
My Data  74

N
Name and Type tab

Rate  68
nanoCell accessory

and instrument z-height  283
and sample pathlength  282
beam path  281
cleaning  287
compatible cell holders  283
components  279
do not submerge precaution  279
frequently asked questions  289
high background signal  286
installing lid  280
loading samples  285
measuring baseline or zero  280
measuring samples  279–280, 286
pathlength correction factors  288
positioning cells  279
sample volume  284
storing  287
theory of operation  281
wavelength range  283

navigation pane  12
neutral density filter, as CVC standard  249
nitrogen, for instrument purge  117
noise  42, 46
Normalize  84
normalizing spectrum  84
Norprene tubing, chemical compatibility  423
Nucleic Acid

Accessories tab  144
application  139, 145–146
Instrument tab  143
Measurement tab  141
overview  138
Samples tab  144
Type tab  140

nucleic acid  138

concentration  139
purtiy  139

Nucleic Acid Labels  156–157
Accessories tab  155
Instrument tab  154
Measurement tab  152
overview  150
Samples tab  155
Type tab  151

nucleic acids
measuring  146

number of cycles  69
number of samples  45, 50, 67, 72, 144, 155, 166, 175, 185, 196, 
207, 218, 229

O
off button

for Computer Control instrument  127
for Local Control instrument  130

off switch  109
oil

removing from touchscreen  132
Oligo Calculator  148, 159
on switch  109
opening

reference compartment door  107
sample compartment door  107
workbook, template or PV report  74

operating precautions  106
optical cables

attaching  266
optical fiber

test  263
Options  96
ordering parts  135
O-ring

replacing for temperature probe stopper  438
overlaying spectra  14–15

P
page

layout  96
number  96

panel
for external tubing connectors  112
sample compartment front  112
sample compartment side  116

panels
removable  111

parts
ordering  135
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path  74, 97
pathlength  140, 151, 161, 170, 180, 192, 202, 213, 224

cell holder slide for variable  351
nanoCell  282
Peltier Single Cell Holder  319
rectangular cell holder with variable  350
Smart Linear Cell Changer  353
Smart Peltier Linear Changer  376
Smart Rotary Cell Changer  395
VERSA Probe  443

pathlength correction factors
for nanoCell  288

peak
area  38
height  37

peak area tool  38
Peak Pick  91
peak/valley measurement tool  37
peaks

finding  47, 91
Peltier

linear changer  367
recirculator  291
single cell holder  311

Peltier Recirculator
acoustic alarm  308
Alarm Mode  305
back panel  293
changing fuse  298
cleaning  306
components  291
dimensions  296
environmental conditions  296
filling reservoir  307
front panel  293
installing  299
maintaining  306
Normal Mode  303
operating  301
other failures  310
resetting water level alarm  309
safety considerations  292
specifications  294
Standby Mode  302
system failures  310
troubleshooting  308
voltage selector  297
voltage setting  298
water level alarm  301
water level failure  309

Peltier Single Cell Holder
changing fuse  318
cleaning  328

components  311
cuvettes  319
dimensions  315
displaying temperature status monitor  323–324
environmental conditions  316
front panel  313
installing  319
maintaining  328
measuring samples  328
normal mode  326
rear panel  313
safety considerations  312
sample volume  319
specifications  314
standby mode  326
startup mode  325
troubleshooting  329
using INSIGHT to operate  322
using Peltier to operate  325
voltage selector  317
voltage setting  318

perchlorate, holmium
as CVC standard  249

Performance Verification  451, 454
combining reports  257
opening reports  257
report  74
test descriptions  452
viewing reports  256

performance verification
with CVC  249

Performance Verification test
CVC  253
wavelength accuracy  276
wavelength reproducibility  276

phosphoric acid, precaution with nanoCell  287
photometric accuracy  452
photometric drift  452
Pierce 660 nm Protein Assay  213, 219–220

Accessories tab  218
Instrument tab  217
Measurement tab  214
overview  212
Samples tab  218
Standards tab  216
Type tab  213

Pierce BCA  179, 186–187
Accessories tab  185
Instrument tab  184
Measurement tab  181
Samples tab  185
Standards tab  183
Type tab  180
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Pierce Modified Lowry  202, 208
Accessories tab  207
Instrument tab  206
Measurement tab  203
overview  201
Samples tab  207
Standards tab  205
Type tab  202

pipette, calibrated
and nanoCell  285

polytetrafluoroethylene tubing
for Sipper flow cells  407

portable memory
connecting  110

ports
for cords and cables  113
for external tubing  112
for internal tubing  113

potassium dichromate, as CVC standard  249
power

button  130
connector  109
switch  109

Power button  130
power indicator  127–129
powering off

Computer Control instrument  127
Local Control instrument  130

precautions
explosion hazard  117
operating for instrument  106
safety for instrument  103
shock hazard  110
UV radiation hazard  113–114

Preferences tab  97
previewing report  21, 75
Print button  13
printer

connecting  110
printing

CVC reports  255
report  21, 75, 96

probe
Temperature Probe  431
trigger connector  110

probes, fiber optic
aligning  268
attaching  266
compatible  266
VERSA Probe  443

properties of spectrum  21
protecting

against electrical shock  110
against explosion hazard  117
against UV radiation hazard  132
against UV radiation in detector compartment  115
against UV radiation in mercury lamp compartment  113
instrument from corrosion  116
USB cables  110

Protein A280  167
Accessories tab  166
Instrument tab  165
Measurement tab  162
overview  160
Samples tab  166
Type tab  161

Protein Biuret  230
Accessories tab  229
Instrument tab  228
Measurement tab  225
Samples tab  229
Standards tab  227
Type tab  224

Protein Bradford  191, 197
Accessories tab  196
Instrument tab  195
Measurement tab  192
overview  190
Samples tab  196
Standards tab  194
Type tab  192

Proteins & Labels  176
Accessories tab  175
Instrument tab  174
Measurement tab  172
overview  169
Samples tab  175
Type tab  170

PTFE tubing
for Sipper flow cells  407

pump
replacing tubing  421
specifications  427
troubleshooting  428
tubing chemical compatibility  423
tubing specifications  426

pump tubing
and storing Smart Sipper  410–411
chemical compatibility  423
installing  410
replacing  421
specifications  426

purge
and subambient temperature samples  117
explosion hazard  117
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installing  118
purge connector  109
purge gas

specifications  117
purging

sample compartment  117
purity

nucleic acid  139
PV  451, 454

test descriptions  452
PV reports

directory for saving  97

Q
Quant  10

Accessories tab  66
data acquisition parameters  51
formulas and units  98
functions  58
Instrument tab  65
Measurement tab  53
parameters  25
sample analysis  26, 28
Samples tab  67
Standards tab  63
Type tab  52

quantitative analysis  25–26, 28
settings  51

quartz tip
for VERSA Probe  446

R
r squared  63, 183, 194, 205, 216, 227
radiation hazard  264

for fiber optic probes  332
for installing Hg Lamp  275
in detector compartment  115
in mercury lamp compartment  113

radiation safety label
detector compartment  105
mercury lamp compartment  105

Rapid Mix Accessory  337
Rate  10, 31

Accessories tab  71
data acquisition  32, 34
data acquisition parameters  68
exporting results from  21
Instrument tab  70
Measurement tab  69
Name and Type tab  68
Rate Calculations tab  72

Samples tab  72
Type tab  68

Rate Calculations tab  72
Ratio  87
ratioing spectra  87
reagents  179, 191, 213
recertifying

CVC  258
recirculator

and Smart Linear 8-Cell Changer  353
and Smart Peltier Linear Cell Changer  367
and Smart Rotary Cell Changer  395
and water thermostatted sample cell holder  342
connecting to instrument  125
Peltier  291

rectangular reference cell holder  339
rectangular sample cell holder  341

variable pathlength  350
water thermostatted  342

reduced volume cuvettes
aligning  341

reference cell holder
cylindrical  339
installing  126
rectangular  339
standard  119

reference cell holders
available  339

reference compartment
cleaning  131
installing cell holder in  126
location  107
opening and closing  107

reference correction  48
reference detector

intensity  99
reference sample

cell holder for measuring  119
reference wavelength correction  42
reflectance accessory

15 degree specular  239
20 degree specular  241
30 degree specular  243
45 degree specular  245
60 degree specular  247
8 degree near normal specular  237
grazing angle  261
integrating sphere  271

region
finding peaks in  47, 91
limiting  39

region-threshold tool  39



478 Evolution 200 Series User Guide  Thermo Scientific

Index: S

remote computer
attaching to Local Control instrument  129
switching control to  129

remote start cable
for fiber optic probes  333
for VERSA Probe  445

removable panels  111
removing

Hg lamp  277
instrument detector  133
manual accessory  121
sample compartment windows  116
Smart Accessory  124
Smart Rotary Changer cell holder  399

repairing instrument  5
replicate standard  63, 183, 194, 205, 216, 227
replicates  26, 28
report

adding sample data to  14
layout  96
printing  21
signing  457

Report Master Page tab  96
reports  75

combining CVC  257
copying, printing and saving CVC  255
viewing CVC  256

reservoir
filling  307

reset
for Peltier Recirculator water level alarm  309

resetting
CVC  251
Peltier Recirculator alarm  305
Peltier Single Cell Holder alarm  326
Smart Linear 8-Cell Changer  359
Smart Peltier Linear Call Changer  381
Smart Peltier Linear Changer alarm  386
Smart Rotary Cell Changer  399

resetting template settings  41
resolution  452
right pane  14
right side sample holder  345
right-clicking using touchscreen keyboard  11
rotatable

test tube and cell holder  347
rotating label  19
Run button  130

S
safety

label locations  104
lifting or moving instrument  106
removing and installing detector  132
using CVC  254
using Fiber Optic Module  263
using fiber optic probes  331
using Hg Lamp  273
using mercury lamp  113
using Peltier Recirculator  292
using Peltier Single Cell Holder  312
using Smart Linear 8-Cell Changer  354
using Smart Peltier Linear Cell Changer  368
using Smart Rotary Cell Changer  396
using Smart Sipper  407

safety considerations  103, 250, 283
safety goggles  132
safety interlock

for Hg Lamp  273
safety label

compliance  104
UV radiation  105

safety warning
explosion hazard  117
general operation  103
shock hazard  110
UV radiation hazard in detector compartment  115
UV radiation hazard in mercury lamp compartment  113

sample
legend  15
loading or saving  45, 50
measuring  24–25, 31, 146, 157, 167, 176, 187, 197, 208, 220, 

230
name  15, 45, 50, 67, 72, 144, 155, 166, 175, 185, 196, 207, 

218, 229
quantifying  25–26, 28

sample cell holder
10 mm rectangular  119
available  341
cylindrical  344
for 15 mm beam height cells  343
for 1-inch square cells  348
for test tubes and vials  349
installing  120
rectangular  341
variable pathlength rectangular  350
variable pathlength slide  351
water thermostatted  342

sample compartment
cleaning  131
connector  111
fluid ports  113
installing manual accessory in  120
installing Smart Accessory in  121
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installing thermostatted accessory in  124
location  107
opening and closing  107
purge connector  109
purging  117
removing manual accessory from  121
removing side panel from  116
removing Smart Accessory from  124
routing cords and cables to  113

sample compartment front panel
removing or replacing  112

sample compartment windows
and corrosive samples  116
and purge  117
removing and replacing  116

sample detector
for Fiber Optic Module  265
installing  134
intensity  99
removing  133

sample holder
for filters  347
for solids  345, 347
for test tubes and vials  349
for thin films  347

sample point
X and Y values  36

sample slide holder
fixed position  345
universal  347
variable position  346

sample volume
for nanoCell  284
for Peltier Single Cell Holder  319
for Smart Peltier Linear Cell Changer  376
for Smart Sipper  418

samples
loading for nanoCell  285
measuring with fiber optic probes  267
measuring with nanoCell  280
measuring with Peltier Single Cell Holder  321, 328
measuring with Smart Linear 8-Cell Changer  360
measuring with Smart Peltier Linear Cell Changer  390
measuring with Smart Rotary Cell Changer  401
measuring with Smart Sipper  418
measuring with Temperature Probe  434
measuring with VERSA Probe  446
volatile, corrosive or caustic  116

Samples tab
Fixed  45
Nucleic Acid  144
Nucleic Acid Labels  155
Pierce 660 nm Protein Assay  218

Pierce BCA  185
Pierce Modified Lowry  207
Protein & Labels  175
Protein A280  166
Protein Biuret  229
Protein Bradford  196
Quant  67
Rate  72
Scan  50

samples, subambient temperature
and purge  117

saving
CVC reports  255
PV reports  97
sample  45, 50
template

saving
workbook  97

workbook  21, 97
Savitzky-Golay algorithm  79
scale of displayed data  15
Scan  10

Accessories tab  50
Correction tab  48
data acquisition parameters  46
Instrument tab  46
Measurement tab  47
Samples tab  50

scan kinetics data acquisition  34
scan speed  42, 46, 65, 70, 143, 154, 165, 174, 184, 195, 206, 217, 
228

schedule
for recertifying CVC  258

screw cap flow cell
installing  414

scripts
running from instrument keypad  130

security  457, 459, 463
selection tool

zooming in  36
serial number

loading CVC  252
setting up

Computer Control instrument  127
Local Control instrument  128
Local Control instrument with remote computer  129

Settings button  41
sharing custom templates  73
shielding

for USB devices  110
shipping cost for warranty repair  6
signal-to-noise ratio  42, 46
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signature  458
verifying  459

signature meanings  463
signed workbook  457
signing

CVC reports  255
file  458
report  457

silicone tubing
for Sipper pump  407

silicone tubing, chemical compatibiity  423
single beam substitution error  48
single cell holder

installing  120
Peltier thermostatted  311
removing  121
standard  119
water thermostatted  342

slide holder
fixed position  345
universal  347
variable position  346

SMA connectors
for VERSA Probe  443

SMA connectors, fiber optic cable  266
Smart Accessory

connector  111
installing  121
removing  124

Smart Linear 8-Cell Changer
calibrating  358
cleaning  364
description  353
displaying status monitor  363
high absorbance values  365
initializing  359
INSIGHT settings  360
installing  355
installing cell holder  357
maintenance  364
measuring samples  360
operating precautions  354
removing cell holder  356
safety considerations  354
troubleshooting  365

Smart Peltier Linear Cell Changer
calibrating  380
Cell Changer settings  389
cell changer status monitor  389
changing fuse  375
cleaning  393
compatible cells  376
components  367

description  369
dimensions  373
environmental conditions  373
external connections  370
high absorbance values  394
initializing  381
installing  376
maintaining  392
measuring samples  390
memory failure  394
Normal mode  386
operating from INSIGHT software  382
operating from Peltier Controller  385
safety considerations  368
sample volume  376
setting stir speed  386
setting target temperature  383
setting temperature  386
setting voltage  375
specifications  371
Standby mode  386
Startup mode  385
stir bar  376
system connections  370
temperature controller panels  370
temperature failure  394
temperature status monitor  385
troubleshooting  394
voltage selector  374
water pump requirement  376

Smart Rotary Cell Changer
cleaning  405
description  395
initializing  399
installing  397
maintenance  405
measuring samples  401
measuring standards  404
operating precautions  396
replacing cell holder  398
safety considerations  396
settings  400
status monitor  404

Smart Sipper
calibrating  415
cleaning  420
cleaning flow cells  421
compatible flow cells  413
description  407
installing  411
installing flow cell  413
installing pump tubing  410
maintaining  420
operating precautions  409
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pump specifications  427
pump tubing compatibility  423
pump tubing specifications  426
replacing flow cell tubing  422
replacing pump tubing  421
safety considerations  407
settings  418
specifications  422
storing  410–411
troubleshooting  428
tubing packs  407

Smooth  77
smoothing  46, 65, 70, 79

spectrum  47, 77
sodium iodide, as CVC standard  249
software  101

CUE  130
INSIGHT  108

solid sample holder
fixed position  345
rotatable  347
variable position  346

solvents
for cleaning nanoCell  287

SPE-8W Peltier Temperature Controller  367
specifications

fluid tubing  113
instrument beam height  107
purge tubing  118

spectra
displaying  15
overlaying  14–15

spectral cursor tool  36
spectral region

finding peaks in  47, 91
spectrophotometer

cleaning exterior  131
cleaning touchscreen  132
computer connector  109
Computer Control  126
connecting to recirculator  125
corrosion protection  116
Enter button  130
external connectors  109
initializing  127–129
INSIGHT software  108
installing detector  134
installing manual accessories  120
installing purge  117
installing reference holder  126
installing sample compartment windows  116
installing Smart Accessories  121
installing thermostatted accessories  124

internal connectors  111
keypad buttons  108
keypad functions  130
keypad shortcuts  131
lifting or moving  106
Local Control  128
major components  106
models  103
opening and closing reference compartment  107
opening and closing sample compartment  107
operating precautions  106
ordering parts  135
performance verification  451–452, 454
Power button  130
removable panels  111
removing detector  133
routine maintenance  131
Run button  130
running CUE scripts from keypad  130
safety label locations  104
setting up  126
shielding of USB cables  110
standard cell holders  118
Stop button  130
touchscreen  108
Zero/Base button  130
z-height  107

spectrophotometer, Computer Control
setting up  127
turning off  127

spectrophotometer, Local Control
attaching remote computer  129
setting up  128
turning off  130

spectrum
adding  82
averaging  88
converting spectrum to derivative  79
converting to other Y-axis units  81
deleting from workbook  21
display attributes  15
displaying  15
expanding, contracting or rolling  40
finding peaks in  47, 91
finding value crossings in  93
normalizing  84
overlaying  14
performing math operations on  89
properties  21
ratioing  87
smoothing  47, 77
subtracting  85
zooming in on or moving  36
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specular reflectance accessory
15 degree  239
20 degree  241
30 degree  243
45 degree  245
60 degree  247
8 degree near normal  237
grazing angle  261

stages  69
standard

calibrated  48
standard cell holders  118
standard curve  53
standard deviation  26, 28
standard tubing packs  407
standards  28, 52–53, 63, 183, 194, 205, 216, 227

CVC  249
handling CVC  249
measuring with Smart Rotary Cell Changer  404
replicate, duplicate or triplicate  63, 183, 194, 205, 216, 227

Standards tab
Pierce 660 nm Protein Assay  216
Pierce BCA  183
Pierce Modified Lowry  205
Protein Biuret  227
Protein Bradford  194
Quant  63

statistical functions for Quant equations  58
status monitor

cell changer  389
temperature  385
temperature probe  436

status monitors  23
stir speed

setting for Peltier Single Cell Holder  322
setting for Smart Peltier Linear Cell Changer  386
using INSIGHT to set  322, 382
using Peltier controller to set  326

Stop button  13
Stop Flow Accessory  337
Stop keypad button  130
stopper

replacing O-rings  438
storing

certificate of calibration  252
CVC  258
Fiber Optic Module  264
Hg Lamp  275
instrument detector  134
nanoCell  287
Smart Sipper  410–411

stray light  452

string functions for Quant equations  58
Subtract  85
subtracting  89

spectra  85
switch

power  109
system policies  457, 459
System Settings  99

T
target temperature

for Temperature Probe  435
using INSIGHT to set  323, 383
using Peltier controller to set  326

task buttons  12
temperature

failure  329, 394
setting for Peltier Single Cell Holder  322
setting for Smart Peltier Linear Changer  382
setting for Temperature Probe  434

temperature controllable
linear cell changer  353, 367
Peltier single cell h older  311
recirculator  291
rotary cell changer  395
sample cell holder  342

temperature controller
Peltier  311
Peltier SPE-8W  367
Peltier TPS-1500W  291

temperature failure
for Peltier Recirculator  310
for Peltier Single Cell Holder  329
for Smart Peltier Linear Changer  394

Temperature Probe
and Smart Linear 8-Cell Changer  353
and Smart Rotary Cell Changer  395
cleaning  438
components  431
displaying temperature status monitor  436
installing  432
maintaining  437
operating precautions  431
replacing stopper O-rings  438
setting target temperature  435
settings  434
specifications  431
troubleshooting  440

temperature range
for Peltier Recirculator  291
for Peltier Single Cell Holder  315
for Smart Peltier Linear Cell Changer  372
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for Temperature Probe  431
for VERSA Probe  443

temperature status monitor
displaying  323
for Peltier Single Cell Holder  324
for Smart Peltier Linear Changer  385
for Temperature Probe  436

Temperature tab
Peltier Single Cell Holder settings  322
Smart Peltier Linear Cell Changer settings  382
Temperature Probe settings  434

template
deleting  74
description  52, 68
directory for saving  97
list  14
name  52, 68
opening  74
resetting settings in  41
saving workbook settings as  21
settings  51
sharing  73
signing  458
verifying signature for  459

test cable  263
proper handling  264

test limits
CVC  253

test tube holder
for small tubes and vials  349
rotatable  347

tests
CVC performance  253
Performance Verification  452
wavelength and bandwidth with Hg lamp  275

Thermo Security Administration  457
Thermo Software IQ  24
thermostatted

Linear Cell Changer  353
Peltier Linear Cell Changer  367
Peltier Single Cell Holder  311
rectangular cell holder  342
Rotary Cell Changer  395

thermostatted accessory
installing  124
tubing connections  113

thermostatted sample cell holder
fluid controlled  342
Peltier controlled  311

thin film sample holder  347
time  96
tips

installing for VERSA Probe  446
tolerance

for CVC tests  253
for Peltier Single Cell holder temperature  315
for probe temperature  431
for Smart Peltier Linear Changer temperature  372

touchscreen
and Local Control instruments  108
cleaning  132
keyboard  11
location  107
switching control to  129

trademarks  6
transfer optics

fiber optic  263
transmission accessory

variable angle  441
Trigger port

connecting to fiber optic probe  333
connecting to VERSA Probe  445
location  110

trigonometric functions for Quant equations  58
triplicate standard  63, 183, 194, 205, 216, 227
triplicates  26, 28
troubleshooting

Fiber Optic Module  270
Peltier Recirculator  308
Peltier Single Cell Holder  329
Smart Linear 8-Cell Changer  365
Smart Peltier Linear Cell Changer  394
Smart Sipper  428
Temperature Probe  440

tubing
adapters  113, 125

tubing access panel
removing and replacing  112

tubing packs
for Smart Sipper  407

tubing specification
for flow cells  407
for fluids  113
for purge gas  118
for Sipper pump  407

tubing, flow cell
FEP  407
flanged  414
low-volume  407
PTFE  407
replacing  422

tubing, pump
chemical compatibility  423
installing  410
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replacing  421
silicone  407
Viton  407

turning off
Computer Control instrument  127
Local Control instrument  130

turning on
Computer Control instrument  127
Local Control instrument  128
Local Control instrument with remote computer  129

Type tab
Nucleic Acid  140
Nucleic Acid Labels  151
Pierce 660 nm Protein Assay  213
Pierce BCA  180
Pierce Modified Lowry  202
Protein A280  161
Protein Biuret  224
Protein Bradford  192
Proteins & Labels  170
Quant  52
Rate  68

U
unit  69

component concentration  53, 141, 152, 162, 172, 181, 192, 
203, 214, 225

units  81
for Quant  98

universal sample slide holder  347
update policy  6
USB connector, for external computer  109
USB connectors, for external devices  110
USB devices

high power  110
shielding  110
supported  110

user group  14
user name  458
UV radiation safety label

detector compartment  105
mercury lamp compartment  105

V
valley

measuring  37
valleys

finding  47, 91
value crossings  93
Value Level  93
Variable Angle Transmission accessory  441

variable pathlength
cell holder slide  351
cylindrical cell holder  344
rectangular cell holder  350

variable position sample slide holder  346
verifying

instrument performance  249
signature  459

VERSA Probe
attaching remote start cable  445
cleaning  449
components  443
description  443
improving signal-to-noise ratio  446
installing  444
installing tips  446
maintaining  449
measuring baseline or zero  447
measuring samples  446
operating precautions  443
pathlength  443
specifications  443
UV radiation hazard  444

vial sample holder  348–349
view finder  40
viewing

CVC reports  256
Viton tubing

for Sipper pump  407
Viton tubing, chemical compatibility  423
volatile samples

protecting instrument from  116
voltage setting

for Peltier Recirculator  298
for Peltier Single Cell Holder  318
for Smart Peltier Linear Cell Changer  375

volume, sample
for nanoCell  284
for Peltier Single Cell Holder  319
for Smart Peltier Linear Cell Changer  376

W
warning

explosion hazard  117
safe operation  103
shock hazard  110
UV radiation hazard  113, 115, 265, 444

warranty  4
and failure to use sample compartment windows  117
items not covered by  5
period  5
repair  5
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shipping cost for items covered by  6
update policy  6

water level alarm  301, 309
water pump

and Peltier Single Cell Holder  311
and Smart Peltier Linear Cell Changer  367

water thermostatted sample cell holder  342
wavelength

calibrating  100, 273
range  42, 46, 65, 143, 154, 165, 174, 184, 195, 206, 217, 228, 

283
wavelength accuracy  276, 452
wavelength reproducibility  452
wavelength reproducibility test  276
windows, sample compartment

and corrosive samples  116
and purge  117
removing and replacing  116

workbook  74
closing  21
creating  21
default settings  21
deleting  74
deleting spectrum from  21
directory for saving  97
e-mailing  4, 21, 97
opening  74
saving  21, 97
signed  457
signing  458
verifying signature for  459

X
xenon lamp

status  101

Y
Y-axis unit  42, 46

Z
Zero button  13
zero scan

initiating from instrument keypad  130
Zero/Base keypad button  130
z-height

and nanoCell  283
cell holder for 15 mm  343
spectrophotometer  107
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